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PER INIZIARE

INSTALLAZIONE
Windows

Installazione
Avviare MuseScore
Disinstallazione

macOS
Installazione
Disinstallazione

Linux
Fedora

Vedi anche

INSTALLAZIONE SU WINDOWS
Installazione
Avviare MuseScore
Disinstallazione
Risoluzione dei problemi
Collegamenti esterni

INSTALLAZIONE SUL MACOS
Installazione
Disinstallazione
Collegamenti esterni

INSTALL ON LINUX
AppImage

Step 1 - Download
Step 2 - Give execute permission
Step 3 - Run it!
Installing the AppImage (optional)
Using command line options

Distribution Packages
Fedora

External links

INSTALL ON CHROMEBOOK
Desktop program
Android app (playback only)
External links

CREARE UN NUOVO SPARTITO
Finestra di avvio
Creare un nuovo spartito
Titolo, compositore ed altre informazioni
Strumenti e parti vocali
Aggiungere un pentagramma collegato ad uno strumento
Selezionare armatura di chiave e tempo
Unità di tempo, battute in levare (anacrusi) e numero di battute
Rettifiche allo spartito dopo la creazione
Modelli
Vedi anche
Collegamenti esterni

IMPOSTAZIONE LINGUA E AGGIORNAMENTI TRADUZIONE
Modificare la lingua
Aggiornare traduzioni
Vedi anche

CONTROLLO DEGLI AGGIORNAMENTI
Controllo automatico degli aggiornamenti
Ricerca aggiornamenti
Vedi anche

NOZIONI DI BASE

INSERIMENTO NOTE
Nozioni di base

1: Punto di inizio inserimento
2: Inserimento note
3: Durata delle note (o delle pause)
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4 - Inserimento note dell'altezza desiderata
Altre scorciatoie da tastiera

Tastiera MIDI
Tastiera pianoforte
Colori delle note fuori estensione
Note piccole
Proprietà delle note
Modifica delle note (senza modificare la durata)
Vedi anche
Link esterni

MODALITÀ DI MODIFICA
Vedi anche

TAVOLOZZE E AREA DI LAVORO
Utilizzare le tavolozze
Area di lavoro
Tavolozze preimpostate
Tavolozza Generale
Vedi anche

ISPETTORE E PROPRIETÀ DEGLI ELEMENTI
Ispettore

Categorie

Proprietà (accessibili tramite il tasto destro del mouse)
Proprietà battuta
Proprietà pentagramma

Vedi anche

OPERAZIONI SULLE BATTUTE
Aggiungere
Inserire
Cancellare
Proprietà

Pentagrammi
Durata della battuta
Altro

Numerazione delle battute
Dividere e unire
Vedi anche

VOCI
Quando usare le voci
Come usare le voci
Nascondere le pause
Scambiare le voci
Vedi anche
Collegamenti esterni

COPIA E INCOLLA
Copia
Incolla
Ripetizione rapida
Filtro selezione
Vedi anche
Link esterni

MODALITÀ SELEZIONE
Selezione di un singolo elemento
Selezione di un intervallo
Selezione di elementi diversi non successivi
Selezionare tutti gli elementi simili
Per cosa sono utilizzati
Vedi anche

MODI DI VISUALIZZAZIONE
Vista pagina/Vista continua

Vista pagina
Vista continua

Zoom
Visualizzare più di una partitura
Schermo intero
Navigatore
Vedi anche
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ANNULLARE E RIPETERE

SALVA/ESPORTA/STAMPA
Menu file

Formati disponibili nel menu 'Salva', 'Salva come...', 'Salva una copia...', 'Salva selezione...' e 'Salva Online...'
Formati disponibili nel menu 'Esporta' (e 'Esporta parti...')
Stampa

Vedi anche

CONDIVIDERE LE PARTITURE ONLINE
Creare un account
Condividere una partitura direttamente da MuseScore
Caricare una partitura sul sito MuseScore.com
Modificare una partitura sul sito MuseScore.com
Vedi anche

PARTITURA IN DO
Vedi anche

NOTAZIONE

ALTERAZIONI
Sostituzione enarmonica delle alterazioni
Vedi anche
Collegamenti esterni

ARMATURA DI CHIAVE
Modificare
Aggiungere
Eliminare
Armatura di chiave di cortesia
Naturali sui cambiamenti di tonalità
Armatura di chiave e pause di battuta
Armatura di chiave interruzione di sezione
Armatura di chiave personalizzata

ARPEGGI E GLISSANDO
Collegamenti esterni

ARTICOLAZIONI E ABBELLIMENTI
Articolazioni
Ornaments
Bends
Utilizzare Articolazioni e Abbellimenti

Per applicare un'Articolazioni o Abbellimenti
Scorciatoie
Per regolare la posizione di un simbolo

Collegamenti esterni

BENDING
Applicare il bending
Regolare l'altezza
Regolare la posizione
bending personalizzato
Collegamenti esterni

BATTUTE D'ASPETTO
Pause di una battuta intera
Battute d'aspetto

Istruzioni
Limitazioni

Interrompere battute d'aspetto

CHIAVI
Aggiungere
Eliminare

FORCELLE
Modificare le forcelle
Linee Cresc. e dim.
Riproduzione delle forcelle
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GRAFFE
Cancellare
Aggiungere
Cambiare
Modificare{#edit}
Posizione orizzontale

GRUPPI DI NOTE
Vedi anche

GRUPPI IRREGOLARI
Istruzioni
Inserimento note
Proprietà
Stile
Vedi anche
Collegamenti esterni

INDICAZIONE METRICA
Creare un'Indicazione metrica personalizzata
Modificare i Gruppi di note preimpostati
Cancellare un'Indicazione metrica
Modifica di ritmi asimmetrici
Durata differente dall'Indicazione metrica: battute in levare (Anacrusi) e Cadenza
Indicazione metrica locale
Modificare l'Indicazione metrica e altri elementi
Vedi anche

INTAVOLATURA
Modificare le proprietà intavolatura
Creare un nuovo pentagramma intavolatura

Con la procedura guidata 'Finestra di avvio'
Con la finestra di dialogo Strumenti
Cambiare tipo di pentagramma

Modifica dei dati delle corde dello strumento (accordatura)
Combinare pentagramma convenzionale con intavolatura{#multiple-staves}

Creare pentagramma/intavolatura con Creare un nuovo spartito
Creare pentagramma/intavolatura da un pentagramma esistente
Modificare una coppia pentagramma/intavolatura collegato in scollegato (o viceversa)

Inserire nuove note
Tastiera
Mouse
Selezionare il valore della nota da inserire

Modifica note inserite
Sintesi dei tasti

Modalità inserimento note

Collegamenti esterni

LEGATURA DI PORTAMENTO
Primo metodo
Secondo Metodo
Terzo Metodo
Modifiche
Linea punteggiata
Vedi anche

LEGATURA DI VALORE
Primo metodo
Secondo metodo
Legatura accordi

LINEE
Inserire le linee nella partitura
Cambiare la lunghezza
Linee personalizzate e proprietà della linea
Collegamenti esterni

NOTAZIONE PERCUSSIONI
Tastiera MIDI
Tastiera del computer
Mouse
Batteria{#edit-drumset}
Rullo
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95

Collegamenti esterni

NOTE DI ABBELLIMENTO (ACCIACCATURE)
Istruzioni
Collegamenti esterni

OCTAVE LINES
Apply an octave line
Change length
Custom lines
External links

RESPIRO E PAUSE

RIPETIZIONI
Riproduzione
Simboli di ripetizione e Testo
Salti
Vedi anche
Collegamenti esterni

STANGHETTE
Cambiare il tipo di stanghetta
Creare un doppio pentagramma
Vedi anche

TRASPORTO
Trasporto cromatico per chiave
Trasporto cromatico per intervallo
Trasporto diatonico
Strumenti traspositori
Vedi anche

TREMOLO

VOLTA
Testo
Riproduzione
Collegamenti esterni

SUONO E RIPRODUZIONE

CAMBIO STRUMENTO LUNGO IL PENTAGRAMMA
Inserire un cambio strumento lungo il pentagramma
Formattare il Testo Cambio strumento
See also

IMPORTAZIONE MIDI
Operazioni disponibili

LIBRERIE DI SUONI
Panoramica
Installare una Libreria di suoni

Disinstallare

Sintetizzatore
Elenco di Librerie di suoni

Librerie di suoni specialistiche

Risoluzione dei problemi
Vedi anche
Collegamenti esterni

MIXER
Mixer

Muto e Solo
Quadranti
Suono

Cambiare strumento
Cambiamenti momentanei di suono (pizz., con sordino, etc.)
Vedi anche

MODALITÀ RIPRODUZIONE
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Controlli riproduzione
Conteggio metronomo
Riproduzione Metronomo
Riproduzione ciclica

SINTETIZZATORE
Overview
Librerie di suoni
Volume
Effetti

Zita 1 riverbero

Accordatura
Cambiare l'accordatura principale

Impostare l'Accordatura predefinita
Cambiare l'accordatura per una singola partitura

SWING
Attivare lo swing
Impostazioni Swing
Disattivare lo swing
Proprietà Testo

TEMPO
Controlli Riproduzione
Metronomo
Vedi anche

DINAMICHE
Dinamiche (testo)

Regolare il volume di riproduzione di una dinamica

Controlli riproduzione
Collegamenti esterni

TESTO

TEXT BASICS
Add text
Format text

Text Style
Text Properties
Text editing

Adjust position of text objects

MODIFICA DEL TESTO
Modalità di modifica del testo

Comandi di modifica e scorciatoie da tastiera

Scorciatoie caratteri speciali
Simboli e caratteri speciali
Vedi anche

STILE DEL TESTO
Proprietà del testo:
Tipi di testo:
Creare un nuovo stile di testo
Applicare le opzioni
Reimpostare le opzioni di stile
Vedi anche

TESTO DI ACCOLLATURA E TESTO DI PENTAGRAMMA
Testo di pentagramma
Testo di accollatura

SIMBOLI DEGLI ACCORDI
Inserire un simbolo accordo

Comandi da tastiera
Modifica di un simbolo accordo

Sintassi simbolo accordo
Testo dei simboli accordo
Stile dei simboli accordo

Stile
Ortografia delle note
Posizionamento
Capotasto
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133

DITEGGIATURA

PAROLE
Caratteri speciali
Vedi anche
External links

NUMERI DI CHIAMATA
Aggiungere Numeri di chiamata

Posizionamento manuale
Posizionamento automatico

Risequenziare automaticamente numeri di chiamata
Ricerca del Numero di chiamata
Stile del Testo
See also

FORMATTAZIONE

IMPAGINAZIONE E FORMATTAZIONE
Modi per modificare l'impaginazione
Impaginazione → Impostazioni pagina...
impaginazione → Aumenta/Diminuisci larghezza battuta
Stile → Generale... → Spartito
Stile → Generale... → Pagina
Stile → Generale... → Intestazione, Piè di pagina, Numeri
Stile → Generale... → Accollatura{#style-edit-general-style-system}
Stile → Generale... → Battuta{#style-edit-general-style-measure}
Stile → Generale... → Stanghette
Tavolozze→ Interruzioni& Spaziatori
Stile → Generale... → Note
Stile → Generale... → Chiavi
Stile → Generale... → Arpeggi
Stile → Generale... → Gruppi di note
Stile → Generale... → Legature di valore/portamento
Stile → Generale... → Dimensioni{#style-edit-general-style-sizes}
Stile → Generale... → Forcelle, Volta, Ottava
Stile → Generale... → Pedale, Trillo
Stile → Generale... → Simboli degli accordi, Schemi tastiera
Stile → Generale... → Basso continuo
Style → Generale... → Articolazioni, Abbellimenti{#style-edit-general-style-articulations}
Style → Generale... → Alterazioni
Style → Generale... → Gruppi irregolari
Modifica spaziatura tra le singole note
Pulsanti Applica e OK
Applica a tutte le parti in una sola volta
Salva e carica stile
Vedi anche
Collegamenti esterni

GENERAL STYLE: MEASURE
Introduction
Options

IMPOSTAZIONI PAGINA
Dimensione pagina
Margini-pagina
Ampiezza spazi pentagramma
Miscellanea

INTERRUZIONI E SPAZIATORI
Aggiungere interruzioni e spaziatori
Eliminare interruzioni e spaziatori
Interruzioni di sezione
Vedi anche

CORNICI
Cornice orizzontale
Cornice verticale
Cornice di testo
Creare una cornice
Cancellare una cornice
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Vedi anche
Collegamenti esterni

IMMAGINI
Vedi anche

ACQUISIZIONE IMMAGINI
Vedi anche

ALLINEARE GLI ELEMENTI
Attivare Aggancia alla griglia

ARGOMENTI AVANZATI

ACCESSIBILITÀ
Introduzione
Configurazione iniziale
Trovare il vostro percorso
Finestra della partitura.
Lettura partitura

Spostamento in avanti o indietro nel tempo
Spostamento tra le note di un battito
Filtro lettura partitura

Riproduzione partitura
Modifica partitura
Personalizzazione

ALBUM
Stampare Album
Unire partiture

ATTREZZI
Aggiungi/rimuovi interruzioni di riga
Esplodi/Implodi

Esplodi
Implodi

Riempire con slash
Commutare a notazione a slash ritmica
Risequenziare marcatori di riferimento
Vedi anche

BASSO CONTINUO
Aggiungere una nuova indicazione di basso continuo
Formato testo

Numeri
Alterazioni
Forme combinate
Parentesi
Durata gruppo
Durata

Modifica basso continuo (già inserito)
Stile
Sintassi corretta
Elenco tasti

ESTRAZIONE PARTI
Impostazione delle parti

Impostazione di tutte le parti in una sola volta

Esportare le parti
Salvare

FORMATO DEI FILE
Formato nativo di MuseScore

Formato MuseScore (*.mscz)
Formato non compresso di MuseScore (*.mscx)

MuseScore file di backup
File di backup di MuseScore (*.mscz, o *.mscx,)

Visualizzare e stampare (solo esportazione)
PDF (*.pdf)
PNG (*.png)
SVG (*.svg)

Ascoltare (solo esportazione)
WAV audio (*.wav)
FLAC audio (*.flac)
Ogg Vorbis (*.ogg)
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163
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MP3 (*.mp3)

Condividere con altri software musicali
MusicXML (*.xml)
MusicXML compresso (*.mxl)
MIDI (*.mid, *.midi, *.kar)
MuseData (*.md) (solo importazione)
Capella (*.cap, *.capx) (solo importazione)
Bagpipe Music Writer (*.bww) (solo importazione)
BB (*.mgu, *.sgu) (solo importazione)
Overture (*.ove) (solo importazione)
Guitar Pro (*.GTP, *.GP3, *.GP4, *.GP5, *.GPX) (solo importazione)

Vedi anche

FUNZIONALITÀ EARLY MUSIC (MUSICA ANTICA)
Notazione senza divisione in battute
Mensurstrich
Ambitus
Unità di Tempo Mensurale
Vedi anche

GRUPPO DI NOTE TRA PENTAGRAMMI
Vedi anche

INFORMAZIONI PARTITURA
Metadati preesistenti
Modificare metadati
Aggiungere metadati
Intestazione/Piè di pagina
Vedi anche

MODALITÀ DI INSERIMENTO NOTE
Un passo alla volta
Modifica altezze
Ritmo
Tempo reale (automatic)
Tempo reale (manual)

Tempo reale Advance shortcut

Vedi anche
Collegamenti esterni

PLUGIN
Installazione

Windows
macOS
Linux

Abilitare/Disabilitare plugin
Creare/modificare/eseguire plugin
Plugin già installati

ABC Import
Break Every X Measures
Notes → Color Notes
Create Score
helloQml
Notes → Note Names
Panel
random
random2
run
scorelist
ScoreView
Walk
Tools

PREFERENZE
Generale
Area di visualizzazione
Inserimento note
Spartito
I/O e suoni
Importazione
Esportazione
Scorciatoie
Aggiornamenti
vedi anche

PROPRIETÀ TIPI DI PENTAGRAMMA
Sfondo
Come arrivarci
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181

182

182
182
182
182

182
182

182
182
182

Elementi comuni

Pentagramma standard e per percussioni, elementi specifici.
Elementi specifici del pentagramma Tablature

Marcatori tasti
Valore della nota
Anteprima

RECOVERED FILES
Behavior of saving after session recovery
Finding recovered files
See also
External links

SCHEMI TASTIERA
Aggiungere uno schema tastiera
Modifica schema tastiera (accordo) {# edit-tastiera-diagramma}
Regolare posizione, dimensione, colore
Stile dello schema Tastiera

SOSTITUIRE LE ALTEZZE DELLE NOTE SENZA MODIFICARE I RITMI
Vedi anche

TAVOLOZZA GENERALE
Vedi anche

TESTE DELLE NOTE SOVRAPPOSTE

NUOVE FUNZIONALITÀ DI MUSESCORE 2.0

AGGIORNARE DA MUSESCORE 1.X
Come aggiornare MuseScore
Aprire spartiti 1.x in MuseScore 2.0
Ridefinire l'impaginazione locale
Ottenere il suono da MuseScore 1.x

SUPPORTO

COME CHIEDERE SUPPORTO O SEGNALARE UN ERRORE
Vedi anche

AIUTARE E MIGLIORARE LA TRADUZIONE
Traduzione del software
Traduzione stringhe del sito e manuale
Vedi anche

RIPRISTINARE LE IMPOSTAZIONI PREDEFINITE
MuseScore 2.0.3 e superiori
da MuseScore 2.0 a 2.0.2
Istruzioni per Windows
Istruzioni per macOS
Instruzioni per Linux
Vedi anche

INCOMPATIBILITÀ CONOSCIUTE
Incompatibilità conosciute
Incompatibilità software

AVG Internet Security blocca MuseScore
Problemi di font su macOS
Problemi di font su Linux
Finestra di dialogo "Salva come..." vuota su Linux

APPENDICE

INCOMPATIBILITÀ CONOSCIUTE DI MUSESCORE 2.0
Nozioni di base

Salva selezione
Unità di tempo locale

Inserimento note
Pentagramma Tablatura collegato con pentagramma standard

Suono e riproduzione
Modifica strumenti
Mixer
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184
184
184
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184
187

188
189
189
189

Impaginazione
Intestazione e piè di pagina

SCORCIATOIE DA TASTIERA
Navigazione
Inserimento note

Durata note
Voci
Altezza note
Intervalli

Direzione
Articolazioni
Inserimento Testi
Inserimento parole
Mostra
Vedi anche

GLOSSARIO
External links

OPZIONI DA RIGA DI DI COMANDO
Qt opzioni kit di strumenti
Vedi anche
Collegamenti esterni
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Pubblicato su MuseScore (https://musescore.org)

Questo è il manuale di MuseScore versione 2.0 e precedenti. Scopri come puoi dare il tuo aiuto .

Per iniziare

Questo capitolo spiega come installare ed eseguire MuseScore per la prima volta. Il capitolo spiega anche come creare
un nuovo spartito.

Installazione

MuseScore funziona su molti sistemi informatici diversi tra cui Windows, macOS, e Linux.

Windows

Installazione

È possibile ottenere il programma di installazione di Windows dalla pagina di Nonexistant node nid: 27 del sito
MuseScore. Un clic sul collegamento per avviare il download. Il browser Internet vi chiederà di confermare che si desidera
scaricare il file. Fare clic su Salva File.

Terminato il download, fare doppio clic sul file per avviare l'installazione. Windows potrebbe chiedere, con un avviso di
sicurezza, di confermare l'operazione prima di lanciare il programma. Un clic su Avanti per continuare, potrete brevemente
visualizzare

NOT FOUND: Win-Install-Wizard-1a.png

seguita da

NOT FOUND: Win-Install-Wizard-1b.png

e poi

NOT FOUND: Win-Install-Wizard-1c.png

con un clic su Annulla, qui o successivamente, vedrete:

NOT FOUND: Win-Install-Wizard-2a.png

Se invece si fa clic su Avanti per continuare, la procedura guidata di installazione visualizzerà i termini della licenza del
software libero.

NOT FOUND: Win-Install-Wizard-2b.png

Assicuratevi che l'opzione Accetto i termini del contratto di licenza  sia selezionata e fare clic su Avanti per continuare. La finestra
successiva conferma il percorso d'installazione di MuseScore.

NOT FOUND: Win-Install-Wizard-3.png

Se si installa una nuova versione di MuseScore ma si desidera mantenere la precedente sul computer, potrebbe essere
necessario sostituire la cartella (le versioni 2.0 e 1.x possono coesistere e non si sovrascriveranno, così non saranno
necessarie modifiche). In caso contrario, fare clic su Avanti per continuare.

NOT FOUND: Win-Install-Wizard-4.png

Clic su Installa per continuare.

Concedete alla procedura di installazione guidata pochi minuti per installare i file e le configurazioni necessarie. Vedrete:

NOT FOUND: Win-Install-Wizard-5a.png

poi

NOT FOUND: Win-Install-Wizard-5b.png

e, finalmente
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NOT FOUND: Win-Install-Wizard-5c.png

Un clic Fine per uscire dall'installazione. Potete cancellare il file di installazione scaricato

Avviare MuseScore

Per avviare MuseScore selezionare Start → Tutti i programmi → MuseScore 2 → MuseScore 2.

Disinstallazione

È possibile disinstallare su Windows a 32 bit con

cd C:\Program Files\MuseScore
Uninstall.exe /S

e su Windows a 64 bit con

cd C:\Program Files (x86)\MuseScore
Uninstall.exe /S

macOS

Installazione

Troverete il file DMG nella pagina Nonexistant node nid: 27 del sito MuseScore. Clic sul collegamento per avviare il
download

NOT FOUND: Mac_Install.png

1. Trascinare e rilasciare l'icona MuseScore nalla cartella Icone Applicazioni. Se non avete fatto l'accesso come
Amministratore, macOS potrebbe chiedere una password: clic su Autentica ed inserite la vostra password per
proseguire.

NOT FOUND: Mac_Install_2.png

Quando l'applicazione ha finito di copiare, estrarre il disco immagine. Potete ora avviare MuseScore dalla cartella
Applicazioni, Spotlight, o Launchpad.

Disinstallazione

Cancellate semplicemente MuseScore dalla cartella Applicazioni.

Linux

Si prega di consultare la pagina di Nonexistant node nid: 27 per le istruzioni relative a MuseScore su Linux. I pacchetti
sono disponibili per Debian, Ubuntu, Fedora e PCLinuxOS. Altre distribuzioni richiedono di compilare l'applicazione dai
sorgenti. Per le istruzioni specifiche per Fedora, vedi sotto.

Fedora

1. Importare la chiave GPG:

su
rpm --import http://prereleases.musescore.org/linux/Fedora/RPM-GPG-KEY-Seve

2. Portarsi alla pagina di Nonexistant node nid: 27 del sito MuseScore. Clic sul collegamento per il download della
versione stabile di Fedora download e scegliere il pacchetto rpm corretto per la propria architettura.

3. A seconda della vostra architettura, utilizzare una delle due serie di comandi per installare MuseScore

per arch i386

su
yum localinstall musescore-X.Y-1.fc10.i386.rpm

per arch x86_64

su
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yum localinstall musescore-X.Y-1.fc10.x86_64.rpm

Per difficoltà con l'audio, vedere Fedora 11 e suoni

Vedi anche

Come cambiare la lingua in MuseScore
Come installare MuseScore senza diritti di amministratore
Come eseguire MuseScore come amministratore su Windows

Installazione su Windows

Installazione

È possibile ottenere il programma di installazione di Windows dalla pagina di Nonexistant node nid: 27 del sito
MuseScore. Un clic sul collegamento per avviare il download. Il browser Internet vi chiederà di confermare che si desidera
scaricare il file. Fare clic su Salva File.

Terminato il download, fare doppio clic sul file per avviare l'installazione. Windows potrebbe chiedere, con un avviso di
sicurezza, di confermare l'operazione prima di lanciare il programma. Un clic su Avanti per continuare, potrete brevemente
visualizzare

seguita da

e poi
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con un clic su Annulla, qui o successivamente, vedrete:

Se invece si fa clic su Avanti per continuare, la procedura guidata di installazione visualizzerà i termini della licenza del
software libero.
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Assicuratevi che l'opzione Accetto i termini del contratto di licenza  sia selezionata e fare clic su Avanti per continuare. La finestra
successiva conferma il percorso d'installazione di MuseScore.

Se si installa una nuova versione di MuseScore ma si desidera mantenere la precedente sul computer, potrebbe essere
necessario sostituire la cartella (le versioni 2.0 e 1.x possono coesistere e non si sovrascriveranno, così non saranno
necessarie modifiche). In caso contrario, fare clic su Avanti per continuare.

Clic su Installa per continuare.

Concedete alla procedura di installazione guidata pochi minuti per installare i file e le configurazioni necessarie. Vedrete:
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poi

e, finalmente
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Un clic Fine per uscire dall'installazione. Potete cancellare il file di installazione scaricato

Avviare MuseScore

Per avviare MuseScore selezionare Start → Tutti i programmi → MuseScore 2 → MuseScore 2.

Disinstallazione

È possibile disinstallare su Windows a 32 bit con

cd C:\Program Files\MuseScore
Uninstall.exe /S

e su Windows a 64 bit con

cd C:\Program Files (x86)\MuseScore
Uninstall.exe /S

Risoluzione dei problemi

Su Windows XP e Vista, il programma di installazione potrebbe essere bloccato dal sistema. Se non si riesce a installare
MuseScore, fare clic destro sul file scaricato e fare clic su Proprietà. Se appare un messaggio "Questo file proviene da un
altro computer e potrebbe essere bloccato per proteggere questo computer", cliccare su "Sblocca", "OK" e fare doppio clic
sul file appena scaricato.

Collegamenti esterni

Come installare MuseScore senza diritti di amministratore
Come eseguire MuseScore come amministratore su Windows
Come cambiare la lingua in MuseScore

Installazione sul macOS

Installazione

Puoi trovare il file DMG (immagine disco) sulla pagina Nonexistant node nid: 27 del sito di Musescore. Premi sul link per
macOS per iniziare il download. Quando il download è stato completato, doppio clic sul file DMG per montarlo.

Trascina e rilascia l'icona di Musescore sull'icona della cartella Applicazioni.

Se non ti sei loggato come amministratore, macOS chiederà la password: premi Autenticati e scrivi la tua password per
procedere.
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Quando l'applicazione ha finito di copiare, espelli l'immagine disco. Ora è possibile lanciare Musescore dalla cartella
Applicazioni, Spotlight, o dal Launchpad.

Disinstallazione

Eliminare semplicemente Musescore dalla cartella applicazioni.

Collegamenti esterni

Come cambiare la lingua in Musescore

Install on Linux

As of MuseScore 2.0.3 you can, for the first time, get hold of a copy for Linux straight from the download  page, just like
Windows and Mac users. This is possible thanks to the AppImage packaging format, which runs on pretty much all Linux
distributions. If you prefer, there is still the option to get it the traditional way via your distribution's package manager (but
you may have to wait for it to get packaged by the relevant maintainer). Of course, you can always build from source .

AppImage

The AppImage format  is a new way of packaging Linux applications. AppImages are portable - they don't have to be
installed - and they run on pretty much any Linux distribution. Dependencies are included in the one AppImage file.

Step 1 - Download

Before you download an AppImage, you need to know your processor's architecture. These terminal commands will show
it:

    arch

or

    uname -m

The output will be something like "i686", "x86_64" or "armv7":

i686 (or similar) - 32-bit Intel/AMD processor (found on older machines).
x86_64 (or similar) - 64-bit Intel/AMD processor (modern laptop and desktop computers, most Chromebooks).
armv7 (or later) - ARM processor (phones & tablets, Raspberry Pi 2/3 running Ubuntu Mate, some Chromebooks,
usually 32-bit at present).

Now you can head over to the download  page and find the AppImage that best matches your architecture. Once
downloaded, the file will be named "MuseScore-X.Y.Z-$(arch).AppImage".

Step 2 - Give execute permission

Before you can use the AppImage you need to give permission for it to be run as a program.

From the Terminal:

This command gives the user (u) permission to execute (x) the AppImage. It works on all Linux systems.

    cd ~/Downloads
    chmod u+x MuseScore*.AppImage
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Note: Use the "cd" command to change directory to wherever you saved the AppImage.

From a File Manager:

If you prefer to avoid the command line, there is usually a way give execute permission from inside a File Manager.

In GNOME Files (Nautilus), simply:

1. Right-click on the AppImage and select "Properties".
2. Open the "Permissions" tab.
3. Enable the option labelled "Allow executing file as a program".

The process may be slightly different in other file managers.

Step 3 - Run it!

Now you should be able to run the program simply by double-clicking on it!

When you downloaded the AppImage it was probably saved in your Downloads folder, but you can move somewhere else
it at any time (e.g. you could put it on your desktop for easy access). If you ever want to remove it then simply delete it.

Installing the AppImage (optional)

You can run the AppImage without installing it, but you must install it if you want it to be completely integrated with your
desktop environment. This has the following benefits:

Adds the AppImage to your Applications Menu or Launcher
Sets the correct icons for MuseScore's files (MSCZ, MSCX) and for MusicXML files (MXL, XML)
Makes the AppImage available via your File Manager's right-click "Open with..." menu

To install it, run the AppImage from the Terminal with the "install" option (see immediately below). This copies a desktop
file and various icons to your computer. If you want to remove them you will need to run the "remove" option before you
delete the AppImage. This does not affect any scores created with any version of MuseScore.

Using command line options

Running the AppImage from the Terminal allows you to use various command line options. The AppImage has some
special options in addition to MuseScore's normal command line options.

You will need to change directory (cd) to wherever the AppImage is saved your system, for example:

    cd ~/Desktop
    ./MuseScore*.AppImage [option...]

Or give the path to the AppImage:

    ~/desktop/MuseScore*.AppImage [option...]

Use the "--help" and "man" options to get more information about the available command line options:

    ./MuseScore*.AppImage --help   # displays a complete list of command line options
    ./MuseScore*.AppImage man      # displays the manual page (explains what the options do)

Distribution Packages

Fedora

1. Import the GPG key:

su
rpm --import http://prereleases.musescore.org/linux/Fedora/RPM-GPG-KEY-Seve
 

2. Go to the download  page of the MuseScore website. Click on the link for the stable Fedora download and choose
the correct rpm package for your architecture.

3. Depending on your architecture, use one of the two sets of commands to install MuseScore
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for arch i386

    su
    yum localinstall musescore-X.Y-1.fc10.i386.rpm
 

for arch x86_64

    su
    yum localinstall musescore-X.Y-1.fc10.x86_64.rpm
 

If you have difficulty with sound, see Fedora 11 and sound .
See also the hints for the various distributions on the download page .

External links

How to run the MuseScore AppImage on Linux  - video
How to change the language in MuseScore

Install on Chromebook

Desktop program

MuseScore's desktop program will not work natively on Chrome OS, but there are some workaround solutions:

1. Via Crouton : Involves installing a Linux based operating system which runs in parallel with Chrome OS, and then
installing MuseScore on Linux.

2. Via software-on-demand service such as rollApp : By just visiting this website, you can run MuseScore in the
browser, but you can only start scores from scratch and only save them to your online MuseScore account through
the menu File→Save Online..., and sound and playback does not work.

Android app (playback only)

Alternatively, it is possible to install MuseScore's Android app  on recent Chromebooks. You will need to update to the
latest version of Chrome OS first. See the Chromebook support documentation for help installing Android apps on
Chromebooks , and a list of supported devices . The app only supports playback of existing scores, not score editing
or creation, but you can sign-in to your MuseScore account for easy access to all your scores on MuseScore.com.

External links

How to run MuseScore on a Chromebook
Check the installation procedure from the comments in this thread
How to change the language in MuseScore

Creare un nuovo spartito

All'avvio di MuseScore, vedrete la finestra di avvio.

Finestra di avvio
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È possibile scegliere tra opzioni come

Creare un nuovo spartito (utilizzando l'icona con il segno più)
Aprire uno spartito precedentemente utilizzato
Aprire uno spartito esistente
Vedere 'In primo piano' lo spartito del giorno
Cercare spartiti su musecore.com
I collegamenti per le applicazioni mobili
I collegamenti per seguire MuseScore sui social networks

Creare un nuovo spartito

Per creare un nuovo spartito dal menu principale (e non dalla Finestra di avvio) scegliere File → Nuovo..., che apre la
creazione guidata di un nuovo spartito.

Titolo, compositore ed altre informazioni

Inserite Titolo, compositore, o qualsiasi altra informazione come mostrato sopra, poi un clic su Avanti > e vedrete:
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Qui è possibile scegliere un modello da cui creare lo spartito. I modelli sono trattati in dettaglio più avanti, per ora
selezionare "Scegli strumenti" che vi porterà al passo successivo.

Strumenti e parti vocali
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La finestra degli strumenti è divisa in due colonne. La colonna di sinistra elenca gli strumenti, o le parti vocali tra cui
scegliere. La colonna di destra, inizialmente vuota, conterrà l'elenco degli strumenti per il nuovo spartito.

L'elenco di strumenti nella colonna di sinistra è suddiviso in famiglie di strumenti. Fare clic su una categoria per
visualizzare l'elenco completo degli strumenti in ogni famiglia. Selezionare uno strumento e fare clic su Aggiungi. Lo
strumento selezionato appare ora nella colonna di destra. È possibile aggiungere più strumenti o parti vocali, se
necessario.

La voce di default è "strumenti comuni", ma si può scegliere tra altri, tra cui 'strumenti Jazz' e 'Early Music'.

Il tipo di pentagramma è solitamente standard (5 linee), ma alcuni strumenti possono utilizzarne altri tipi
(batteria/percussioni, corde pizzicate).

L'ordine degli strumenti nella colonna di destra riflette il modo in cui appariranno nello spartito. Per modificare l'ordine fare
clic sul nome dello strumento e utilizzare i pulsanti Su o Giù per spostarlo in alto o in basso. Poi un clic su OK >.

Aggiungere un pentagramma collegato ad uno strumento
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Opzionale: clic su un pentagramma nell'elenco degli strumenti aggiunti e Aggiungi pentagramma collegato.

Selezionare armatura di chiave e tempo

La procedura guidata chiederà due cose: l'armatura di chiave e il tempo dello spartito. Selezionare una qualsiasi delle
opzioni disponibili e fare clic su Avanti > per continuare. Anche il tempo iniziale può essere impostato qui.

Unità di tempo, battute in levare (anacrusi) e numero di battute
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Potete impostare da qui l'unità di tempo iniziale. Se lo spartito inizia con una battuta in levare, contrassegnare la casella di
controllo "battuta in levare" ed impostare l'unità di tempo (un'impostazione presente nel menu di scelta rapida 'proprietà
battuta' come durata battuta).

La quantità di battute può essere specificata qui, ma è possibile modificarla in seguito.

Clic su Fine per creare il vostro nuovo spartito.

Rettifiche allo spartito dopo la creazione

È possibile modificare le impostazioni inserite durante la creazione dello spartito con la nuova procedura guidata, anche
dopo aver iniziato a lavorare sullo spartito.

Per aggiungere/eliminare battute o creare una battuta in levare vedi Operazioni sulle battute

Per modificare qualsiasi testo vedi Modifica del testo. Per aggiungere un titolo mancante (o un altro elemento di
testo) utilizzare il menu Aggiungi → Testo → Titolo (o altro elemento di testo)

Per aggiungere, eliminare o modificare l'ordine degli strumenti, utilizzare il menu Modifica → Strumenti....

Modelli

La prima schermata della nuova procedura guidata ha un'opzione per "Crea nuovo spartito da modello". (vedi sopra per i
dettagli). Per creare lo spartito utilizzando questo metodo selezionare il modello per continuare.

La schermata successiva mostra un elenco di modelli. Selezionare un modello e fare clic su Avanti >. Proseguire e
concludere la nuova procedura guidata come al solito.

Si tratta di file MuseScore normali, memorizzati in una cartella di modelli (uno a livello di sistema e una personale). È
possibile creare il proprio modello salvando gli spartiti in queste posizioni.

Su Windows, la cartella di sistema dei modelli si trova di solito in C:\Program Files\MuseScore 2\templates o, nella versione a 64-
bit in C:\Program Files (x86)\MuseScore 2\templates.

Su Linux guardate sotto /usr/share/mscore-xxx se avete installato dal gestore di pacchetti. Se avete compilato MuseScore su
Linux da soli cercate sotto /usr/local/share/mscore-xxx (dove xxx è la versione in uso).

Su Mac, guardate sotto /Applications/MuseScore 2.app/Contents/Resources/templates.

È possibile configurare la posizione dei modelli personali in Modifica → Preferenze... → Generale, MuseScore mostrerà i modelli
da entrambe: sistema e personale.

27



Vedi anche

Armatura di chiave
Unità di tempo
Chiavi
Tempo
Proprietà tipo di pentagramma

Collegamenti esterni

Video tutorial: MuseScore in Minutes: Lezione 1 - Impostazione spartito

Impostazione lingua e aggiornamenti traduzione

MuseScore verrà installato e lavorerà con la lingua di "Sistema" (quella utilizzata per la maggior parte dei programmi e in
generale a seconda del paese e delle impostazioni della lingua del PC, o account).

Modificare la lingua

1. Andate su Modifica → Preferenze... (Mac: MuseScore → Preferenze...)

2. Nella scheda Generale c'è una sezione Lingua:

È possibile modificare e aggiornare anche la traduzione con il tasto Aggiorna traduzioni. Si aprirà una nuova finestra, che
mostra, in alto, la vostra lingua - vedi sotto.

Come da avviso dovrete chiudere e riavviare MuseScore per rendere effettive le modifiche.

Aggiornare traduzioni

È possibile aggiornare la traduzione come spiegato sopra, tramite le impostazioni delle preferenze, ma c'è un altro
metodo:

1. Andate su Aiuto → Gestore delle risorse...

2. Un clic sul tasto Aggiorna
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Anche qui sarà necessario chiudere e riavviare MuseScore perchè l'aggiornamento abbia effetto.

Vedi anche

Contribuire e migliorare la traduzione

Controllo degli aggiornamenti

Ci sono due modi per controllare gli aggiornamenti.

Controllo automatico degli aggiornamenti

1. Da Modifica → Preferenze... (Mac: MuseScore → Preferenze...)
2. Selezionare la scheda Aggiorna

3. Ricerca aggiornamenti ...

Ora MuseScore controllerà gli aggiornamenti all'avvio e avviserà se necessario.

Ricerca aggiornamenti
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1. Selezionare Aiuto → Ricerca aggiornamenti

2. Si aprirà una finestra di dialogo con lo stato dell'aggiornamento: "Nessun aggiornamento disponibile" o "È disponibile
un aggiornamento per MuseScore:" seguito da un collegamento per scaricarlo.

Vedi anche

Preferenze: Aggiornamenti

Nozioni di base

Il precedente capitolo "Per iniziare " è una guida alla procedura di installazione e a come creare una nuova partitura. Il
capitolo "Nozioni di base" offre una panoramica di MuseScore e descrive i metodi generali per l'interazione con lo spartito.

Inserimento note

Nozioni di base

Per inserire in un pentagramma le note e le pause si devono seguire quattro passaggi fondamentali:

1. selezionare il punto di inizio inserimento
2. selezionare la Modalità Inserimento Note

3. selezionare la durata della nota (o della pausa) da inserire
4. inserire la nota dell'altezza desiderata (o una pausa) con scorciatoie da tastiera PC, con il mouse, o con una tastiera

MIDI

Per inserire delle note che iniziano/finiscono in momenti diversi (polifonia), vedi Voci. Per inserire degli accordi leggi
qui sotto.

1: Punto di inizio inserimento

Per prima cosa selezionare una nota o una pausa già presenti nella partitura come punto di inizio inserimento. C'è da
precisare che quando si inseriscono delle note, queste vanno a sostituire le note o le pause già esistenti (sovrascrittura).
Tuttavia è possibile inserire nuove battute in ogni punto della partitura (vedi Operazioni sulle battute: Inserire), oppure
utilizzare la funzione copia e incolla per spostare un passaggio di note.

2: Inserimento note

Il pulsante "N" presente nella barra degli strumenti Inserimento Note indica se siete nella modalità inserimento note. Per
attivare o disattivare la Modalità inserimento note, si può fare clic sul pulsante, utilizzare la scorciatoia da tastiera N. Per
disattivare la Modalità inserimento note si può anche utilizzare il tasto Esc.

3: Durata delle note (o delle pause)

Dopo essere entrati nella Modalità Inserimento Note, si deve selezionare la durata della nota da inserire facendo clic su uno dei
simboli presenti nella Barra inserimento note, oppure utilizzare le scorciatoie da tastiera.
Se c'è una divisione irregolare (come 3 note da 1/8 nel tempo di due), vedi Gruppi irregolari di note (terzine)

Le scorciatoie da tastiera per selezionare la durata sono:

1: 1/64 (semibiscroma)
2: 1/32 (biscroma)
3: 1/16 (semicroma)
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4: 1/8 (croma)
5: 1/4 (semiminima)
6: 2/4 (minima)
7: 4/4 (semibreve)
8: 8/4 (breve)
9: 16/4 (longa)
0: Pausa
.: il punto trasforma la durata selezionata in una nota/pausa puntata

4 - Inserimento note dell'altezza desiderata

Per tutti gli strumenti (eccetto le percussioni a suono indeterminato) è possibile inserire le note facendo clic con il mouse
direttamente sul pentagramma. (Per le istruzioni specifiche per le percussioni vedi Notazione per percussioni). Un metodo
più veloce è quello di usare una tastiera MIDI (vedi sotto), oppure la tastiera alfabetica del computer. Gli esempi seguenti
sono fatti utilizzando la tastiera standard del computer.

Per inserire le note come da esempio qui sotto utilizzare la sequenza di tasti: C D E F G A B C

Premendo 0 (Zero) si inserisce una pausa: per esempio con la sequenza C D 0 E si ottiene il risultato mostrato qui sotto.
Notare che la durata selezionata per inserire le note (semiminime in questo esempio) determina anche la durata della
pausa (pausa da 1/4 in questo esempio).

Mentre si inseriscono le note, la finestra di MuseScore scorre automaticamente lungo la partitura. Se si vuole aggiungere
una o più note nella stessa posizione dell'ultima inserita per scrivere un accordo, premere Maiusc e il tasto della nota: C D
Maiusc+F Maiusc+A E F

Per creare degli accordi con note di differente durata, vedi il capitolo Voci.

Per inserire una nota con il punto, premere .. Per esempio 5 . C 4 D E F G A

Quando si inserisce una nota utilizzando la tastiera del computer, Musescore la posiziona il più vicino possibile all'ultima
nota inserita (sopra o sotto). Quando invece si inserisce un accordo le note sono aggiunte sopra la nota corrente (dal
basso verso l'alto).
Per aumentare o diminuire di una ottava l'altezza dell'ultima nota inserita, utilizzare le seguenti combinazioni di tasti:

Ctrl+↑ (Mac: ⌘+↑): aumenta l'altezza della nota di una ottava.
Ctrl+↓ (Mac: ⌘+↓): diminuisce l'altezza della nota di una ottava.

Altre scorciatoie da tastiera

Altri utili comandi da tastiera disponibili in Modalità Inserimento Note:

↑ (Su): aumenta l'altezza della nota di un semitono (utilizza ♯)
↓ (Giù): diminuisce l'altezza della nota di un semitono (utilizza ♭)
Alt+Maiusc+↑: aumenta l'altezza della nota di un tono o un semitono a seconda della tonalià (armatura di chiave)
Alt+Maiusc+↓: diminuisce l'altezza della nota di un tono o un semitono a seconda della tonalià (armatura di chiave)
J: cambia la nota alterata nella corrispondente enarmonica (es. da Do♯ a Re ♭)
R: duplica l'ultima nota inserita
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Q: dimezza la durata l'ultima nota inserita
W: raddoppia la durata l'ultima nota inserita
Backspace: annulla l'ultima nota inserita
X: inverte l'orientamento dei gambi della nota
Maiusc+X: sposta la testa della nota sul lato opposto del gambo

Tastiera MIDI

È possibile inserire le note utilizzando una tastiera MIDI.

1. Collegare la tastiera MIDI al computer e accenderla
2. Avviare MuseScore
3. Creare una nuova partitura
4. Selezionare con il mouse il punto di inizio inserimento (vedi sopra )
5. Premere N per entrare in Modalità inserimento note

6. Selezionare la durata della nota, per esempio 5 per una nota da 1/4 (semiminima), come descritto sopra
7. Premere la nota desiderata sulla tastiera MIDI: verrà inserita nella partitura la nota dell'altezza selezionata

Nota: con la tastiera MIDI è possibile inserire una nota o un accordo alla volta. Questa modalità di inserimento (in inglese
"step-time entry") è veloce e affidabile. Alcuni programmi di notazione cercano di interpretare i passaggi suonati dai
musicisti (in inglese "real-time entry") e scrivere direttamente la notazione. Comunque con questo ultimo metodo spesso i
risultati risultano non attendibili. MuseScore si concentra sulle procedure più affidabili per l'inserimento delle note.

Se avete più di una periferica MIDI connessa al computer, dovete indicare a Musescore quale di queste periferiche è la
tastiera MIDI. Selezionare Modifica → Preferenze... (Mac: MuseScore → Preferenze...). Nella finestra di dialogo fare clic sulla
scheda I/O e suoni e selezionare la periferica nella sezione "PortAudio".

Tastiera pianoforte

Colori delle note fuori estensione

Le note che sono all'interno dell'estensione di uno strumento o di una parte di voce appaiono di colore nero, invece le
note al fuori della normale estensione appaiono colorate in rosso. Per alcuni strumenti l'estensione dipende dall'abilità del
musicista (esempio archi, fiati o voce). Per questi strumenti le note fuori estensione per un musicista amatoriale appaiono
colorate in giallo scuro, mentre le note fuori una tipica estensione per un professionista appaiono colorate in rosso.

I colori servono come informazione e appaiono sullo schermo ma non nelle copie stampate. Per disabilitare i colori delle
note selezionare Modifica → Preferenze... (Mac: MuseScore → Preferenze...), , fare clic sulla terza scheda Inserimento Note e
deselezionare l'opzione "Colora le note fuori estensione".

Note piccole

1. Selezionare la nota (o le note) che si vogliono in formato piccolo
2. Attivando la finestra Ispettore (F8) è possibile cambiare la grandezza sia delle note singole che quelle degli accordi

utilizzando l'opzione "Piccolo" (presente sia nella sezione Accordo che nella sezione Nota nella finestra dell'ispettore)

selezionando Stile → Generale → Dimensioni è possibile cambiare la grandezza proporzionale di tutti gli elementi piccoli
(anche se è una procedura non convenzionale).

Nota: nella finestra Ispettore, se si mette la spunta Piccolo nella sezione 'Note' verrà ridotta la grandezza della sola testa
della nota; se si mette la spunta Piccolo nella sezione 'Accordo' si ridurranno anche le dimensioni dei gambi, delle code
nei gruppi di note e delle code uncinate (cediglie).

Proprietà delle note
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Vedi Impaginazione e formattazione, in particolare le sezioni riguardanti le note, gli accidenti e i gruppi irregolari
Vedi Ispettore e proprietà degli elementi per le proprietà di una nota o di una selezione di note

Modifica delle note (senza modificare la durata)

Se si deve modificare una sola nota, il sistema migliore è quello di selezionarla e di modificarla con il mouse o la tastiera.
Se si devono modificare più note ma non la loro durata, si può utilizzare il trasporto (se gli intervalli tra le note rimangono
gli stessi), oppure la modalità di modifica altezza delle note.

Vedi modifica altezza delle note
Vedi Trasporto

Se le alterazioni appaiono insolite, è possibile utiizzare la funzione di sostituzione enarmonica delle alterazioni (vedi
Alterazioni: Sostituzione enarmonica).

Vedi anche

Notazione delle percussioni
Preferenze
Gruppi irregolari
Voci
How to enter a chord  (in inglese)
How to enter a rest  (in inglese)
How to span a stem over two staves  (in inglese)

Link esterni

Video tutorial: MuseScore in Minutes: Lesson 3 - Note input
Video tutorial: MuseScore in Minutes: Lesson 4 - MIDI Keyboard Input
Video tutorial: MuseScore in Minutes: Lesson 5 - More Input Ideas

Modalità di modifica

Molti elementi nello spartito possono essere modificati con la Modalità di modifica:

Doppio clic: Avvia la Modalità di modifica

Esc: Si lascia la Modalità di modifica

alcuni elementi, nella modalità di modifica, mostrano delle maniglie, che possono essere spostate trascinandole col
mouse o con comandi da tastiera.

Legatura di portamento in Modalità di modifica:

Comandi disponibili da tastiera:

←: sposta la maniglia a sinistra di uno spazio (la distanza tra due linee del pentagramma)
→: sposta la maniglia a destra di uno spazio
↑: sposta la maniglia su di uno spazio
↓: sposta la maniglia giù di uno spazio
Ctrl+← (Mac: ⌘+←): sposta la maniglia a sinistra di 0,1 spazi
Ctrl+→ (Mac: ⌘+→): sposta la maniglia a destra di 0,1 spazi
Ctrl+↑ (Mac: ⌘+↑): sposta la maniglia su di 0,1 spazi
Ctrl+↓ (Mac: ⌘+↓): sposta la maniglia giù di 0,1 spazi
Alt+←: sposta la maniglia a sinistra di 0,1 spazi
Alt+→: sposta la maniglia a destra di 0,1 spazi
Alt+↑: sposta la maniglia su di 0,1 spazi
Alt+↓: sposta la maniglia giù di 0,1 spazi
Maiusc+←: sposta la maniglia all'ancoraggio di sinistra
Maiusc+→: sposta la maniglia all'ancoraggio di destra
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Tab: va alla maniglia successiva

Per spostare manualmente gli elementi dello spartito selezionarli con un doppio clic ed utilizzare le frecce direzionali.

Vedi anche

Modifica testo
Legatura di portamento
Graffe
Linee
Proprietà gruppo note
Crescendo e diminuendo

Tavolozze e area di lavoro

Una tavolozza è uno spazio archiviazione contenente un gruppo di simboli musicali correlati. Un insieme di tavolozze è
chiamata Nonexistant node nid: 39841 ed è ancorata, per impostazione predefinita, sul bordo sinistro della finestra. Può
essere sganciata se lo si desidera, ridimensionata e trascinata in qualsiasi posizione comoda. Può anche essere ancorata
sul lato destro, ridotta o a piena ampiezza, condividendo efficacemente lo spazio con l'Ispettore.

Le aree di lavoro possono essere attivate o disattivate con Visualizza → Tavolozze o usando la scorciatoia F9 (Mac: fn+F9).

Utilizzare le tavolozze

Clic sul titolo di una tavolozza per visualizzarne il contenuto. I simboli sono applicati alla partitura, da una tavolozza, così:

Selezionando uno o più elementi della partitura e facendo doppio clic sul simbolo nella tavolozza.
Trascinando il simbolo e rilasciandolo nella posizione scelta sul pentagramma .

Ad esempio, è possibile aggiungere rapidamente il simbolo Tenuto (—) ad un gruppo di note:

1. Selezionare le note (clic sulla prima nota, poi Maiusc + clic sull'ultima nota)
2. nella tavolozza Articolazioni e Abbellimenti fare doppio clic sul simbolo Tenuto

Per aggiungere altri simboli musicali alla propria tavolozza vedi: Tavolozza personalizzata .

Area di lavoro

MuseScore fornisce due preselezioni Nonexistant node nid: 39841 – Avanzata e Essenziale
(quest'ultima è una versione ridotta della prima con meno tavolozze ed un minor numero di simboli). Selezionare una o
l'altra utilizzando il menu a tendina in basso a sinistra della finestra, sotto le tavolozze stesse.
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È possibile creare la propria Tavolozza personalizzata  selezionando un'area di lavoro esistente utilizzando il menu in
basso a sinistra della finestra, un clic sul segno più, e inserendo un nome per la nuova area di lavoro. In questo modo è
possibile modificare autonomamente le tavolozze e i simboli di questa Area di lavoro.

Tavolozze preimpostate

L'Area di lavoro più ricca di funzionalità contiene le seguenti tavolozze:

Note di abbellimento (acciaccature)
Chiavi
Armatura di chiave
Indicazione metrica
Stanghette
Linee
Arpeggi e Glissando
Respiri e Pause
Graffe
Articolazioni e abbellimenti
Alterazioni
Dinamiche
Diteggiatura
Testa delle note
Tremolo
Salti e Ripetizioni
Tempo
Testo
Interruzioni e Spaziatori
Abbellimenti cornamusa
Proprietà gruppo note
Cornici e battute
Schemi tastiera

Tavolozza Generale

I simboli musicali che non fanno parte delle tavolozze nell'Area di lavoro Avanzata si trovano nella Tavolozza generale che
si attiva premendo Z o Maiusc+F9 (Mac: fn+Maiusc+F9).

Vedi anche
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Tavolozza personalizzata
Nonexistant node nid: 39841
Tavolozza generale

Ispettore e proprietà degli elementi

Per la maggior parte degli elementi le opzioni avanzate sono disponibili tramite il pulsante destro del mouse (anche noto
come clic secondario) e possono essere visualizzate e modificate da Ispettore.

Ispettore

Per attivare o disattivare l'Ispettore andare su Visualizza → Ispettore o utilizzare la scorciatoia F8 (Mac: fn+F8). L'Ispettore sarà
visualizzato, per preimpostazione, sul lato destro della finestra principale.

La finestra dell'Ispettore può essere sganciata con un doppio clic sulla barra del titolo o un clic sul relativo pulsante

Quando un elemento viene selezionato le sue proprietà sono visibili nell'Ispettore.

Categorie

Nell'Ispettore ci sono diverse opzioni in ciascuna delle categorie.

Gli elementi hanno disponibili i seguenti controlli: Visibile, Colore e spiazzamento Orizzontale/Verticale.

Se la casella di controllo "Visibile" è deselezionata l'elemento diventerà grigio in MuseScore e non sarà stampato o
mostrato in caso di esportazione come PDF o immagine.

"Colore" vi permette di scegliere il colore dell'elemento. L'elemento resterà del colore scelto quando la partitura sarà
stampata o esportata.

"Spiazzamento orizzontale" e "Spiazzamento verticale" consentono di regolare con precisione il posizionamento di un
singolo elemento, inserendo i valori esatti per il suo spiazzamento dalla posizione predefinita alle coordinate X/Y del
piano.

Altre categorie possono essere visualizzate solo in casi specifici, mirati, come Stanghetta, che è presente solo quando è
selezionata una stanghetta.
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Alcuni elementi possono essere correlati tra loro. Un esempio potrebbe essere quello di una nota selezionata che abbia
un punto e una coda come quella nell'esempio:

Sono disponibili diverse categorie di opzioni relative alla nota, tra cui accordo, nota e segmento. In fondo, sotto
"Selezione", è possibile accedere alle opzioni per gli elementi correlati, inclusi gambo e, in questo esempio, gruppo note e
punto.

Se si seleziona una misura, l'ispettore mostrerà solo le opzioni comuni a ogni nota nella battuta: Visibile/Invisibile e colore.
Per modificare le proprietà della battuta stessa, fare clic su una parte vuota della battuta e selezionare "Proprietà battuta",
come illustrato di seguito.

Quando sono selezionati più elementi, se hanno un diverso valore per una data proprietà, la proprietà viene visualizzata
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in blu. Se si modifica questa proprietà, essa cambierà per tutti gli elementi selezionati.

Proprietà (accessibili tramite il tasto destro del mouse)

Proprietà battuta

Per modificare le proprietà di una misura, fare clic su una parte vuota della misura e selezionare "Proprietà battuta"

Dall'interno di una finestra Proprietà battuta aperta, è possibile spostarsi per modificare la misura precedente o successiva
tramite questi pulsanti, in basso a sinistra della finestra: NOT FOUND: Previous:Next Buttons.png (si noti che mentre la
finestra cambia, la misura indicata come selezionata nella partitura non lo fa. Fate attenzione).

Proprietà pentagramma

Le proprietà pentagramma sono accessibili anche facendo clic destro su una battuta o cliccando col tasto destro sul nome
di uno strumento.

Le proprietà pentagramma includono attualmente sia la sezione Proprietà del pentagramma che la sezione Proprietà
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parte:

Le opzioni del pentagramma comprendono colore, numero delle linee, spazio tra le linee, le opzioni "nascondi",
dimensioni del pentagramma e così via.

Le opzioni "parte" includono nome dello strumento, nome della parte (utilizzato per l'estrazione parte), trasporto in
riproduzione ed estensione delle note utilizzabile.

Vedi anche

Operazioni sulle battute
Inserimento note
Impaginazione e formattazione
Proprietà tipo di pentagramma
Estrazione parti

Operazioni sulle battute

Aggiungere

Per aggiungere una battuta alla fine della partitura premere Ctrl+B (Mac: ⌘+B), oppure selezionare dal menu Aggiungi →

Battute → Aggiungi una battuta . Per aggiungere più battute premere Alt+Maiusc+B (Mac: Option+Maiusc+B), oppure selezionare dal
menu Aggiungi → Battute → Aggiungi battute... .

Inserire

Selezionare una battuta e quindi premere Ins, oppure selezionare dal menu Aggiungi → Battute → Inserisci una battuta  per
inserire una battuta vuota prima di quella selezionata. Per inserire più battute premere Ctrl+Ins (non ci sono scorciatoie per
il Mac), oppure dal menu Aggiungi → Battute → Inserisci battute....

Cancellare

Selezionare la battuta da cancellare e premere Ctrl+Canc (Mac: ⌘+Fn+Canc).

Proprietà

Per modificare le proprietà di una battuta fare clic con il tasto destro del mouse in un'area vuota della battuta e scegliere
Proprietà battuta...:
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Pentagrammi

Agendo sulla proprietà visibile è possibile mostrare o nascondere le note e le linee del pentagramma della battuta
selezionata.
Agendo sulla proprietà senza gambo è possibile mostrare o nascondere tutti gambi delle note della battuta
selezionata. Le note che normalmente hanno i gambi come le minime (2/4) e le semiminime (1/4) se contrassegnate
senza gambo mostreranno solo le teste delle note.

Durata della battuta

La durata Nominale corrisponde alla unità di tempo mostrata nella partitura.
È possibile modificare la durata Reale di una battuta nonostante l'unità di tempo presente nella partitura.
Di solito la durata nominale è uguale a quella reale. Tuttavia una battuta (per esempio la battuta iniziale in levare,
anacrusi) può avere una durata reale inferiore alla durata nominale.

Nella immagine qui sotto la battuta iniziale in levare ha una durata nominale di 4/4 ma una durata reale di 1/4. Le battute
centrali hanno sia la durata nominale che quella reale di 4/4. L'ultima battuta con una minima puntata, che è
complementare alla prima, ha una durata reale di 3/4:

Altro

Escludi da conteggio battute 
Si utilizza "Escludi da conteggio battute" in caso di battute "irregolari", cioè quelle che non devono essere
conteggiate per la numerazione delle battute. Di solito una battuta iniziale in levare è segnata come "Escludi da
conteggio battute".

Aggiungi al numero di battuta 
È possibile utilizzare l'opzione "Aggiungi al numero di battuta" per influire sulla numerazione delle battute. È
possibile inserire un numero positivo oppure negativo. Notare che questa modifica interesserà le battute successive.
Un valore di "-1" avrà lo stesso effetto di escludere la battuta dal conteggio delle battute.

Larghezza battuta 
Con questa opzione è possibile aumentare o diminuire lo spazio orizzontale tra gli elementi della partitura (note,
pause, ecc.).

Conteggio delle ripetizioni 
Se la battuta è alla fine di una ripetizione, è possibile definire quante volte la ripetizione deve essere suonata.

Interrompi le battute d'aspetto 
Questa proprietà interrompe una pausa che dura più di una battuta a partire dalla battuta corrente. Questa opzione
deve essere selezionata prima di selezionare l'opzione "Crea battute d'aspetto" nel menu Stile → Generale...,
all'etichetta "Spartito".
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Le battute d'aspetto si interrompono automaticamente in presenza di segni importanti come marcatori di riferimento,
cambio di unità di tempo, doppie stanghette, battute irregolari, ecc. La selezione predefinita per le partiture è
disattiva, per le parti è attiva.

Numerazione delle battute

MuseScore inserisce automaticamente la numerazione nella prima battuta di ogni accollatura (eccetto la prima accollatura
della partitura, di fatto eccetto la battuta con il numero 1), ma sono disponibili ulteriori opzioni di numerazione. Dal menu
principale selezionare Stile → Generale..., nel riquadro di sinistra selezionare l'etichetta "Intestazione, piè di pagina,
numeri". Nella parte inferiore del riquadro di destra c'è la sezione "Numeri delle battute".

Mettere la spunta nella casella di controllo vicino a "Numeri delle battute" per abilitare la numerazione automatica delle
battute.

Selezionare "Mostra il primo" se si vuole visualizzare il numero sulla prima battuta.

Selezionate "Tutti i pentagrammi" se si vogliono i numeri su tutti i pentagrammi dell'accollatura. Altrimenti la numerazione
sarà mostrata solo sul primo pentagramma di ogni accollatura.

È possibile mostrare i numeri in "Ogni accollatura" (il numero appare nella prima battuta della riga), oppure secondo un
"Intervallo" e specificare l'ampiezza dell'intervallo. Per esempio con un intervallo di 1 tutte le battute saranno numerate,
con un intervallo di 5 la numerazione sarà visualizzata ogni 5 battute.

Dividere e unire

È possibile ottenere una battuta più lunga o al contrario una più corta. Si può sempre modificare il conteggio e l'unità di
tempo, ma ora c'è una nuova funzione per dividere o unire le battute. Le linee che uniscono i gruppi di note possono
essere modificati automaticamente.

Unire

1. Selezionare le battute che si vogliono unire
2. Modifica → Battuta → Unisci battute

Nota: se si selezionano le battute di un solo un pentagramma, saranno unite anche le battute corrispondenti degli altri
pentagrammi dell'accollatura.

 

Dividere

1. Selezionare una nota (o un accordo)
2. Modifica → Battuta → Dividi battuta

Nota: se si seleziona una nota di un pentagramma, tutti gli altri pentagrammi dell'accollatura saranno divisi nello stesso
punto.

Vedi anche

Come eliminare le battute
How to span a measure over multiple systems
Come creare uno spartito senza Unità di tempo (e chiave)

Voci

Si possono avere fino a 4 Voci su ogni pentagramma. Una voce è una linea musicale o parte che può avere il proprio
ritmo indipendentemente dalle altre voci sullo stesso rigo. Le voci sono anche chiamate 'layers' in altri software di
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notazione musicale.

In una battuta polifonica la voce 1 mostra gli steli verso l'alto, la voce 2 verso il basso.

Nota: la funzione denominata "Voci" non deve essere confusa con "righi vocali", che possono essere aggiunti dalla
finestra di dialogo Strumenti (cui si accede premendo I). Quando si crea un punteggio SATB "chiuso", utilizzare le voci 1 e
2 sia per Soprano e Contralto, sul pentagramma in alto, che su quello in basso per Tenore e Basso - non è consigliabile
usare le Voci 3 e 4 per Tenore e Basso.

Quando usare le voci

Se su un singolo rigo, all'interno di un accordo, volete che i gambi puntino in direzioni opposte.
Se, all'interno di un pentagramma, volete che note di diversa durata suonino simultaneamente.

Come usare le voci

1. Assicurarsi di essere in modalità inserimento note: il pulsante della Voce 1 viene evidenziato in blu nella barra
inserimento note. Per prima cosa inserire la voce più alta (per un esempio, vedere l'illustrazione seguente). Quando
si inseriscono le note alcune di queste possono avere il gambo rivolto in giù, la direzione dei gambi sarà
automaticamente invertita quando verrà aggiunta la seconda voce.

2. Una volta terminato l'inserimento delle note di una sezione della Voce 1 premere il tasto ← ripetutamente per
muovere il cursore, nota per nota, fino alla prima nota della sezione (o in alternativa utilizzare Ctrl← per spostarsi di
una battuta alla volta). Oppure semplicemente uscire dalla modalità di inserimento note (premere Esc) e fare clic
direttamente sulla prima nota.

3. Per inserire le note della voce 2, assicurarsi di essere in modalità inserimento note e che la nota della Voce 1,

all'inizio della sezione, sia selezionata. Fare clic sul pulsante della "Voce 2"  (a destra sulla barra), o utilizzare la
scorciatoia CtrlAlt2. Inserire tutte le note della parte vocale inferiore (gambi in basso). Il risultato finale potrebbe
essere simile a questo:

Notare che è necessario attivare la modalità inserimento note per selezionare un'altra voce.

Nascondere le pause

Solo le pause delle voci 2, 3, 4 possono essere cancellate, quelle della voce principale (1- blu), possono solo essere
nascoste.

Per nascondere una pausa selezionarla e premere V o deselezionare la casella "Visibile" nell'Inspettore, che può essere
richiamato dal menù Visualizza o con il tasto F8 (Mac: fn+F8). Se avete messo la spunta su Mostra elementi invisibili  nel menù
Visualizza, la pause saranno visualizzate in grigio sullo schermo. Le pause nascoste non saranno visibili se stamperete o
esporterete come PDF, PNG, SVG, ecc.

Scambiare le voci

1. Selezionare un intervallo di note
2. Modifica → Voci

3. Scambiare qualsiasi coppia di voci
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Nota: La selezione può comprendere il contenuto di qualsiasi voce, ma ne saranno scambiate solo due alla volta.

Vedi anche

Shared noteheads

Collegamenti esterni

Come fondere/unire/implodere due pentagrammi in uno con due voci
Come inserire su un pentagramma più note di diversa durata
Come fare coincidere le note in unisono
Video tutorial: How To Write Two Parts On One Staff: Voices

Copia e incolla

Copia e incolla è un utile strumento per ripetere una sezione di musica, oppure per spostare un passaggio .

Copia

1. Clic sulla prima nota della selezione
2. Maiusc+Clic sull'ultima nota della selezione. La musica selezionata sarà evidenziata da un rettangolo blu
3. Dal menu selezionare Modifica → Copia, oppure premere Ctrl+C (Mac: ⌘+C)

Incolla

1. Clic sulla prima nota o sulla prima battuta di destinazione
2. Dal menu selezionare Modifica → Incolla oppure premere Ctrl+V (Mac: ⌘+V)

Ripetizione rapida

1. Selezionare una nota o una battuta
2. Premere R e MuseScore duplicherà l'oggetto selezionato

Filtro selezione

Per poter scegliere esattamente cosa copiare e incollare, è possibile utilizzare un filtro prima di copiare una selezione.

1. Abilitare il Filtro selezione con il tasto F6 (Mac: fn+F6) oppure Visualizza → Filtro selezione
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Il Filtro selezione ha questo aspetto:

La scheda Filtro selezione apparirà sotto la scheda Tavolozze. Può essere staccata dalla finestra principale e diventare
una finestra indipendente ("floating window" in inglese); se la si sposta con il mouse sopra la scheda Tavolozze (oppure
sulla scheda Ispettore), le schede possono essere selezionate utilizzando la linguetta che appare sul bordo inferiore.

2. Deselezionare quello che non si vuole copiare
Esempio: Articolazioni e Legature di portamento non sono selezionate.

3. Copiare e incollare come descritto sopra
(nell'esempio vengono copiate le battute 4 e 5 e si incolla nelle battute 12 e 13)

4. Risultato: le legature di portamento non sono state copiate
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Vedi anche

Se si vogliono modificare delle note senza cambiare il ritmo, è possibile combinare le funzioni trasposizione o modifica
altezza delle note con copia e incolla.

Link esterni

Video tutorial: Lyrics, copying & dynamics

Modalità selezione

Ci sono diverse modalità di selezione (metodi per selezionare gli oggetti).

Selezione di un singolo elemento

Basta cliccarci sopra.

Selezione di un intervallo

1. Selezionare il primo elemento (leggi: evidenziare con un clic)
2. Premere Maiusc

3. Selezionare (con un clic) l'ultimo elemento

Tutti gli elementi selezionati saranno all'interno di un rettangolo blu.

Nota 1: Alcuni elementi possono essere selezionati come intervalli: note, pause, articolazioni ...
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Nota 2: Vedi Copia e incolla: Filtro selezione per selezionare solo alcuni elementi nell'intervallo.

Selezione di elementi diversi non successivi

1. Selezionare il primo elemento (leggi: evidenziare con un clic)
2. Premere Ctrl e tenere premuto
3. Selezionare (con un clic) gli altri elementi

La nota 1 qui sopra si applica ancora.

Selezionare tutti gli elementi simili

1. Selezionare un elemento
2. Clic destro → Seleziona >

3. Sono disponibili diverse opzioni

Tutti gli elementi simili: in tutta la partitura
Tutti gli elementi simili nello stesso pentagramma: solo nello stesso pentagramma
Tutti gli elementi simili nella selezione: solo se la →selezione di un intervallo è attiva, seleziona gli elementi
simili solo all'interno di quella selezione
Di più...

Esempio: Un diesis (alterazione) selezionato

È possibile contrassegnare (e combinare) le seguenti selezioni:

Stesso sottotipo: in questo esempio saranno selezionati solo i diesis (non i bemolli, né i naturali); alcuni
elementi hanno un sottotipo (ad esempio le articolazioni, le alterazioni ...)
Stesso pentagramma: solo gli elementi nello stesso pentagramma
Stessa voce: solo gli elementi nella stessa voce
Stessa accollatura: solo gli elementi nella stessa accollatura
Stessa selezione: se una selezione è attiva, solo gli elementi in quella selezione

Possono essere eseguite diverse azioni (una sola scelta): Aggiungi, Sottrai, Sostituisci e Cerca

Per cosa sono utilizzati

Copia e incolla
Modalità modifica per spostare oggetti simili
Ispettore e proprietà degli elementi

Vedi anche

Nozioni di base in particolare capitolo Inserimento note
Notazione in particolare capitolo Alterazioni
Testi in particolare capitolo Modifica del testo e Griglia di spostamento di simboli o del testo di pentagramma
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Modi di visualizzazione

È possibile visualizzare lo spartito in modalità differenti.

Fatta eccezione per Vista pagina/Vista continua, tutte le seguenti opzioni si trovano sotto il menu Visualizza in
MuseScore.

Vista pagina/Vista continua

In Vista pagina è possibile visualizzare la partitura formattata come apparirà una volta stampata, o esportata come file
PDF o immagine. In Vista continua , la partitura verrà mostrata come un'unica accollatura senza interruzioni.

Notare che nel passaggio da Vista pagina a Vista continua la partitura viene riformattata per la nuova visualizzazione e le
regolazioni manuali potrebbero richiedere una revisione.

È possibile cambiare modalità di visualizzazione qui:

Vista pagina

In Vista pagina, la partitura è mostrata come una o più pagine di dimensioni specifiche con margini, e si possono vedere
tutte le linee e le interruzioni di pagina, comprese quelle aggiunte manualmente e quelle calcolate automaticamente dal
software. (Le interruzioni di pagina manuali possono essere utili per avere la pagina ben posizionata quando, per
esempio, la si trasforma in parti orchestrali).

Vista continua

In Vista continua , la partitura verrà mostrata come un'unica accollatura senza interruzioni. Se il punto di partenza non è in
vista sarà visualizzata una forma sostitutiva dei numeri di misura, nomi degli strumenti, chiavi, tempo e tonalità.

Prima di stampare una partitura, o di Condividere le partiture online, passare a Vista pagina per controllare interruzioni di
linea/pagina.

Nota: Poiché il layout è semplificato MuseScore può eseguire più velocemente Vista continua di Vista pagina.

Zoom

In Vista pagina o Continuo Vista, è possibile modificare il livello di zoom (si noti che questo non pregiudica le dimensioni in
stamp) qui:

Nel menu a discesa si può scegliere una percentuale di scala per visualizzare la partitura com'è, oppure Larghezza
pagina, Pagina intera, e Due pagine, che sono scalate relativamente alla dimensione della finestra.
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Le opzioni Zoom avanti eZoom indietro e relative scorciatoie da tastiera si trovano nel menù Visualizza e si può anche
ingrandire e ridurre utilizzando la rotella del mouse mentre si tiene premuto il tasto Ctrl (Mac: Cmd).

Visualizzare più di una partitura

Si possono avere gli spartiti affiancati

o sovrapposti
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È possibile trascinare il confine che separa i due spartiti per regolare la quantità di spazio nella finestra dedicata a
ciascuno.

Schermo intero

La modalità Schermo intero espande MuseScore per riempire lo schermo in modo che sia visibile maggior contenuto.
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Navigatore

Se la partitura è grande e si desidera sapere in che punto ci si trova, o raggiungere una pagina specifica, utilizzare il
Navigatore nella parte inferiore della finestra

La casella blu rappresenta l'area della partitura visibile nella finestra principale. È possibile trascinare la casella blu o la
barra di scorrimento o fare clic su un'area per raggiungerla immediatamente.

Per attivare/disattivare il Navigatore, andare al menù Visualizza e selezionare Navigatore o utilizzare la scorciatoia F12 (Mac:
fn+F12).

Ctrl + F apre la barra Trova . Si può inserire un numero di battuta o di pagina utilizzando il formato pXX (dove XX =
numero di pagina), o il testo dei Marcatori di riferimento.-->

Vedi anche

Navigatore
Salva/Esporta/Stampa
Formato file
Impaginazione e formattazione

Annullare e ripetere

MuseScore ricorda un numero illimitato di azioni annulla/ripeti.

Le scorciatoie standard sono:

Annulla Ctrl+Z (Mac: ⌘+Z)
Ripeti Ctrl+Maiusc+Z o Ctrl+Y (Mac: ⌘+Maiusc+Z)

Oppure utilizzare i pulsanti della barra degli strumenti:

Salva/Esporta/Stampa

Le azioni per salvare ed esportare i file sono state distinte in due menu: 'Salva' e 'Salva come' (lo stesso per 'Salva una
copia' e 'Salva selezione') per i file nei formati nativi di MuseScore (.mscz e .mscx) e 'Esporta' (e 'Esporta parti') per i
formati non nativi (MusicXML, MIDI, vari formati grafici e audio). 'Stampa' è per stampare direttamente su una stampante
un file MuseScore

Menu file

Le voci disponibili sono: 'Salva', 'Salva come...', 'Salva una copia...', 'Salva selezione...', 'Salva Online...', 'Esporta...',
'Esporta parti...' e 'Stampa'
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Formati disponibili nel menu 'Salva', 'Salva come...', 'Salva una copia...', 'Salva selezione...' e 'Salva Online...'

Formati disponibili nel menu 'Esporta' (e 'Esporta parti...')

Nota: il formato File MuseScore non compresso è disponibile sia in 'Salva' che in 'Esporta'.
Per esportare file *.mscz di oltre una certa dimensione in file *.wav, può essere utile togliere, agendo su "Visualizza", il
Navigatore dalla pagina del file *mscz.

Stampa

A seconda della stampante utilizzata ci possono essere opzioni differenti. In generale sono disponibili le opzioni relative
all'intervallo di pagine (Tutte, Selezione, Pagina corrente, Pagine), numero di copie.
Se è installata una stampante PDF, è possibile utilizzarla al posto di 'Esporta' file PDF.
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Vedi anche

Formato file
Estrazione parti

Condividere le partiture online

Andare all'indirizzo musescore.com/sheetmusic  per visualizzare altre partiture scritte con MuseScore.

È possibile salvare e condividere le partiture online nel sito MuseScore.com . Potete scegliere di salvare una partitura in
forma riservata per un accesso personale da qualunque computer, oppure scegliere di condividere la partitura
pubblicamente. MuseScore.com permette di visualizzare e riprodurre le partiture all'interno del browser - una funzione
aggiuntiva dal titolo VideoScores permette la sincronizzazione tra la partitura e un video su YouTube. È possibile utilizzare
la partitura al di fuori del browser scaricandola in diversi formati (inclusi PDF, MIDI, MP3, MusicXML e il formato originale
MuseScore).

Creare un account

1. Andare all'indirizzo web MuseScore.com  e fare clic su "Create new account ". Scegliere un nome utente,
inserire un indirizzo email valido e premere il tasto "Crea nuovo account".

2. Attendere qualche minuto per una e-mail dal supporto MuseScore.com. Se la mail non arriva controllare la cartella
spam.

3. Fare clic sul collegamento nell'e-mail per raggiungere il vostro profilo utente  e cambiare la password.

Condividere una partitura direttamente da MuseScore

È possibile salvare direttamente online una partitura selezionando dal menù File → Salva Online....

Se non si dispone ancora di un account MuseScore: prima crearne uno cliccando sul collegamento Crea un account.
Questo aprirà il vostro browser e vi collegherà a https://musescore.com/user/register

Poi inserire l'indirizzo e-mail o il nome utente MuseScore e la password. Una volta eseguito l'accesso sarà possibile
inserire le informazioni della partitura.
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1. Il titolo è quello della vostra partitura.
2. La descrizione apparirà accanto ad esso.
3. È possibile scegliere di rendere pubblica (visibile a tutti) la partitura, o Privata (visibile solo a voi) - comunque è

possibile creare un 'collegamento nascosto'.
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4. Scegliere una licenza. Utilizzando una Creative Commons license , potete permettere agli altri di utilizzare la
vostra partitura con alcune restrizioni.

5. È possibile aggiungere delle etichette per aiutare la ricerca delle partiture all'interno del sito MuseScore.com. - si
separano utilizzando il tasto Invio.

6. Nel caso la partitura sia stata salvata online precedentemente, verrà automaticamente aggiornata quella esistente.
Deselezionare Update the existing score per salvarla online come una nuova partitura.

Caricare una partitura sul sito MuseScore.com

È possibile inoltre caricare una partitura direttamente su MuseScore.com.

1. Fare clic sul collegamento Upload link  su MuseScore.com.
2. Sono disponibili le stesse opzioni del menù Salva Online.
3. È inoltre possibile accedere a più informazioni, come ad esempio Genere.

Nota: Se si raggiunge il limite di caricamento di cinque partiture è ancora possibile Condividere una partitura direttamente
da MuseScore, ma solo le ultime cinque saranno visibili. Se si desidera caricarne un numero superiore eseguire prima
l'aggiornamento a un Pro Account .

Modificare una partitura sul sito MuseScore.com

Se volete fare delle modifiche alle partiture pubblicate su MuseScore.com, apportare le modifiche nel file MuseScore sul
vostro computer e quindi seguire i seguenti passaggi:

1. Andare alla pagina degli spartiti sul sito MuseScore.com
2. Fare clic sul collegamento Edit
3. All'interno del modulo potete cambiare il file le altre informazioni, i privilegi ecc.

Vedi anche

Come eliminare uno spartito salvato su MuseScore.com

Partitura in Do

Il pulsante Partitura in Do (in inglese Concert pitch) nella barra degli strumenti permette di passare dalla visualizzazione con gli
strumenti traspositori attivati (come devono essere scritte le note per gli strumenti traspositori) alla visualizzazione delle
note reali. Questo comporta anche una diversa visualizzazione dell'armatura di chiave e/o della chiave a seconda dello
strumento traspositore interessato.

Nota: Prima della stampa, se la partitura comprende degli strumenti traspositori assicurarsi che il pulsante non sia
selezionato.

Vedi anche

Transposizione: Strumenti traspositori
Alterazioni: Sostituzione enarmonica delle alterazioni

Notazione

Nel precedente capitolo "Nozioni di base" si apprendono l'Inserimento note e l'interazione con la tavolozza. Il capitolo
"Notazione" descrive i diversi tipi di notazione in modo più dettagliato, compresi alcuni metodi di notazione avanzati

Vedi anche "Argomenti avanzati"

Alterazioni
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Le Alterazioni possono essere impostate/modificate trascinando il simbolo corrispondente dalla tavolozza Alterazioni fino
ad una nota nello spartito.

Se si vuole solo cambiare l'intonazione di una nota è possibile selezionare la nota e premere:

↑: Aumenta l'altezza di una nota di un semitono (privilegia i diesis).
↓: Diminuisce l'altezza della nota di un semitono (privilegia i bemolle).
Ctrl+↑ (Mac: Cmd+↑): Aumenta l'altezza della nota di un'ottava.
Ctrl+↓ (Mac: Cmd+↓): Diminuisce l'altezza della nota di un'ottava.
J: Modifica l'ortografia enarmonica di una nota.

Per modificare un'alterazione esistente in un'alterazione di precauzione (racchiusa tra parentesi), trascinare le parentesi
dalla tavolozza alterazioni sull'elemento (non la testa della nota) esistente. Per rimuovere le parentesi, selezionare
l'alterazione e premereCanc.

Se successivamente si modifica l'altezza con i tasti cursore, le impostazioni manuali per l'alterazione vengono rimosse.

Sostituzione enarmonica delle alterazioni

La funzione del menù Note → Sostituzione enarmonica delle alterazioni cerca di applicare le alterazioni corrette per l'intero spartito.

Vedi anche

Armatura di chiave: Change

Collegamenti esterni

Alterazioni  su Wikipedia

Armatura di chiave

L'Armatura di chiave si inserisce, o modifica, trascinandola dalla tavolozza Armatura di chiave ad una battuta, o su una
preesistente.

F9 (Mac: ⌥+⌘+K) mostrare o nascondere la finestra della tavolozza.

Modificare

Trascinare il simbolo dalla tavolozza sul simbolo già presente nello spartito.
Se si desidera cambiare la tonalità solo per un pentagramma della partitura (ad esempio per la musica contemporanea),
premere Ctrl (Mac: ⌘) mentre si trascina l'armatura di chiave sul relativo pentagramma.

Aggiungere

Trascinare il simbolo dalla tavolozza a una zona vuota di una battuta: il simbolo della tonalità viene inserito all'inizio della
battuta.
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Se si desidera cambiare la tonalità solo per un pentagramma (ad esempio per la musica contemporanea), premere Ctrl

(Mac: ⌘) mentre si trascina l'armatura di chiave sul relativo pentagramma.

Eliminare

Selezionare il simbolo della tonalità e premere Canc o trascinare dalla tavolozza la cella vuota (dall'area di lavoro
avanzata) sulla battuta.

Armatura di chiave di cortesia

È possibile utilizzare l'Ispettore, o Stile → Generale... → Pagina per inserire "Crea armatura di chiave di cortesia".
L'Ispettore interesserà solo la parte selezionata, l'impostazione da 'stile' interesserà l'intera partitura.

Naturali sui cambiamenti di tonalità

Quando si modifica l'armatura di chiave, è possibile nascondere il naturale/i in alcuni casi. Da Stile → Generale... → Accidenti

vedrete le opzioni:

Premere Applica o OK. Se siete in una parte della partitura è possibile applicarlo a tutta la parte con il corrispondente
tasto.

In questo esempio, la variazione di tonalità mostra il bequadro.

]

Armatura di chiave e pause di battuta

Le pause di più battute vengono interrotte se c'è una modifica nell'armatura di chiave.

Vedi Pause di battuta

Armatura di chiave interruzione di sezione

L'armatura di chiave di cortesia non viene mostrata prima di un'interruzione di sezione
Vedi Interruzioni e spaziatori: Interruzione di sezione

Armatura di chiave personalizzata
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Premere Maiusc+K per visualizzare la Tavolozza Generale...

È possibile utilizzare il doppio diesis o il doppio bemolle ecc.

Si noti tuttavia che attualmente le tonalità personalizzate non sono supportate in riproduzione.

Arpeggi e Glissando

Gli Arpeggi si inseriscono selezonando la nota di destinazione e facendo doppio clic sul corrispondente simbolo nella
tavolozza Arpeggi e Glissandi. L'Ispettore consente di effettuare diverse regolazioni delle proprietà di aspetto e di
riproduzione del simbolo.
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Per modificare la lunghezza dell'arpeggio, attivarlo con un doppio clic e trascinare la maniglia in alto o in basso.

I Glissando si inseriscono con un doppio clic sul corrispondente simbolo della tavolozza Arpeggi e Glissandi dopo aver
selezionato la prima di due note consecutive sullo stesso pentagramma.

Si modifica o elimina il testo di un glissando selezionandolo con un clic e utilizzando l'Ispettore. Se non c'è abbastanza
spazio tra due note, MuseScore non visualizzerà il testo.

Il glissato per gli strumenti a corda, come la chitarra, può essere creato modificando la linea glissando predefinita.
Normalmente, può essere creato solo un glissato per voce perché MuseScore, per impostazione predefinita, utilizza
sempre la nota superiore di un accordo come destinazione. Tuttavia, c'è una semplice soluzione per i glissato di accordi:
Costruire l'accordo di destinazione nota per nota, partendo dal basso, e applicare un glissando dalla nota desiderata dopo
ogni passaggio. Per esempio:

Un glissato breve può essere creato modificandone le linee, esse hanno infatti le maniglie che consentono la regolazione
di lunghezza e angolazione.

Collegamenti esterni

Arpeggio  su Wikipedia
Glissando su Wikipedia
Glissando su Wikibooks

Articolazioni e Abbellimenti

Una serie completa di simboli si trova nella tavolozza Articolazioni e Abbellimenti tavolozza nell' Area di lavoro
Avanzata.
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C'è anche la versione abbreviata nella tavolozza Essenziale

Articolazioni

Le Articolazioni sono i simboli aggiunti alla partitura per mostrare come una nota o un accordo devono essere suonati. I
simboli principali di questo gruppo sono:

Corona
Staccato
Mezzo-staccato / Portato
Staccatissimo
Tenuto
Sforzato
Marcato

Articolazioni specialistiche sono dispoonibili anche per arco/pizzicato, fiati ecc.

Ornaments

Gli Abbellimenti includono:

Note di abbellimento (appoggiatue, acciaccature)
Mordente, Mordente inferiore, Pralltrillers
Trillo
Gruppetto

Bends

Lo __ strumento Bend __ viene utilizzato per trascrivere una serie di curve semplici o complesse (cioè a più fasi) nei
pentagrammi ordinari e nelle tablature. Maggiori dettagli possono essere trovati in
Bends …

Utilizzare Articolazioni e Abbellimenti

Per applicare un'Articolazioni o Abbellimenti

1.Selezionare una nota o un intervallo di note.
2. Fate doppio clic sul simbolo nella tavolozza.

In alternativa, è possibile aggiungere il simbolo trascinandolo dalla tavolozza direttamente sulla nota.

Scorciatoie

Attiva/disattiva Staccato: Shift+S

Attiva/disattiva Tenuto: Ctrl+Alt+N (Mac: Cmd+Option+N)

Attiva/disattiva Marcato: Ctrl+Alt+O (Mac: Cmd+Option+O)

Aggiungere acciaccatura (note di abbellimento): /

In MuseScore è possibile personalizzare le scorciatoie da Preferenze.

Per regolare la posizione di un simbolo
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Immediatamente dopo l'aggiunta di un'articolazioni o abbellimento dalla tavolozza, il simbolo viene selezionato
automaticamente: Può quindi essere spostato verso l'alto o verso il basso dalla tastiera come segue:

Premere i tasti freccia su/giù per un posizionamento fine (0,1 sp alla volta);
Premere Ctrl+↑ o Ctrl+↓ (Mac: Cmd+↑ o Cmd+↓) per le regolazioni verticali più ampie (1 sp alla volta).
Per abilitare le regolazioni in tutte le direzioni dalla tastiera:

1. Doppio clic sul simbolo per accedere alla Modalità modifica, o fare clic sull'elemento e premere Ctrl + E (Mac: Cmd +
E) , o fare clic destro sull'elemento e selezionare "Modifica elemento";

2. Premere i tasti freccia per un posizionamento fine (0,1 sp alla volta); o premere Ctrl+Freccia (Mac: Cmd+Arrow) per le
regolazioni più ampie (1 sp alla volta).

È anche possibile modificare la posizione orizzontale e verticale da Ispettore. Per posizionare più di un simbolo alla volta,
selezionarli tutti e regolarne le posizioni con l'Ispettore.

Nota: Il simbolo può anche essere riposizionato cliccando e trascinando, ma per un controllo più preciso, è nevessario
utilizzare i metodi di cui sopra.

Per posizionare un simbolo sull'altra parte della nota (dove applicabile), selezionarlo e premere X.

Collegamenti esterni

Articolazione  su Wikipedia
Abbellimento  su Wikipedia

Bending

Una varietà di bending, semplici e complessi (cioè a più stadi), possono essere creati sia nei pentagrammi ordinari che

nelle tablature con il Bend Tool , che si trova nella tavolozza "Articolazioni e Abbellimenti" nell'Nonexistant node nid:
39841 Avanzata.

Applicare il bending

Per applicare lo strumento, selezionare la nota da cui iniziare e utilizzare una delle seguenti opzioni:

Fare doppio clic sul simbolo nella tavolozza.
Trascinare il simbolo dalla tavolozza alla nota.

Per impostazione predefinita, lo strumento applica un up-bend di minima. Per modificare la curva clic destro sull'elemento
e selezionare "proprietà Bend". Sono disponibili cinque opzioni predefinite, se necessario, nel lato sinistro della finestra.

Ogni unità sull'asse verticale del grafico rappresenta un bending di 1/4 di tono: 2 unità un bending di mezzo tono, 4 unità i
toni interi e così via. L'asse orizzontale indica l'estensione del bending: ogni punto aggiunto estende il bending di 1 sp (sp
= spazio, la distanza tra due linee del pentagramma).

Un bending viene modificato o creato aggiungendo o eliminando i punti nel grafico. Per aggiungere un punto al grafico,
fare clic su un incrocio vuoto. Per eliminarlo, semplicemente cliccare su un punto esistente, o sulla stessa linea verticale
del punto. I punti Inizio e Fine del bending possono essere solo spostati su e giù.

Regolare l'altezza
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L'altezza del simbolo piega viene regolata automaticamente in modo che appaia appena sopra il pentagramma. Questa
altezza può essere ridotta, se necessario, con un espediente: creare una nota parallela alla nota in cui inizia il bending,
ma in una posizione più alta nel pentagramma (o tablatura); applicare il bending alla nota superiore, regolarne la
posizione e, infine, rendere la nota extra invisibile e silenzioso (utilizzando l'Ispettore)

Regolare la posizione

Per regolare la posizione:

Trascinare il simbolo con il mouse.
Clic sul simbolo e regolare le posizioni orizzontali e verticali con l'Ispettore.
Doppio clic sul simbolo; o clic e premere Ctrl + E (Mac: Cmd + E); o fare clic destro sul simbolo e selezionare
"Modifica elemento". Quindi utilizzare i tasti freccia per il posizionamento di precisione (0,1 sp alla volta); o
Ctrl+Freccia (Mac: Cmd+Freccia)
per le regolazioni maggiori (1 sp alla volta).

bending personalizzato

Dopo aver creato un bending nella partitura si può salvarlo, per un utilizzo futuro, trascinando il simbolo nella tavolozza
mentre si tiene premuto Ctrl+Maiusc (Mac: Cmd+Maiusc). Vedi Tavolozza personalizzata .

Collegamenti esterni

Bending  su Wikipedia

Battute d'aspetto

Pause di una battuta intera

Quando una intera battuta è priva di note si utilizza una pausa di semibreve (si utilizza questo simbolo anche se il tempo
non è 4/4).

Per creare una pausa che duri tutta la battuta selezionare la battuta interessata e premere Canc. Tutte le note e le pause di
questa battuta saranno sostituite da un'unica pausa.
Nota: Per pause di una battuta intera, in battute personalizzate, premere Ctrl+Shift+Canc.

Battute d'aspetto

Le pause di più battute, battute d'aspetto, indicano il prolungato silenzio di uno strumento e sono utilizzate di frequente
nelle partiture per la musica d'insieme. Vengono interrotte automaticamente in punti significativi, tipo doppie stanghette,
marcatori di riferimento, armatura di chiave o unità di tempo ecc.
Sulle battute d'aspetto, sopra il rigo, è presente il numero che indica per quante battute dura la pausa.

Istruzioni

1. dal menù selezionare Stile → Generale...

2. Selezionare col mouse la voce "Partitura"
3. Mettere la spunta su "Crea battute d'aspetto"

Limitazioni

Questa opzione di modifica dello stile creerà automaticamente le pause di più battute nella partitura. Si raccomanda
pertanto di inserire prima tutte le note e solo dopo selezionare questa opzione.

Interrompere battute d'aspetto

Vedi anche: Azioni sulle battute: Interrompere battute d'aspetto
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Potreste volere una pausa di più battute divisa in due

Questa opzione dovrebbe essere verificata prima di attivare l'opzione "Crea le pause di più battute" in Stile → Generale...,
nella scheda "Partitura".
Selezionare la prima battuta dove inserire la seconda battuta d'aspetto e, con un clic del tasto destro selezionare
Proprietà battuta... → Interrompi la battuta d'aspetto.

Da notare che le pause di più battute vengono interrotte se c'è un marcatore di riferimento (non un semplice testo di
pentagramma), Interruzione di sezione, modifiche di armatura di chiave, unità di tempo o doppie stanghette.

Chiavi

Le Chiavi sono inserite o modificate selezionando il simbolo dalla tavolozza Chiavi e trascinandolo su una battuta o su un
altro simbolo di chiave. Utilizzare il tasto F9 (Mac: ⌥+⌘+K) per mostrare o nascondere le tavolozze.

Nota: Per impostazione nella tavolozza Essenziale sono disponibili solo le chiavi di violino, contralto, tenore e basso. Per
le altre è possibile passare alla tavolozza Avanzata dall'elenco a discesa in fondo all'Area di lavoro. L'immagine seguente
mostra le chiavi presenti nell'area di lavoro Avanzata .

Aggiungere

Trascinare il simbolo dalla tavolozza a una zona vuota della battuta. La chiave viene inserita all'inizio della battuta.

Trascinare il simbolo su una determinata nota per aggiungere la chiave all'interno di una battuta. Se la battuta non è la
prima della partitura il simbolo della chiave appare più piccolo. Un esempio è uno spartito per pianoforte, in cui il
pentagramma superiore inizia con una chiave di Sol e passa immediatamente ad una chiave di Fa. Poi, dopo una nota e
una pausa, torna in chiave di Sol.

Nota: una chiave trascinata su una nota (e in particolare sulla prima nota), non sarà interessata dalla proprietà di "chiave
di cortesia".
Per vedere se la modifica verrà applicata alla nota o alla battuta, controllare l'elemento che cambia colore quando si
trascina.
È anche possibile selezionare la nota, o la misura in primo luogo, e fare doppio clic sulla chiave della tavolozza per
assicurarsi della corretta destinazione.

Eliminare

Selezionare la chiave e premere Canc.

Note:

se si cambia la chiave non si altera l'altezza assoluta delle note presenti nella partitura. Le note già inserite si
riposizioneranno automaticamente nel pentagramma.
Le chiavi Speciali o di utilizzo raro non sono presenti di default nella tavolozza. Sono invece disponibili nella
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suddetta Tavolozza generale.

Forcelle

Le Forcelle sono degli oggetti di tipo linea. Per inserire questi simboli per prima cosa selezionare l'intervallo di note cui
applicarle.

<: Inserisce il simbolo crescendo

>: Inserisce il simbolo diminuendo

È possibile inserire questi simboli con un doppio clic nella tavolozza Linee mentre la nota è selezionata.

Modificare le forcelle

Dopo aver inserito una forcella nella partitura è possibile regolarla, estenderla o spostarla. Per regolare la lunghezza:

1. Doppio clic sulla forcella per entrare in Modalità di modifica. Poi selezionare (con un clic) il punto finale da spostare:

2. Maiusc+→ o Maiusc+← sposta l'ancoraggio del punto finale selezionato, che determina quali note interesserà la
riproduzione e consente alla forcella di estendersi attraverso le interruzioni di riga:

3. → o ← e Ctrl+→ o Ctrl+← (Mac: Cmd+→ o Cmd+←) sposta il punto finale selezionato senza cambiare quello di
ancoraggio. Questo metodo è adatto solo per piccoli aggiustamenti dell'aspetto visivo della forcella. Per estendere
la forcella su più o meno note utilizzare Maiusc+→ o Maiusc+← per modificare l'ancoraggio (vedi sopra). Il
comando "Reset" Ctrl+R (Mac: Cmd+R) annullerà questi piccoli aggiustamenti, ma non modificherà l'ancoraggio.

Linee Cresc. e dim.

In aggiunta alle forcelle ci sono le linee cresc.   _     _     _ e dim.   _     _     _ con la stessa funzione nella tavolozza Lnee.
Per modificare il testo (es. cresc. poco a poco, o decresc. invece di dim), fare clic destro sulla linea e scegliere Proprietà

linea .....

Per trasformare una forcella nell'equivalente linea di testo :

1. Selezionare la forcella.
2. Da Ispettore, impostare lo "Stile della linea" su "Tratteggio ampio".
3. Nell'Ispettore, mettere la spunta sulla casella "Linea testo".

Riproduzione delle forcelle

La riproduzione di crescendo e diminuendo è efficace solo da una nota a quella successiva; attualmente non è possibile
cambiare la dinamica nel corso di una singola nota. Per impostazione predefinita le forcelle influenzeranno la riproduzione
solo se prima e dopo di esse sono indicate le dinamiche .
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Per esempio, un crescendo che comprende le note tra le dinamiche p ed f causerà un cambiamento dinamico durante la
riproduzione. Tuttavia, tra due dinamiche successive solo la prima forcella corretta avrà effetto: un diminuendo tra p ed f
sarà ignorato; di due o più crescendo tra p ed f, saranno ignorati tutti tranne il primo.

Una forcella può essere utilizzata senza segni dinamici, regolandone l' "Intensità" con l'Ispettore (valori dell'intervallo tra 0
a 127).

Graffe

Cancellare

Selezionare la graffa e premere Canc

Aggiungere

Trascinare il simbolo della graffa dalla tavolozza Graffe in una zona vuota della prima battuta di un'accollatura.

Cambiare

Trascinare un simbolo dalla tavolozza Graffe sulla graffa già presente nella partitura.

Modificare{#edit}

Fare doppio clic sulla graffa per entrare in Modalità di modifica. In Modalità di modifica è possibile modificare l'altezza di una
graffa per estenderla arbitrariamente ad altri pentagrammi.

Posizione orizzontale

Se è necessario spostare una graffa più a sinistra o destra, fare doppio clic sulla graffa per entrare in Modalità di modifica, e
premere Maius+← o Maius+→.

Gruppi di note

I Gruppi di note sono inseriti automaticamente, ma possono essere modificate manualmente trascinando il simbolo dalla
tavolozza Proprietà gruppo note fino alla nota per modificarne il comportamento.

È anche possibile selezionare prima una nota e poi fare doppio clic sul simbolo appropriato nella tavolozza.

 Prima nota del gruppo..

 Non far finire il gruppo con questa nota.

 Questa nota non appartiene a un gruppo

 Inizia il secondo livello del gruppo a partire da questa nota.

 Inizia il terzo livello del gruppo a partire da questa nota

 (ritorno) Modalità automatica: MuseScore sceglie l'impostazione in base all'unità di tempo corrente.
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 Inizia il fascio di code (più lento) a partire da questa nota.

 Inizia il fascio di code (più veloce) a partire da questa nota.

Per modificare l'angolatura delle code o la lunghezza degli steli fare doppio clic sulla coda, per entrare in Modalità di modifica,
con la maniglia all'estremità destra selezionata. Le frecce direzionali su/giù consentiranno la variazione dell'angolo.
Selezionando la maniglia di sinistra le frecce direzionali destra/sinistra varieranno la lunghezza del gambo. Premere Esc

per uscire dalla modalità modifica e rendere effettive le modifiche

Per spostare una trave da sopra a sotto le note, o viceversa, invertire la direzione dei gambi utilizzando il pulsante della
barra inserimanto note (prima dei pulsanti Voci) con il simbolo della nota con due steli opposti o utilizzare il tasto X.

Vedi anche

Gruppo di note tra pentagrammi
Modalità di modifica
Inserimento note
Come collegare le (code delle) note separate da una pausa
How to place a beam between notes

Gruppi irregolari

I gruppi irregolari sono utilizzati per scrivere una suddivisione ritmica che non rispetta quella prevista dall'unità di tempo
indicata nella partitura. Per esempio in una partitura in 4/4 in presenza di una terzina di crome l'esecutore suonerà tre note
nel tempo in cui ne dovrebbero essere suonate due (la nota da 1/4 viene divisa in tre invece che in due).

Istruzioni

Per creare una terzina per prima cosa selezionare nella partitura una nota che specifica la durata complessiva della
terzina. Per esempio, una terzina di crome ha una durata complessiva di 1/4 (semiminima).

Dal menù principale selezionare Note → Gruppi irregolari → Terzina. Verrà così creata una terzina dividendo la durata
complessiva in tre parti uguali,

Che successivamente potranno essere modificate.

Inserimento note

L'inserimento delle terzine in modalità inserimento note funziona in modo leggermente diverso da quello di descritto
sopra. È necessario prima selezionare la durata e poi inserire l'altezza delle note. Di seguito sono descritti i passaggi per
inserire una terzina di crome.

1. Selezionare la modalità inserimento note premendo il tasto N
2. Verificare che il cursore sia nel punto dove si desidera inserire la terzina (per spostare il cursore utilizzare

eventualmente le frecce direzionali)
3. Selezionare la durata dalla barra delle note per specificare la durata complessiva della terzina Nell'esempio fare clic

sulla croma (o premere 5 sulla tastiera)
4. Dal menù selezionare Note → Gruppi irregolari → Terzina, o premere Ctrl+3 (Mac: ⌘+3)
5. Notare che è stata selezionata automaticamente la durata 1/8. Un clic sul pentagramma per inserire l'altezza delle
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note (o utilizzare la tastiera, del computer o Midi)

Proprietà

Per modificare le proprietà di visualizzazione di un gruppo irregolare selezionarne il numero o la graffa e utilizzare
l'Ispettore (F8).

Se né il numero né la graffa vengono visualizzati selezionare una nota del gruppo e poi utilizzare il pulsante Gruppo
irregolare in Ispettore per visualizzare la finestra di dialogo qui sopra.

In Direzione scegliere Auto per posizionare la graffa nella stessa direzione degli steli o delle code. Scgliere Su, o Giù per
collocare in modo esplicito la staffa sopra o sotto le teste delle note, indipendentemente dalla direzione degli steli o delle
code.

In Tipo di numeroselezionare Numero per motrare un intero, Rapporto per un rapporto di due numeri interi or Niente per non
visualizzarlo.

In Tipo di parentesi selezionare Automatico per nascondere la graffa delle note collegate e visualizzarle se il gruppo include
note o pause non collegate. Scegliere Graffa, o Niente per visualizzare o nascondere, esplicitamente la graffa.

Spostando la graffa, o il numero, sarà visibile l'aggiornamento dei posizionamenti orizzontali o verticali (impostati entrambi
di default su 0 spazio).

È possibile ripristinare le impostazioni predefinite con il pulsante freccia sulla destra.
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Stile

Da Stile → Generale... selezionando Gruppi irregolari è possibile modificare tutte le proprietà dei gruppi irregolari.

Sono possibili due regolazioni: verticale e orizzontale

Le regolazioni verticali hanno tre opzioni con i valori in unità di spazio e una opzione selezionabile
Pendenza massima: il valore predefinito è 0,50; l'intervallo è da 0.10 a 1.00
Distanza verticale dal gambo (vedi (2) sotto): il valore predefinito è di 0,25; l'intervallo va da -5,00 a 5,00
Distanza verticale dalla testa delle note (vedi (3) sotto): il valore di default è 0,50; l'intervallo va da -5,00 a 5,00
Evita i pentagrammi: selezionato di default

Le regolazioni orizzontali hanno quattro opzioni con i valori in unità di spazio
Distanza prima del gambo della prima nota (vedi (5) sotto): il valore di default è 0,50; l'intervallo va da -5,00 a
5,00
Distanza prima della testa della prima nota: il valore di default è 0,00; l'intervallo va da -5,00 a 5,00
Distanza dopo lo stelo dell'ultima nota (vedi (6) sotto): il valore di default è 0,50; l'intervallo va da -5,00 a 5,00
Distanza dopo la testa dell'ultima nota: il valore di default è 0,00; l'intervallo va da -5,00 a 5,00
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Vedi anche

Come creare terzine e altri gruppi irregolari

Collegamenti esterni

Gruppi irregolari  su Wikipedia
Come creare gruppi irregolari in MuseScore  [video in inglese]
The User Guide to Tuplets in MuseScore  [video in inglese]

Indicazione metrica

L'Indicazione metrica è disponibile nel pannello tavolozze . È possibile selezionare e trascinare questi simboli nella
partitura (vedi Tavolozza per le informazioni generali su come utilizzare le tavolozze di MuseScore).

Creare un'Indicazione metrica personalizzata

Se l'Indicazione metrica necessaria non è disponibile nella relativa tavolozza accedere alla Tavolozza Generale...
direttamente tramite la scorciatoia MaiuscT) per crearne una personalizzata. È possibile modificare il numeratore e il
denominatore nella sezione Crea Indicazione metrica  e poi usare il pulsante Aggiungi. Una volta aggiunta è sufficiente trascinare
e rilasciare l'Indicazione metrica, direttamente dal pannello di sinistra, sulla partitura. Tenere presente che non apparirà
nella tavolozza di lavoro. Se si desidera aggiungerla alla relativa tavolozza, leggere Tavolozza personalizzata .

Modificare i Gruppi di note preimpostati

Per modificare le 'code' inserite automaticamente, è possibile fare clic sulle note che si desidera modificare.

Per esempio, di default 5/8 è collegato come 3+2. È possibile fare clic sulla terza e quarta nota per ottenere 2 + 3. Non
dimenticate di fare altrettanto per le altre due suddivisioni. Per modificare la terza trascinare il simbolo dal pannello

Gruppi della nota  alla corrispondente suddivisione. In questo esempio il simbolo della "Prima nota del
gruppo" verrà trascinato fino alla nona nota e il terzo simbolo alla tredicesima.

Cancellare un'Indicazione metrica
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Le Indicazioni metriche non più necessarie possono essere rimosse dalla finestra di dialogo qui sotto con un clic del tasto
destro e l'opzione "Pulisci".

Modifica di ritmi asimmetrici

Nella maggior parte dei casi vi servirà cambiare solo il numeratore. Gli altri numeri disponibili per il numeratore sono per
l'unità di ritmi asimmetrici , che contengo più valori del numeratore separati da un segno +.

Durata differente dall'Indicazione metrica: battute in levare (Anacrusi) e Cadenza

Ci sono situazioni in cui la durata di una battuta è diversa da quella indicata dall'Indicazione metrica. Battute in levare
all'inizio del brano e cadenza sono un esempio tipico. Per cambiare la durata reale di una battuta senza mostrare una
diversa Indicazione metrica vedi Operazioni sulle battute: Proprietà, Durata della battuta.

Indicazione metrica locale

L'Indicazione metrica può essere differente per differenti pentagrammi. L'esempio seguente è tratto da Bach: Variazioni
Goldberg 26:
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MuseScore supporta il concetto di un'Indicazione metrica globale e di una attuale (locale). Per modificare l'Indicazione
metrica globale trascinare il corrispondente simbolo dalla relativa tavolozza. L'Indicazione metrica globale è utilizzata per
contare i battiti (come indicato nella barra di stato) ed è il riferimento per i marcatori di tempo. L'Indicazione metrica
globale è la stessa per tutti i pentagrammi e, normalmente, identica a quella 'corrente'

L'indicazione del tempo corrente si trova nella finestra di dialogo Proprietà Indicazione metrica e può differire per ciascun
sistema (18/16 nell'esempio).

NOT FOUND: Time_Signature_Properties_en.png

Il testo dell'Indicazione metrica può essere impostato indipendente dai valori correnti.

L'Indicazione metrica locale si imposta tenendo premuto Ctrl e trascinandola, ha valore solo per un pentagramma.
L'Indicazione metrica globale viene replicata per tutti i pentagrammi

Modificare l'Indicazione metrica e altri elementi

Le pause di più battute vengono interrotte in presenza di un cambio di Indicazione metrica.
Inoltre un'interruzione di sezione impedirà che venga mostrata, alla fine della battuta precedente, un'Indicazione metrica di
cortesia.

Vedi anche

Pause di battuta
Interruzioni e spaziatori

Intavolatura

La musica per i cordofoni come la chitarra, è comunemente notata utilizzando l'intavolatura (abbreviate in tab) che
fornisce una rappresentazione visiva delle corde e dei numeri dei tasti

L'intavolatura può essere anche combinata con la tradizionale notazione del pentagramma

Modificare le proprietà intavolatura

Quando un pentagramma intavolatura viene creato dalla procedura guidata Creare un nuovo spartito viene impostata
l'accordatura più comune dello strumento in questione, nel caso di una chitarra, per esempio, assume l'accordatura
standard Mi2, La2, Re3, Sol3, Si3, Mi4. Per modificare l'intonazione, o qualsiasi altra proprietà dell'intavolatura fare clic
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con il tasto destro del mouse sul pentagramma (nella partitura) e selezionare Proprietà pentagramma... Vedi → sotto per
i dettagli.

Da Proprietà pentagramma è possibile accedere a Stile proprietà avanzate..., da cui possono essere impostate
regolazioni dettagliate.

Creare un nuovo pentagramma intavolatura

Per creare un'intavolatura come parte di una partitura utilizzare la la procedura guidata 'Creare un nuovo spartito'. Per
aggiungere un'intavolatura ad una partitura esistente utilizzare la finestra di dialogo Strumenti. O, in alternativa, è possibile
cambiare tipo di pentagramma. Vedi sotto per i dettagli.

Con la procedura guidata 'Finestra di avvio'

Per creare un'intavolatura in una nuova partitura (per un sistema pentagramma/intavolatura vedere → sotto):

1. Selezionare File → Nuovo o usare la scorciatoia Ctrl + N (Mac: Cmd+N) per aprire procedura guidata.
2. Inserire i dettagli della partitura (opzionale).Clic sul pulsante Avanti.
3. Nella finestra Seleziona file modello, clic su Scegli strumenti.

4. Nella finestra Strumenti selezionare una (o più) opzioni intavolatura sotto "Cordofoni" nella colonna di sinistra (vedi
immagine sotto). Poi clic su Aggiungi.

Nota: È possibile utilizzare l'elenco a discesa sopra l'elenco strumenti per cambiare la categoria visualizzata. In alternativa
è possibile cercare lo strumento utilizzando il campo "Cerca" sotto l'elenco strumenti.

5. Completare la procedura guidata Creare un nuovo spartito.

Se l'intavolatura desiderata non è disponibile nell'elenco Scegli strumenti:

1. Selezionare un pentagramma intavolatura in "Cordofoni" (passo 4 vedi sopra).
2. Premere Aggiungi per spostarlo nella colonna a destra.
3. Controllare il menu a discesa a destra dello strumento appena aggiunto per l'opzione Tab più adatta, se presente.
4. Completare la procedura guidata Creare un nuovo spartito e uscire.
5. Modificare il numero di corde e l'accordatura dell'intavolatura, se necessario, nella finestra di dialogo Proprietà

pentagramma (vedi → [sotto](#Modifica dei dati delle corde dello strumento (accordatura)).
6. Modificare il nome dello strumento in Proprietà pentagramma, se necessario.

Questo consente di creare intavolature per qualsiasi strumento cromatico-a tasti.

Con la finestra di dialogo Strumenti

Per aggiungere un singolo pentagramma intavolatura ad una partitura esistente (per la coppia pentagramma/intavolatura)
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vedi → sotto):

1. Aprire l'editor strumenti (menu Modifica → Strumenti... o tasto I).
2. Aggiungere la tab pentagramma come descritto in Strumenti.

Cambiare tipo di pentagramma

È anche possibile convertire qualsiasi pentagramma di tipo standard nel tipo tablature e viceversa:

1. Fare clic destro in un punto vuoto del pentagramma e selezionare Proprietà pentagramma.... Se "Strumenti" è già impostato

come cordofono uscire da Proprietà pentagramma e passare al punto 4

2. Se "Strumenti" non è un cordofono fare clic su Cambia strumento e selezionare lo strumento appropriato da "Cordofoni"
3. Doppio clic sul pulsante OK per uscire da Proprietà pentagramma.
4. Aprire l'editor Strumenti dalla pagina della partitura (menù Modifica → Strumenti... o tasto I).
5. Fare clic sul pentagramma nella colonna di destra e cambiare il "tipo pentagramma" per l'opzione desiderata.
6. Clic su OK per chiudere la finestra di dialogo Strumenti e tornare alla pagina della partitura

Nota: Se in seguito sarà necessario apportare ulteriori modifiche al pentagramma (ad es. accordatura, numero di
linee/corde ecc.), fare clic destro sul pentagramma e selezionareProprietà pentagramma....

Versione alternativa (utilizzando solo la finestra di dialogo "Proprietà pentagramma"):

1.Fare clic destro sul pentagramma e selezionare Proprietà pentagramma....
2. Se lo strumento mostrato è nella categoria "Cordofoni", passare al punto 4.
3. Se lo strumento mostrato non è nella categoria "Cordofoni", clic su Cambia strumento e selezionare lo strumento
appropriato da "Cordofoni". Clic su OK.
4. Clic su Stile proprietà avanzate..., cambiare il "Modello" nel tipo desiderato e premere < Ripristino a modello.
5. Clic su OK per chiudere la finestra di dialogo Proprietà pentagramma.

Nota: Altre modifiche del pentagramma (es. accordatura, numero di linee/corde ecc.), possono essere effettuate dalla
finestra Proprietà pentagramma.

Modifica dei dati delle corde dello strumento (accordatura)

In MuseScore, i pentagrammi dei cordofoni (convenzionali e intavolature) sono impostati di default per le accordature più
comunemente usate. È possibile visualizzare l'accordatura facendo clic destro su un pentagramma della partitura,
selezionando Proprietà pentagramma..., e premendo Modifica dati corda.

Modificare l'accordatura di una corda di un pentagramma:

1. Clic destro in un punto vuoto di una battuta o di un pentagramma di cui modificare l'accordatura.

2. Selezionare Proprietà pentagramma....

3. Premere il pulsante Modifica dati corda... in fondo alla finestra di dialogo (mostrato solo quando lo strumento è definito
come "cordofono"). Si apre la finestra Dati corda:
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Qui ci sono diverse opzioni:

Riaccordare una corda esistente. Clic sull'altezza della nota e selezionare Modifica corda..., o doppio clic sulla
corda. Poi selezionare la nuova intonazione nella finestra Seleziona nota: e fare clic su OK (o doppio clic sulla
nuova intonazione).

Note: Se l'intonazione viene modificata quando l'intavolatura dello strumento contiene già delle note i capotasti
verranno modificati per produrre la stessa nota con la nuova accordatura (se possibile).

Qualsiasi modifica apportata all'intonazione della corda avrà effetto solo quel particolare strumento per quella
particolare partitura, e non modificherà nessun impostazione predefinita o la definizione incorporata.

Aggiungere una nuova corda. Clic sull'altezza della nota e selezionare Nuova corda.... Selezionare la nuova
altezza e premere OK (o doppio clic sulla nuova intonazione). La nuova corda viene inserita sotto quella
selezionata.

Eliminare una corda. Clic sull'altezza della nota e selezionare Cancella corda.

Nota: Dopo aggiunta o l'eliminazione di una corda nell'intavolatura è necessario adeguare il numero dei righe nella
finestra di dialogo Stile, proprietà avanzate.

Impostare una corda su "Aperta". Selezionare una o più caselle nella colonna "Aperta". Questa funzione
viene utilizzata per designare le corde senza capotasti - come nel liuto.

Cambiare il numero di capotasti dello strumento. Selezionare o inserire un nuovo numero nella
casella"Numero di tasti". Questo imposta il numero massimo dei tasti che può essere inserito per una corda.

4. Clic su OK per chiudere la finestra "Dati corda"

5. Clic su OK per chiudere la finestra "Modifica proprietà pentagramma/parte".

Combinare pentagramma convenzionale con intavolatura{#multiple-staves}

Gli strumenti cordofoni, come la chitarra, sono comunemente notati utilizzando insieme: quello convenzionale e
l'intavolatura (TAB). Quello convenzionale mostra la notazione musicale mentre l'intavolatura associata mostra le corde
ed il numero di capotasti corrispondenti alle note. I pentagrammi abbinati possono essere collegati o scollegati:

1. Pentagrammi collegati: I pentagrammi associati sono detti collegati se la modifica dell'uno si applica
immediatamente all'altro (traslazione reciproca).

2. Pentagrammi scollegati: Sono detti scollegati se possono essere modificati indipendentemente l'uno dall'altro. Per
trasferire la notazione dall'uno all'altro selezionare l'intervallo desiderato e usare copia e incolla per trasferirlo
nell'altro pentagramma.

Note: Di tanto in tanto, si possono trovare i numeri segnati in rosso nell'intavolatura. Questo significa che il capotasto
non può essere visualizzato perché collide con un altro esistente. È possibile risolvere spostando e regolando i numeri dei
capotasti (vedi Modifica note inserite). Comunque una collisione sulla linea più bassa non richiederà regolazioni, questo è
"come programmato" e la marcatura rossa non apparirà sulla copia stampata.

Creare pentagramma/intavolatura con Creare un nuovo spartito

Se volete creare ex novo un sistema pentagramma/intavolatura (collegato o scollegato)
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1. Selezionare File → Nuovo o utilizzare la scorciatoia Ctrl + N (Mac: Cmd+N) per aprire New Score wizard.
2. Inserire i dettagli della partitura (opzionale). Clic su Nuovo.
3. Nella finestra Seleziona file modello, clic su Scegli strumento.
4. Nella finestra Strumenti selezionare un pentagramma nella sezione "Cordofoni" a sinistra. Poi clic sul pulsante

Aggiungi.

5. Selezionare il pentagramma appena creato nella colonna di destra e scegliere tra le opzioni:

Clic su Aggiungi pentagramma collegato per creare una coppia collegata di pentagramma/intavolatura
Clic su Aggiungi pentagramma per creare una coppia scollegata di pentagramma/intavolatura

6. Modificare il Tipo di pentagramma in fondo a destra se necessario ( più dettagliate opzioni di visualizzazione sono
disponibili facendo clic con il tasto destro sull'intavolatura e selezionando Proprietà pentagramma… → Stile, proprietà

avanzate).

7. Completare la procedura guidata nuovo spartito o fare clic su Fine

Nota: Per creare i pentagrammi non collegati con canali del mixer separati, invece di "punto 5" (sopra), selezionare un
pentagramma Intavolatura nella colonna di sinistra e fare clic su Aggiungi. Proseguire con i punti 6 e 7.

Creare pentagramma/intavolatura da un pentagramma esistente

Per aggiungere un'intavolatura ad un pentagramma per cordofono nella partitura (o viceversa):

1. Aprire l'editor Strumenti (menu Modifica → Strumenti... o tasto I)
2. Selezionare, nella colonna di destra, il pentagramma sotto il quale aggiungere il nuovo.
3. Scegliere tra le opzioni:

Clic su Aggiungi pentagramma collegato/kbd>per creare una coppia pentagramma/intavolatura collegato

Clic su Aggiungi pentagramma per creare una coppia pentagramma/intavolatura scollegato
4. Modificare se necessario Tipo pentagramma nelle opzioni all'estrema destra, (opzioni di visualizzazione più

dettagliate sono disponibili facendo clic destro sul pentagramma intavolatura e selezionandoProprietà pentagramma… →

Stile, proprietà avanzate...).
5. Utilizzare il pulsante Su per cambiare la posizione del pentagramma, se necessario.
6. Clic su OK.

Note: Per creare i pentagrammi non collegati con canali del mixer separati, invece del "punto 3" (sopra), selezionare un
pentagramma adeguato nella colonna di sinistra e fare clic su Aggiungi. Poi procedere con i punti 4–6.

Modificare una coppia pentagramma/intavolatura collegato in scollegato (o viceversa)

(a) Per modificare una coppia pentagramma/intavolatura nella partitura da collegati a scollegati:

1. Aprire l'editor Strumenti dalla pagina della partitura (menu Modifica → Strumenti... o premere il tasto I )
2. Clic sul pentagramma della colonna destra, poi clic su Aggiungi pentagramma.
3. Modificare Tipo pentagramma (all'estremità destra) della sezione del pentagramma appena creato per l'opzione

corretta. Se la precedente coppia di pentagramma/intavolatura era vuota, passare al punto 5. Se non c'è esistente
notazione nella partitura, continuare con il punto 4.

4. Clic su OK per tornare alla partitura. Copiare e incollare qualsiasi notazione dal pentagramma collegato a quello
dell'intavolatura non collegata. Tornare all'editor strumenti.

5. Clic sull'intavolatura collegata nella sezione destra, poi clic su Togli poi OK.

(b) Per modificare una coppia pentagramma/intavolatura nella partitura da scollegati a collegati:

1. Aprire l'editor Strumenti dalla pagina della partitura (menu Strumenti → Strumenti... o premere il tasto I)
2. Clic sul pentagramma della colonna destra, poi clic su Aggiungi pentagramma collegato.
3. Modificare Tipo pentagramma (all'estremità destra) della sezione del pentagramma appena creato per l'opzione

corretta
4. Selezionare l'intavolatura non collegata e fare clic su Togli, poi OK.

Inserire nuove note

Tastiera

In primo luogo, assicurarsi di non essere in modalità inserimento note. Selezionare la battuta o nota esistente da cui
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si desidera iniziare la notazione.
Passare in modalità inserimento note (N): un piccolo 'rettangolo blu' appare intorno a una corda dell'intavolatura:
questa è la corda corrente
Selezionare la durata della nota o pausa da inserire (vedi sotto).
Premere i tasti freccia su/giù per spostare il cursore fino alla corda scelta . Utilizzare i tasti freccia destra/sinistra per
spostarsi attraverso la partitura.
Premere da 0 a 9 per inserire un marcatore di tasto da 0 a 9 sulla corda corrente; per immettere i numeri con diverse
cifre premere ogni cifra in sequenza. Anche i tasti da A a L (saltando I) possono essere usati, utile quando si lavora
su una intavolatura Francese.
Note: Non si possono inserire cifre eccedenti il numero di capotasti.
È possibile anche correggere il numero tasto con Maiusc+↑ o Maiusc+↓

Premere ; (punto e virgola) per inserire una pausa della durata selezionata
È possibile inserire le note in differenti voci se necessario—come fareste in un pentagramma convenzionale

Mouse

Passare in modalità inserimento note e selezionare la durata della nota (vedi sotto)
Fare clic su una corda per inserire la nota. Le note sono inizialmente create sul tasto 0 (o La per intavolature
francesi): per correggerle, digitare il numero direttamente dalla tastiera.
È possibile correggere il numero del capotasto con Alt+Maiusc+↑ o Alt+Maiusc+↓.
È possibile inserire le note in differenti voci se necessario—come fareste in un pentagramma convenzionale.

Selezionare il valore della nota da inserire

In modalità inserimento note è possibile utilizzare uno dei seguenti metodi per impostare durata della nota
nell'intavolatura:

da Maiusc+1 a Maiusc+9 (la disponibilità di queste scorciatoie può dipendere dalle impostazioni della piattaforma e/o
della tastiera)
Tastierino numerico da 1 a 9 (se c'è il tastierino numerico BlocNum è attivo)
la barra inserimento note nella parte superiore dello schermo
Q per diminuire il valore selezionato W per aumentarlo

Modifica note inserite

Se non si è in modalità inserimento note si possono utilizzare tre scorciatoie per modificare un marcatore di tasto:

Maiusc+↑ / ↓ cambia l'altezza delle note. MuseScore seleziona la corda e il tasto: è selezionata sempre la massima
corda possibile.
↑ / ↓ cambia il tasto su/giù senza modificare la corda (compreso tra 0 e il numero di tasti definiti nella finestra di
dialogo Modifica dati corda).
Ctrl+↑ / ↓ sposta la nota selezionata alla corda superiore/inferiore (se la corda è libera e può suonare quella nota).
Maiusc+X attiva/disattiva la funzione nota fantasma

Sintesi dei tasti

Modalità inserimento note

Digitare: per ottenere:

↑ Seleziona la corda superiore come attuale.

↓ Seleziona la corda inferiore come attuale.

Maiusc+1 a Maiusc+9 Seleziona una durata

Tastierino da 1 a Tastierino 9 Seleziona una durata

Q Diminuisce la durata della nota che si inserisce.

W Aumenta la durata della nota che si inserisce.

da 0 a 9 Inserisce un marcatore numero/lettera.

da A a K
Inserisce un marcatore numero/lettera. (I
escluso).

Maiusc+↑ Aumenta il marcatore corrente.

Maiusc+↓ Diminuisce il marcatore corrente.
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Modalità normale

Digitare: per ottenere:

Maiusc+↑ Aumenta l'altezza della nota selezionata (MuseScore sceglie la corda).

↑ Aumenta l'altezza senza modificare la corda.

Maiusc+↓
Diminuisce l'altezza della nota selezionata (MuseScore sceglie la
corda).

↓ Diminuisce l'altezza senza modificare la corda.

Ctrl+↑ Sposta la nota alla corda superiore mantenendo l'altezza.

Ctrl+↓ Sposta la nota alla corda inferiore mantenendo l'altezza.

Maiusc+X Attiva/Disattiva le note fantasma

Collegamenti esterni

Video tutorial: MuseScore in Minutes: Lesson 7 - Tablature e Notazione percussioni

Legatura di portamento

La legatura di portamento è una linea curva tra due o più note di differente altezza. Indica che queste note devono
essere suonate senza interruzioni. Per unire due note della stessa altezza vedere Legatura di valore

Primo metodo

1. Uscire dalla Modalità inserimento note e selezionare la prima nota:

2. S crea la legatura di portamento:

3. Maiusc+Destra sposta la fine della legatura di portamento alla nota successiva:

4. X rovescia la legatura:

5. Esc fa uscire dalla Modalità di modifica legatura:

Secondo Metodo

1. Lasciare la Modalità inserimento note e selezionare la prima nota.
2. Tenere premutoCtrl (⌘su Mac) o Maiusc e selezionare l'ultima nota.
3. Premere S

Terzo Metodo
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1. In Modalità inserimento note inserire la prima nota
2. Premere S per iniziare la legatura
3. Inserire le successive note da collegare
4. Premere S per finire la legatura

Modifiche

I quadratini o “maniglie” (mostrati nelle immagini dei passaggi 2-4 qui sopra) possono essere trascinati con il mouse.
Quelli esterni modificano l'inizio e la fine della legatura, quelli centrali modificano la curvatura.

Una legatura di portamento si può estendere su diverse accollature e pagine. L'inizio e la fine della legatura sono ancorati
a note, accordi o pause. Se questi elementi vengono riposizionati per cambiamenti dell'impaginazione, delle dimensioni
delle battute oppure dello stile, anche la legatura di portamento verrà riposizionata e ridimensionata.

Questo esempio mostra una legatura che si estende dalla chiave di basso a quella di violino. Usando il mouse,
selezionare la prima nota, tenendo premuto Ctrl (o ⌘ su Mac) selezionare l'ultima nota da collegare e premereS per
inserire la legatura.

Linea punteggiata

Le legature di portamento con la linea punteggiata sono talvolta utilizzate nelle canzoni dove la presenza di una legatura
varia da una strofa all'altra. Sono inoltre utilizzate per indicare un suggerimento dell'editore (differente dalle indicazioni
originali dell'autore). Per modificare una legatura esistente, in una punteggiata o tratteggiata, selezionarla e poi da
Ispettore (F8) scegliere in Tipo di Linee : Punteggiata o Tratteggiata.

X rovescia la legatura selezionata.

Vedi anche

Legatura di valore
Modalità di modifica
Inserimento note

Legatura di valore

La legatura di valore è una linea curva che unisce due note della stessa altezza. Per la legatura che collega note di
altezze differenti vedere Legatura di portamento.

Primo metodo

Selezionare la prima nota:

Il tasto + crea una legatura di valore

(o il pulsante , situato in alto a destra nella barra inserimento note)
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Secondo metodo

Per creare una legatura di valore durante l'Inserimento note, premere + dopo la prima nota della legatura di valore.

Legatura accordi

Per aggiungere una legatura di valore tra due accordi selezionare il gambo del primo, o Maiusc + clic sul primo accordo e
premere +. La modalità Inserimento note non deve essere attivata.

X rovescia la direzione della legatura.

Linee

La tavolozza Linee, dell'Area di lavoro Avanzata, include i seguenti tipi di linee:
* legatura di portamento
* Forcelle (crescendo e diminuendo)
* Volta (1^, 2^, 3^ Volta ecc.)
* Linea di Ottava (8va, 8vb, 15ma ecc)
* Pedale
* Linee di abbellimento estese
* Linea barré chitarra
* Retta
* Ambitus (simbolo early music)

Inserire le linee nella partitura

Le linee possono essere inserite nei seguenti modi:

Selezionare una nota e quindi fare doppio clic su una delle linee nella tavolozza.

Selezionare un intervallo di note facendo clic sulla prima nota e, utilizzandoMaiusc, fare clic per selezionare l'ultima
nota. Fare quindi doppio clic su una linea nella tavolozza. Questo genera una linea più corta della selezione
precedente.

Trascinare e rilasciare una linea dalla tavolozza sulla partitura.

Legature di portamento possono essere inserite anche utilizzando il tasto S.

Cambiare la lunghezza

1. Se siete in modalità modalità inserimento note premere Esc
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2. Doppio clic sulla linea da modificare per entrare in modalità modifica

3. Spostare le maniglie utilizzando i seguenti tasti di scelta rapida:

Maiusc+→ per spostare l'ancoraggio a destra di una nota (o battuta)
Maiusc+← per spostare l'ancoraggio a sinistra di una nota (o battuta)

4. Se è necessario modificare la lunghezza visivamente senza modificare le note o le battute cui la linea è
ancorata, trascinare le maniglie con il mouse o utilizzare le seguenti scorciatoie:

→ per spostare la maniglia a destra di 0.1 sp (1 sp = spazio pentagramma = la distanza tra due righi del
pentagramma).
← per spostare la maniglia a sinistra di 0.1 sp.
Ctrl+→ (Mac: Cmd+→) per spostare la maniglia a destra di uno sp.
Ctrl+← (Mac: Cmd+→) per spostare la maniglia a sinistra di uno sp.

Linee personalizzate e proprietà della linea

Le linee come ottava e volta sfruttano caratteristiche come il testo incorporato o ganci alle estremità della linea. È inoltre
possibile personalizzare le linee a piacere dopo averle inserite in partitura, e anche aggiungerne di nuove alla tavolozza
per un utilizzo futuro.

1. Clic destro su una linea e scegliere Proprietà Linea...

2. È possibile specificare il testo da visualizzare all'inizio, alla continuazione (il testo sarà mostrato all'inizio
dell'accollatura seguente), e/o alla fine della linea. Clic sul pulsante ... per controllare la formattazione ed il
posizionamento di ogni tipo di testo all'interno della linea.

3. L'impostazione del Gancio consente di creare angoli perpendicolari o di 45º alle estremità della linea.

4. Uscendo dalla finestra di dialogo Proprietà linea, è possibile impostare lo spessore della linea con l' Ispettore, con il
quale è possibile scegliere lo Stile della Linea (es.: continua, tratteggiata, punteggiata).

5. Per salvare il risultato nelle tavolozze, vedere Tavolozza personalizzata .

Vedi anche Proprietà Linea.

Collegamenti esterni

Pedale  su Wikipedia.
Chitarra/Il barrè  su Wikibooks.

Notazione Percussioni

Esempio notazione percussioni:

La notazione per percussioni comprende quasi sempre delle note simultanee che hanno i gambi in direzione opposta. Se
non avete esperienza nell'inserimento di più voci in un singolo pentagramma consultate l'argomento Voci per una
panoramica. Vedere sotto per le istruzioni specifiche per la notazione delle percussioni.

Tastiera MIDI

La maniera più facile per inserire la notazione delle percussioni alla vostra partitura è quella di utilizzare una tastiera MIDI.
Alcune tastiere MIDI hanno i simboli delle percussioni su ciascuna nota. Se si preme il tasto relativo allo hi-hat (detto
anche charleston) il programma MuseScore inserirà nella partitura la notazione corretta. MuseScore inserisce
automaticamente la testa della nota corrispondente e il gambo nella giusta direzione.

Tastiera del computer

sette suoni di batteria sono associati di default ad una scorciatoia (AG) ed è possibile rimappare solo quelle sette
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scorciatoie per altre percussioni (o modificare altre proprietà del contenuto della tavolozza percussioni) tramite il pulsante
Modifica Set Percussioni del pannello inserimento percussioni (vedi →sotto).

Se si desidera inserire una nuova nota nella stessa posizione di una nota esistente - per esempio per indicare che
rullante e charleston suonano contemporaneamente - e si stava inserendo la nuova nota tramite la tastiera del computer è
necessario tenere premuto Maiusc mentre si inserisce la nuova nota in modo da non sovrascrivere quella esistente. Questo
è lo stesso metodo utilizzato quando si inseriscono in MuseScore gli accordi per gli strumenti accordati.

Mouse

Il sistema per inserire le note per le percussioni a suono indeterminato è differente da quello per gli altri strumenti, quindi
si devono seguire questi passaggi specifici:

1. Selezionare una nota o pausa nel pentagramma percussioni.
2. Premere N per attivare la modalità Inserimento note

Notate che il pannello inserimento percussioni appare solo quando avete completato questi passaggi:

3. selezionare la durata della nota dalla barra inserimento note
4. selezionare il tipo di nota (come grancassa, rullante o) dal pannello inserimento percussioni
5. fare clic sul pentagramma percussioni per aggiungere la nota alla partitura

Batteria{#edit-drumset}

Facendo clic su Modifica set percussioni sulla sinistra della tavolozza inserimento Percussioni si apre la finestra Modifica
set percussioni. In alternativa, fare clic con il pulsante destro del mouse su un pentagramma percussioni e selezionare
"Modifica set percussioni". Il lato sinistro della finestra contiene un elenco di numeri/nomi di nota MIDI, degli strumenti
associati alle percussioni e le scorciatoie da tastiera.

Un clic su una riga nella colonna di sinistra consente di modificare le proprietà di visualizzazione di tale nota come segue:

Nome: il nome che si desidera visualizzare nella tavolozza di inseriento percussioni quando il mouse inserisce la nota.
Testa della nota: Seleziona una testa della nota per quello strumento da un elenco a discesa di opzioni.
Linea pentagramma: Questo numero indica la linea/spazio del pentagramma spazio su cui verrà visualizzata la nota. "0"
significa che la nota viene visualizzata nella riga superiore del pentagramma a 5 righe. I numeri negativi spostano la nota
verso l'alto passo dopo passo, mentre i numeri positivi lo spostano verso il basso nello stesso modo.
Direzione stelo: Automatico, su o giù.
Voce di default: Assegnare a una delle quattro voci. Ciò non influisce sull'input di una tastiera MIDI o della tastiera
virtuale del pianoforte.
Scorciatoia: Assegnare una scorciatoia da tastiera per inserire quella nota.

Nota: In MuseScore 2.1, alcuni dei suoni dello strumento Tenor Drums non vengono riprodott; C'è un file DRM progettato
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per risolvere questo problema, che è possibile scaricare [qui]
(https://musescore.org/sites/musescore.org/files/MarchingTenorsKeyMap.drm ).

Rullo

Per creare un rullo di tamburi utilizzare Tremolo.

Collegamenti esterni

Tutorial video: MuseScore in Minutes: Lesson 7 - Tablature e Notazione percussioni
Drum Parts  [video]
Modifica della tavolozza Percussioni in MuseScore 1.1  [video]
Salvare le impostazioni Batteria in MuseScore 1.1  [video]
Guida alla notazione di Batteria e Percussioni

Note di abbellimento (acciaccature)

Le note di abbellimento corte (Acciaccatura) sono disegnate come piccole note con una linea obliqua che attraversa il
gambo. Le note di abbellimento lunghe (Appoggiatura) non hanno questa linea. Le note di abbellimento si posizionano
prima di una nota normale.

Istruzioni

Si inserisce una nota di abbellimento trascinando il simbolo desiderato dalla tavolozza Note di abbellimento ad una nota
regolare nella partitura. È anche possibile creare una nota di abbellimento selezionando la testa di una nota e facendo
doppio clic sul simbolo desiderato dalla tavolozza.

Per aggiungere più di una nota di abbellimento, trascinare successive note di abbellimento sulla testa della nota
selezionata.

Per aggiungere un accordo di note di abbellimento, inserire la prima e selezionarla, quindi usare Maiusc + la lettera
corrispondente al nome della nota (C, D, E, ecc...)

Se si desidera modificare la durata di una nota di abbellimento precedentemente creata, selezionarla e scegliere una
durata dalla barra degli strumenti oppure usare le scorciatoie da tastiera 1 ... 9 (vedi Inserimento note).

Le note di abbellimento dopo una nota (ad esempio un trillo finale) deve essere posizionata manualmente con Ctrl + frecce
direzionali.

Collegamenti esterni

Abbellimento  in Wikipedia

Octave lines

Octave (Ottava) lines are used to indicate that a section of music is to be played one or more octaves above or below
written pitch: The line may be dotted or solid. Ottavas are available in the Lines palette of the Basic and Advanced
workspaces.

8─────┐or 8va─────┐: Play one octave above written pitch
8─────┘or 8vb─────┘: Play one octave below written pitch

8va/8vb lines are particularly common in piano scores, though they are sometimes used in other instrumental music.1

15ma (2 octaves above) and 15mb (2 octaves below) are also occasionally used.
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Apply an octave line

Use one of the following:

Select a range of notes, then double click an octave line from a palette.
Select one or more measures, then double click an octave line from a palette.
Click on a note, then double-click an octave line from the palette (extends line from selected note to end of bar).
Drag an octave line from a palette onto a note (extends line from selected note to end of bar).

See also, Lines: Adjust vertical position.

Change length

See Lines: Change length.

Custom lines

Octaves can be customized just like any other line. See Lines: Custom lines and line properties.

External links

Octave  at Wikipedia

1. Gerou/Lusk. Essential Dictionary of Music Notation (Internet Archive ). ↩�

Respiro e Pause

Per inserire un simbolo di respiro selezionarlo dalla tavolozza (dall'area di lavoro Avanzata) e trascinarlo su una nota
dello spartitp. Il simbolo di Respiro viene posizionato dopo la nota.

Simbolo di Respiro nello spartito:

La Cesura funziona allo stesso modo.

Ripetizioni

L'inizio e la fine di ripetizioni semplici (ritornelli) possono essere definite inserendo in maniera opportuna le stanghette. Per
le istruzioni di finali di 1a e di 2a volta, vedi Volta.
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Riproduzione

Per ascoltare le ripetizioni nella modalità riproduzione verificare che il tasto "Attiva/Disattiva ripetizioni"  della barra
Riproduzione sia selezionato. Nello stesso modo si può arrestare la ripetizione, durante la riproduzione, deselezionando il
bottone.

Nell'ultima battuta di una ripetizione si possono impostare le proprietà "Conteggio ripetizioni" per definire il numero di
ripetizioni da suonare.

Simboli di ripetizione e Testo

Testo e relativi simboli legati alle ripetizioni si trovano nella tavolozza Salti e Ripetizioni.
La tavolozza Salti e Ripetizioni contiene i simboli di ripetizione battuta, segno e coda. inoltre 'D.S.', 'D.C.', e il testo Fine:

Per aggiungere un oggetto dalla tavolozza ripetizioni trascinarlo dentro (non sopra) la battuta (la battuta cambia colore).
Rilasciandolo si posizionerà sopra la battuta.

Salti

I Salti generalmente offrono tre opzioni:

Vai al segno
fino al segno
continua fino al segno

Segno è il nome del marcatore attribuito alla posizione di una misura. Due segni ("inizio" e "fine) indicano l'inizio e la fine
di una partitura e non è necessario indicarli esplicitamente.

Esempi:

In corrispondenza del simbolo Da Capo la riproduzione ritorna all'inizio e suona di nuovo l'intero spartito (fino al segno di
fine implicito).

In corrispondenza del simbolo Da Capo al Fine la riproduzione ritorna all'inizio e suona di nuovo l'intero spartito fino al
segno di Fine .

Dal Segno al Fine (o D.S. al Fine) passa al Segno suona fino al segno Fine

Dal Segno al Coda suona dal Segno fino alla prima Coda. Poi la riproduzione prosegue fino al secondo segno Coda. La
proprietà del marcatore può essere modificata con un clic del tasto destro sul simbolo Dal Segno al Coda.

Vedi anche

Volta
Come separare una coda dal resto dello spartito

Collegamenti esterni

Video tutorial: Codas

Stanghette

83

https://musescore.org/it/node/11368
http://www.youtube.com/watch?v=04XTa6IrzGg


Cambiare il tipo di stanghetta

Le stanghette possono essere modificate trascinandone una dalla relativa tavolozza fino a quella da sostituire sullo
spartito.

Per nascondere completamente una stanghetta selezionarla e togliere la spunta su Visibile in Ispettore (F8).

Creare un doppio pentagramma

Per estendere le stanghette su più pentagrammi selezionatela con un doppio clic (vedi Modalità modifica).

Fare clic sulla maniglia blu e trascinarla verso il basso fino al secondo pentagramma.

Le modifiche saranno effettive dopo aver lasciato la Modalità modifica.

Vedi anche

Operazioni sulle battute

Trasporto

Il trasporto 'sposta' una selezione di note più in alto o più in basso sul pentagramma. MuseScore supporta diversi metodi
di trasporto
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Trasporto cromatico per chiave

Il trasporto cromatico alza o abbassa la tonalità delle note con incrementi di un semitono. Dal menù principale selezionare
Note → Transporto... e scegliere in quale tonalità trasporre: Tonalità vicina, su o giù.

Trasporto cromatico per intervallo

Il trasporto cromatico alza o abbassa la tonalità delle note con incrementi di un semitono.Dal menu principale
sselezionare Note → Transporto.... Mettere la spunta su "Per intervallo" e selezionare su o giù, poi, dall'elenco a discesa,
selezionare l'intervallo.
È anche possibile trasporre una selezione di note utilizzando le frecce direzonali (↑ o ↓).

Trasporto diatonico

Il Trasporto diatonico (o per intervalli) alza o abbassa la tonalità delle note in base all'armatura di chiave. È possibile
modificare una singola nota trascinandola su o giù, o modificare una selezione di più note con Ctrl + un clic e
trascinamento.

Strumenti traspositori

Alcuni strumenti come la tromba in si bemolle o il sassofono contralto sono strumenti traspositori. Questi strumenti
suonano in una tonalità superiore o inferiore a quella scritta. MuseScore integra il supporto per questi strumenti.

Il pulsante Partitura in Do, o l'opzione Note → Partitura in Do nel menù in alto a sinistra consente di passare da diapason a
trasporto. Partitura in Do è utile a compositori e arrangiatori, perché mostra tutti gli strumenti nella stessa chiave, in modo
che le note sul pentagramma abbiano la stessa altezza. Quando Partitura in Do è deselezionata, le note di alcuni
strumenti non corrispondono alla tonalità impostata ma sono correttamente indicate per uno strumentista. Se si utilizza
Partitura in Do durante la sessione, ricordarsi di deselezionarlo prima di stampare le parti.

La trasposizione degli strumenti è già impostata in MuseScore. Tuttavia, se si desidera utilizzare uno strumento raro o la
cui trasposizione non sia disponibile in MuseScore, potrebbe essere necessario modificare manualmente la trasposizione
dello strumento . Fare clic destro su una parte vuota del rigo dello strumento e scegliere Proprietà pentagramma.... Nella parte
inferiore della finestra Proprietà del pentagramma è possibile selezionare l'intervallo utilizzabile, eventuali spostamenti di
ottava, e l'intervallo superiore (su) o inferiore (giù) rispetto a quello scritto.

Vedi anche

Come trasporre
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Tremolo

Il tremolo è la ripetizione rapida di una nota o la rapida alternanza tra due o più note. È indicato da delle linee che
attraversano il gambo delle note interessate. Se il tremolo è tra due o più note queste linee sono disegnate tra i gambi
delle note interessate. Il simbolo Tremolo è utilizzato anche per trascrivere i rulli di tamburo
La tavolozza tremolo contiene simboli separati per il tremolo di una nota singola (simboli con i gambi) e per il tremolo tra
due note (simboli senza gambi).

Per aggiungere il tremolo allo stelo di una singola nota, selezionare la testa della nota e fare doppio clic sul simbolo
desiderato nella tavolozza tremolo.

Nel tremolo tra due note ognuna di queste viene indicata col valore dell'intero tremolo. Per esempio, per inserire un
tremolo della durata complessiva di 2/4 (minima) inserire due note di 1/4 (semiminima). successivamente trascinare il
simbolo del tremolo sulla prima nota: le due note interessate saranno automaticamente visualizzate di durata 2/4 (minima)
con il simbolo del tremolo posizionato tra i due gambi.

Volta

I simboli di Volta o di finali di 1a e di 2a volta sono utilizzati per definire differenti finali in un ritornello.

Per inserire un simbolo di volta nella partitura selezionarlo e trascinarlo (drag-and-drop) dalla tavolozza Linee.

Il simbolo di volta può comprendere una o più battute. Fare doppio clic sul simbolo di Volta per entrare nella Modalità di

modifica e spostare le maniglie con:

Shift+→ una battuta a destra
Shift+← una battuta a sinistra

Questi comandi spostano l'inizio o la fine "logica" del simbolo di Volta, che determina la riproduzione in MuseScore e il
layout su più accollature. Se si spostano le maniglie utilizzando i tasti freccia da soli oppure se si usa il mouse, si avrà una
regolazione grafica più precisa, ma non sarà modificata la modalità di ripetizione.

Se spostate le maniglie viene mostrata una linea tratteggiata tra la posizione logica (ancoraggio) e quella grafica.

Testo

È possibile cambiare il testo e altre proprietà del simbolo di volta utilizzando le proprietà dalla linae nella finestra di
dialogo. Fare clic con il tasto destro del mouse sul simbolo e selezionare Proprietà linea.... La figura seguente mostra
l'esempio di un testo "1.-5."
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È possibile anche cliccare con il tasto destro del mouse sul simbolo di Volta e selezionare Proprietà Volta. Da qui è
possibile cambiare sia il testo del simbolo Volta (come da Proprietà Linea qui sopra) sia l'Elenco Ripetizioni. Se si vuole
che un finale sia suonato soltanto in alcune ripetizioni e un altro finale sia invece suonato in altre ripetizioni, digitare le
ripetizioni desiderate separandole con una virgola. Nell'esempio qui sotto, questa Volta verrà suonata durante le ripetizioni
1, 2, 4, 5 e 7. Un'altra Volta avrà l'altro finale, come 3, 6 ed eventualmente altri numeri più alti quali 8, 9, ecc.

Riproduzione

A volte il ritornello deve essere ripetuto per più di due volte. nella figura qui sopra il testo indica che deve essere ripetuto
per cinque volte prima di continuare. Se si desidera cambiare il nomero di ripetizioni che MuseScore dovrà riprodurre
selezionare la battuta con la stanghetta del ritornello e modificare il parametro conteggio ripetizione (vedi Operazioni sulle
battute: Altro per i dettagli).

Collegamenti esterni

Video tutorial: Repeats, 1st and 2nd time endings
Screencast: Add alternative repeats with MuseScore

Suono e riproduzione

MuseScore incorpora funzionalità di "Suono e riproduzione". Questo capitolo tratta i controlli di riproduzione e come
utilizzare i suoni degli strumenti diversi dal suono del pianoforte di base.

Cambio strumento lungo il pentagramma

Quando è necessario per un musicista raddoppiare un dato strumento, per una sezione di un brano, le istruzioni del
cambio strumento sono generalmente posizionate sopra il rigo, all'inizio della sezione. Nello stesso modo viene gestiro il
ritorno allo strumento precedente.

MuseScore permette agli utenti di inserire una classe speciale di testo chiamato Cambio strumento per questo scopo.
Questa classe di testo è diverso da quelli usati per Pentagramma or Sistema perchè si riflette sulla riproduzione e sul
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suono attribuito al nuovo strumento. Ci sono tuttavia alcune limitazioni alla funzionalità di questa funzione, in 2.0.x, che è
preferibile approfondire prima dell'utilizzo.

1. La trasposizione automatica alla relativa chiave, da Partitura in Do per gli Ottoni ed i Legni traspositori non è
attualmente supportata. Per le modifiche strumenti notati in una chiave diversa (da Flauto in Do a flauto inMi♭; da
Oboe a Corno inglese, ecc.), l'utilizzo del normale Testo di pentagramma per indicare il cambiamento è preferibile,
e la trasposizione deve essere effettuata dopo l'inserimento della musica (utilizzando Note>Trasporto dal menù
principale). Per evitare discordanze nella riproduzione, lo strumento assegnato a quel pentagramma dovrebbe
essere disattivato nel Mixer (F10).

2. Se è necessario ascoltare il suono del nuovo strumento in riproduzione, deve essere utilizzata la funzione del testo
Cambio strumento. Comunque, dopo un cambio strumento lungo il pentagramma, dove i due strumenti sul
pentagramma non sono notati nella stessa chiave, non bisogna tentare di inserire lle note direttamente dalla tastiera.
Possono invece essere (a) incollate o (b) inserite prima di effettuare il cambio dello strumento. L'inserimento nelle
battute seguenti il cambio dello strumento sono soggette a due noti bug del programma, che non possono essere
risolti nelle versioni 2.0.x attuali senza compromettere la retrocompatibilità. (È stato risolto per la prossima versione
stabile v.3.0.) Inoltre Partitura in Do deve rimanere attivato o sarà difforme dalla trasposizione. Per comodità degli
utenti una copia della parte può essere salvata come file autonomo e le sezioni che lo richiedono trasposte alla
relativa chiave prima della stampa della parte. (Notare che la trasposizione di una parte collegata influenzerà la
partitura.)

3. Quando si passa da uno strumento in Do a un altro, o da uno strumento traspositore ad un altro nella stessa chiave
(da Tromba Si♭ a Cornetta in Si♭ cornet o Flicorno ecc.), il Testo Cambio strumento può essere utilizzato per
garantire che il suono di riproduzione sia corrispondente al nuovo strumento. L'inserimento può essere fatto in modo
usuale, e non è influenzato dai bug menzionati sopra.

Inserire un cambio strumento lungo il pentagramma

1. Selezionare il punto iniziale della variazione

2. Applicare "Instrument" dalla tavolozza Testo

3. Fare doppio clic sul testo "Instrument" appena aggiunto (o Ctrl+A) per modificarlo

4. Digitare il testo che si desidera visualizzare sulla partitura, poi fare clic altrove per uscire dalla modalità modifica.

5. Clic del tasto destro sul testo e selezionare "Cambio strumento…"

6. Scegliere lo strumento e fare clic su OK
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Formattare il Testo Cambio strumento

Notare che è possibile formattare il testo Cambio strumentonell'editor di testo che appare nella parte inferiore dello
schermo, mentre si è in modalità di modifica del testo. Perchè le modifiche siano effettive il testo può essere prima
evidenziato (con Ctrl+A o clic+trascinamento).

La formattazione del testo può anche essere eseguita modificando le Proprietà del testo. Queste sono accessibili con un
clic destro sul testo, dopo aver lasciato la modalità di modifica. In alternativa, è possibile applicare uno Stile di testo (che
applicherà le stesse modifiche a tutti i Testi Cambio strumento in tutto la partitura).

See also

Cambiare strumento
Cambiamenti momentanei di suono

Importazione MIDI

L'Importazione MIDI è personalizzabile tramite il pannello di importazione MIDI che compare ogni volta che file .mid/file
midi/.kar vengono aperti in MuseScore. Con questo pannello, gli utenti ottengono un controllo più preciso
dell'elaborazione, selezionando tracce e applicando loro le opzioni disponibili (per esempio l'uso di quantizzazione, note
puntate, legature ecc.); Il pulsante "Applica" (in alto) mostrerà tutte le modifiche con effetto immediato. Il pulsante
"Annulla" eliminerà immediatamente le modifiche non salvate.

Utilizzare Maiusc+rotella del mouse o Ctrl+rotella del mouse per scorrere le opzioni orizzontalmente; o le tracce, verticalmente,
senza modificare le opzioni.

Il risultato dovrebbe essere una migliore qualità nella riproduzione della partitura dal file

Il pannello di importazione MIDI mostra una lista di tracce (sono visualizzabili solo le tracce con eventi nota) e le
operazioni disponibili per ogni traccia.

Se ci sono più tracce, ne viene aggiunta un'altra, in cima alla lista, per selezionare tutte le tracce in una sola volta.
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Nel pannello, è possibile selezionare le tracce per l'importazione e riordinarle. Vengono visualizzate anche alcune meta
informazioni (suono, nome pentagramma, e 'parole' se presenti). La presenza della colonna parole è un'indicazione che il
file contiene una traccia per i testi, assegnabile alle diverse tracce tramite l'elenco a discesa disponibile con un clic.

Le operazioni (a destra) sono presenti come coppie: "nome" - "valore". Ogni valore è modificabile e cliccabile. Può essere
una combinazione o una casella di controllo (lista di scelte disponibili). La serie di opzioni disponibili può variare da traccia
a traccia, a seconda del tipo (suoni determinati o traccia percussioni).

Il pannello di importazione MIDI aggiorna le informazioni rilevanti di qualsiasi file visualizzato se l'utente ne ha aperti
diversi . Se non più necessario il pannello di importazione MIDI può essere chiuso facendo clic sul pulsante nell'angolo in
alto a sinistra. Il pannello riapparirà dopo aver cliccato sul pulsante "Mostra pannello di importazione MIDI" che appare
subito dopo che il pannello è stato chiuso.

Operazioni disponibili

MuseScore strumenti
Assegna uno strumento MuseScore (elencati in instruments.xml o specificato nel file xml personalizzato, in
Preferenze) che definisce il nome del pentagramma, chiave, tonalità, articolazioni, ecc

Quantizzazione

Quantizza le note MIDI in base a normali schemi. La risoluzione MAX dello schema può essere impostato tramite il
menu a tendina:

Valore da Preferenze (default) - il valore di quantizzazione è preso dalla finestra di dialogo delle preferenze
principali di MuseScore (nella scheda "Importazione")
Semiminima, croma, 1/16, 1/32, 1/64, 1/128th - valori definiti dall'utente
La reale dimensione dello schema è adattativo e si riduce se il valore della nota è piccolo.

Voci max.
Imposta il numero massimo di voci consentite

Gruppi irregolari
Se abilitata, questa opzione tenta di rilevare i gruppi irregolari e applica lo schema di quantizzazione corrispondente
agli accordi del gruppo irregolare.

È prestazione umana
Se attivata, questa opzione riduce la precisione della conversione da MIDI a partitura a favore della leggibilità. È utile
per i file MIDI non allineati, quando non è disponibile uno schema di quantizzazione. Per questi file l'algoritmo di
rilevamento automatico dei battiti è utilizzato per tentare di rilevare le posizioni dalle battute in tutta la partitura.

Conteggio battute meno 2x
L'opzione è attiva per i file MIDI non allineati (quando "È prestazione umana" è selezionata per impostazione
predefinita). Dimezza il conteggio della battuta ottenuto dall'operazione di tracciamento interno dei battiti. Può
essere utile quando il tracciamento dei battiti 2x genera suddivisioni in battute più frequenti del necessario.

Unità di Tempo
L'opzione è attiva per i file MIDI non allineati. L'utente può scegliere un'unità di tempo adeguata per tutto il brano se
il valore predefinito rilevato è errato. L'opzione è utile perché gestisce i gruppi irregolari importati correttamente a
differenza dell'impostazione diretta dalla tavolozza tempo.

Dividi pentagramma
Questa opzione è adatta soprattutto per le tracce di pianoforte - per assegnare le note per la mano sinistra o destra
dell'esecutore. Utilizza la separazione per altezza costante (l'utente può scegliere l'altezza con opzioni secondarie) o
la separazione per altezza variabile (a seconda della larghezza mano - una sorta di ipotesi dal punto di vista del
programma).
Per le tracce di batteria (suono "Percussioni" nella lista delle tracce) si divide il personale in più pentagrammi,
ciascuno dei quali ottiene un solo tono di percussione (es. suono di batteria). C'è anche una sub-opzione per
consentire/non consentire l'applicazione della graffa per l'insieme appena creato delle tracce di percussioni.

Modifica chiavi
Le chiavi piccole possono essere inserite all'interno di un pentagramma per mantenere gli accordi più vicini alle 5
linee del pentagramma. I cambi di chiave dipendono dal tono medio dell'accordo. I gruppi di note legate non sono
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interrotti dall'inserimento della chiave (se ciò si verifica, si può segnalare un bug per l'algoritmo in
importmidi_clef.cpp). Questa opzione non è disponibile per le tracce percussioni.

Semplifica durata
Riduce il numero di pause per formare la durata delle note più "semplice". Per le trecce delle percussioni questa
opzione può anche eliminare le pause ed incrementare la durata delle note.

Mostra staccato
Opzione per mostrare/nascondere le marcature di staccato nella partitura.

Note puntate
Controlla se MuseScore userà note puntate o legature di valore.

Mostra Testo tempo
Mostra/nasconde le marcature di testo tempo nella partitura.

Mostra nomi degli accordi
Mostra/nasconde i nomi degli accordi nella partitura, se presenti, per i formati di file MIDI XF.

Riconosci battuta in levare
Se abilitata, questa opzione non cambia l'unità tempo della prima battuta che è più corta della seconda. È detta
anche anacrusi. Questa opzione è applicabile per tutte le tracce in una volta sola.

Rileva swing
MuseScore cerca di rilevare lo swing - per sostituire la terzina [4th + 8th] con due crome straight, o ottavi non
modificati, (per lo swing consueto, 2:1) o un ottavo puntato più un sedicesimo sempre con due crome straight (per lo
shuffle, 3:1). Stampa anche "swing" o "shuffle" all'inizio del pentagramma con note swingate.

Librerie di suoni

Panoramica

Un SoundFont è un tipo speciale di file che contiene molti esempi di vari strumenti che suonano note diverse,
consentendo a MuseScore di riprodurre il suono dello strumento. Alcuni SoundFonts sono progettati per la musica
classica, altri sono stati progettati per il jazz, pop, ecc. Molti SoundFonts sono disponibili sul web. Per un'informazione sui
128 suoni disponibili vedere General MIDI  (GM). Se si utilizza un SoundFont non conforme allo standard General MIDI
quando si condivide uno spartito o si esporta un file MIDI gli altri potrebbero non sentire correttamente gli strumenti.
MuseScore 0.9.6 – 1.3 sono caratterizzati da una libreria di suoni molto leggera TimGM6mb.sf2, mentre MuseScore 2 è
corredato dal più realisticoFluidR3Mono_GM.sf3.

La dimensione del file e la qualità del suono delle librerie di suoni disponibili sul web varia. SoundFonts più grandi spesso
suonano meglio, ma occupano molta memoria e possono essere troppo grandi per funzionare sul computer. Se si nota
che MuseScore funziona lentamente dopo l'installazione di una grande libreria di suoni, o il vostro computer non risponde
correttamente durante la riproduzione, è opportuno cercare un SoundFont più piccolo.

Una volta installata la libreria di suoni, è possibile utilizzarla in MuseScore (e controllare altri aspetti del suono in uscita)
con il sintetizzatore. Per visualizzare il sintetizzatore utilizzare Visualizza → Sintetizzatore.

Installare una Libreria di suoni

Dopo aver trovato e decompresso un SoundFont (vedi→sotto), fare doppio clic per aprirlo. Nella maggior parte dei casi, il
tipo di file SoundFont sarà già associato a MuseScore, e all'avvio MuseScore mostrerà una finestra di dialogo che chiede
se si desidera installarlo. Occasionalmente un'applicazione diversa da MuseScore sarà associato al tipo di file SoundFont;
in questo caso, sarà necessario fare clic destro (o control-clic) sul file, sin modo da visualizzare un menu da cui è
possibile scegliere di aprire il file in MuseScore. In entrambi i casi, quando la finestra di dialogo chiede se si desidera
installare il SoundFont, fare clic su "Sì" per inserire una copia del file SoundFont nella directory SoundFonts di
MuseScore. Questa directory può essere visualizzata o modificata da MuseScore, Preferenze, ma il percorso predefinito
è:

Windows: %HOMEPATH%\Documents\MuseScore2\Soundfonts

macOS and Linux: ~/Documents/MuseScore2/Soundfonts

Diversamente dalle Librerie di suoni aggiunte dall'utente quella installata di default si trova in una directory di sistema,
destinato unicamente a tale scopo, e non dovrebbe essere modificata. Questa directory e il suo file SoundFont di default
è:

Windows (32-bit): %ProgramFiles%\MuseScore 2\sound\FluidR3Mono_GM.sf3

Windows (64-bit): %ProgramFiles(x86)%\MuseScore 2\sound\FluidR3Mono_GM.sf3
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macOS: /Applications/MuseScore 2.app/Contents/Resources/sound/FluidR3Mono_GM.sf3

Linux (Ubuntu): usr/share/sounds/sf2/FluidR3Mono_GM.sf3

Disinstallare

Per disinstallare una libreria di suoni è sufficiente aprire la cartella in cui è installata ed eliminarla.

Sintetizzatore

Il Sintetizzatore è il pannello di controllo principale di MuseScore per l'uscita audio. Una volta che una libreria di suoni è
stata installata, è necessario caricarla nel sintetizzatore in modo che MuseScore possa usarlo per la riproduzione. Per
impostare un diverso SoundFont come default, caricarlo nel sintetizzatore e fare clic sul Imposta come predefinito.

Per visualizzare il sintetizzatore, utilizzare Visualizza → Sintetizzatore. Per maggiori dettagli vedere: Sintetizzatore.

Elenco di Librerie di suoni

Di seguito sono riportati alcuni popolari fonts audio GM di diverse dimensioni.

Fluid R3 GM  (141 MB decompresso)
Licenza: rilasciato sotto licenza MIT incluso nell'archivio)
GeneralUser GS  (29.8 MB decompresso)
Courtesy of S. Christian Collins
Magic Sound Font, version 2.0  (67.8 MB decompresso)
Arachno SoundFont, version 1.0  (148MB decompresso)
Courtesy of Maxime Abbey
MuseScore version 1.x shipped with TimGM6mb  (5.7 MB decompresso)
Licenza: GNU GPL, version 2
Courtesy of Tim Brechbill
MuseScore version 2.0 is shipped with the SoundFont FluidR3Mono_GM.sf3  (12.6 MB).
Licenza: released under the MIT license
Timbres of Heaven, version 3.2  (369 MB decompresso)
Courtesy of Don Allen

Oltre ai file SoundFont, MuseScore supporta anche il formato SFZ, grazie al nuovo sintetizzatore Zerberus . Ecco
alcune banche di suoni SFZ:

Sonatina Symphonic Orchestra (503 MB decompresso)
Downloads: SoundFont  | SFZ format
Licenza: Creative Commons Sampling Plus 1.0
Salamander Grand Piano, version 3  (between 80 MB and 1.9 GB decompresso)
Licenza: Creative Commons Attribution 3.0
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Salamander Grand Piano, version 2  (between 80 MB and 1.9 GB decompresso)
Licenza: Creative Commons Attribution 3.0
Detuned Piano  (244 MB decompresso)
Licenza: Creative Commons Attribution-ShareAlike 3.0
Plucked Piano Strings  (168 MB decompresso)
Licenza: Creative Commons Attribution-ShareAlike 3.0

Librerie di suoni specialistiche

Acoustic grand piano, release 2008-09-10  (132 MB decompresso)
Descrizione: Yamaha Disklavier Pro piano, sf2 format, 116 samples, 44100Hz, 16bit
Maggiori informazioni: http://zenvoid.org/audio/
Licenza: Creative Commons Attribution 3.0
Courtesy of Roberto Gordo Saez
Acoustic grand piano, old version  (37.5 MB decompresso)
Descrizione: Steinway & Sons, sf2 format, 13 samples, stereo, 44100Hz, 16bit (based on the University of Iowa
Musical Instrument Samples )
More information: http://zenvoid.org/audio/
Licenza: Public domain
Courtesy of Roberto Gordo Saez

Nota: Dal momento che i file SoundFont sono di grandi dimensioni spesso sono compressi in una varietà di formati, tra
cui .zip, .sfArk, and .tar.gz. È necessario prima decomprimere questi file per poterli utilizzare.

ZIP è il formato di compressione standard supportato dalla maggior parte dei sistemi operativi.

sfArk è il formato di compressione progettato appositamente per la compressione dei file SoundFont. Usare lo
speciale sfArk software  per decomprimerlo.

.tar.gz è un formato di compressione popolare per Linux. Gli utenti Windows possono utilizzare 7-Zip ; gli utenti
Mac possono utilizzare The Unarchiver , o le Utility macOS's built-in Archive . che se si utilizza 7-Zip, è necessario
applicare la decompressione due volte: una volta per GZip e una volta per TAR.

Risoluzione dei problemi

Se il pannello degli strumenti di riproduzione è grigio o non visibile, seguire le istruzioni qui sotto per ottenere il
funzionamento della riproduzione:

Fare clic destro sulla barra dei menu e assicurarsi che ci sia un segno di spunta sulla casella Strumenti per il Trasporto  .
È possibile aggiungere o rimuovere il segno di spunta con un clic sulla voce di menu corrispondente. Se questo
passaggio non risolve il problema, continuare come sotto.
Se il pannello di riproduzione scompare dopo aver cambiato la libreria di suoni utilizzare Edit → Preferenze... → I/O tab e
fare clic su OK senza apportare alcuna modifica. Dopo il riavvio di MuseScore, il pannello dovrebbe riapparire.

Se si sta configurando una libreria di suoni per la prima volta, si prega di utilizzare una di quelle consigliate, elencate
sopra.

Se la riproduzione va a scatti , probabilmente il computer non è in grado di gestire la libreria di suoni utilizzata. Due
soluzioni:

1. Ridurre la quantità di RAM (memoria) utilizzata da MuseScore utilizzando un SoundFont più piccolo. Vedi lista qui
sopra per suggerimenti.

2. Aumentare la quantità di RAM disponibile per MuseScore chiudendo tutte le applicazioni ad eccezione di
MuseScore. Se avete ancora dei problemi e una grande libreria di suoni è importante per voi, prendete in
considerazione l'opportunità di aumentare la RAM per il computer.

Vedi anche

Sintetizzatore
Modifica e regolazione dei suoni

Collegamenti esterni

Come cambiare la libreria di suoni (SoundFont) utilizzato per la riproduzione o aggiungerne un altro per
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MuseScore

Mixer

Mixer

Il mixer permette di cambiare il suono degli strumenti e di regolare il volume, il bilanciamento, (il riverbero e il chorus
attualmante non sono supportati) di ogni accollatura. Dal menu principale scegliere Visualizza → Mixer oppure premi F10

(Mac: fn+F10) per far apparire il mixer.

Muto e Solo

Puoi usare la check box Muto per silenziare alcuni pentagrammi. Alternativamente, puoi usare la check box Solo per
silenziare tutti i pentagrammi ad eccezione di quello marcato con "solo".

Quadranti

Per girare un quadrante: Fare clic e trascinare verso l'alto o verso il basso o posizionare il puntatore e utilizzare la rotella
del mouse.
Un doppio clic su ogni quadrante lo riporta al suo valore predefinito.

Suono

Il menù a tendina dei suoni contiene tutti gli strumenti supportati dal SoundFont  attualmente in uso.
Se nel Sintetizzatore sono caricati più SoundFont tutti i campioni di tutti i SoundFonts appariranno in un unico lungo
elenco-tutti i suoni disponibili del secondo saranno accodati a quelli del primo e così via

Cambiare strumento

Puoi cambiare lo stumento associato ad un pentagramma. Il seguente metodo aggiorna il suono dello strumento, il nome
del pentagramma e la trasposizione del pentagramma tutto in un colpo.

1. Clic destro in una zona vuota di una battuta e scegli Proprietà pentagramma...

2. Clic su Cambia strumento... (pulsante a destra)
3. Scegli il nuovo strumento e clicca OK per tornare alla finestra di dialogo Proprietà pentagramma.
4. Clicca ancora OK per tornare allo spartito

Vedi anche Cambio strumento lungo il pentagramma.

Cambiamenti momentanei di suono (pizz., con sordino, etc.)

Alcuni strumenti sono dotati di più canali nel Mixer che possono essere utilizzati per modificare i suoni a metà dello
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spartito. Per esempio, gli archi potrebbero utilizzare il pizzicato, o il tremolo, mentre la tromba potrebbe passare a un
suono con sordina. Le istruzioni seguenti usano il pizzicato come esempio, ma gli stessi principi si applicano a tutte gli
altri cambiamenti di suono.

1. Seleziona la prima nota della sezione dove vuoi che venga applicato il pizzicato
2. Dal menù principale, scegli Aggiungi → Testo → Testo di pentagramma

3. Digita Pizz. A questo punto, il testo di pentagramma rappresenta solo un elemento visuale e pertanto sono necessari
i passi successivi per far sì che l'effetto venga applicato in riproduzione.

4. Clic destro sul testo di pentagramma e seleziona Proprietà testo pentagramma...

5. Nella finestra di dialogo Proprietà testo pentagramma, seleziona una o più voci sulla sinistra (nel tab Cambia canale)

6. Dal menù a tendina, seleziona pizzicato

7. Clicca OK per tornare allo spartito

Ogni nota dopo il testo di pentagramma ora suona come pizzicato. Per tornare a un suono normale, segui gli stessi passi
descritti sopra, eccezion fatta per il passo 3 dove scriverai Arco e per il passo 6 dove selezionerai normale.

Vedi anche

Librerie di suoni
Sintetizzatore
How to change instrument sound (e.g. pizz., con sordino) midway through score

Modalità riproduzione

MuseScore dispone di un sequencer e di un sintetizzatore integrati per riprodurre la vostra partitura.

Premendo il pulsante Play , si entra in Modalità di riproduzione. In Modalità di riproduzione sono disponibili i comandi:

Porta alla nota precedente ←
Porta alla nota successiva →
Porta alla battuta precedente Ctrl+← (Mac: Cmd+←)
Porta alla battuta successiva Ctrl+→ (Mac: Cmd+→)
Riavvolge ad inizio partitura Home (Mac: ⌘+Home)
Attiva/disattiva visualizzazione controlli riproduzione F11 (Mac: ⌥+⌘+P)

Premere il pulsante di riproduzione di nuovo per interrompere e uscire da Modalità di riproduzione.

MuseScore inizia la riproduzione dal punto in cui la si è interrotta precedentemente. Se si seleziona una nota MuseScore
riproduce da quella. La barra degli strumenti ha un pulsante di riavvolgimento per tornare rapidamente a riprodurre la
partitura dall'inizio.

Per includere la riproduzione di ripetizioni, attivare il pulsante  Riproduci le ripetizioni-.
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Controlli riproduzione

Il pannello controlli riproduzione presenta vari controlli per la riproduzione tra cui tempo, posizione di partenza fine, e il
volume generale per la sessione corrente (niente di tutto questo viene salvato nella partitura). Dal menu principale,
scegliete Visualizza → Controlli riproduzione per aprirlo

Nota: è possibile impostare il volume di default tramite il Sintetizzatore(Visualizza → Sintetizzatore).

Conteggio metronomo

È possibile attivare e disattivare un 'conteggio' da eseguire ogni volta che si avvia la riproduzione. Il conteggio metronomo
suona i battiti pe un'intera battuta (secondo l'indicazione del tempo nominale del punto di partenza della riproduzione); se
il punto di partenza è a metà battuta o in una battuta irregolare (anacrusi) riprodurrà battiti sufficienti a riempire quella
misura. L'icona del direttore, nel pannello Controlli riproduzione, attiva o disattiva il conteggio.

Riproduzione Metronomo

È possibile attivare/disattivare l'accompagnamento del metronomo durante la riproduzione della partitura (vedere l'icona
del metronomo sul pannello controlli riproduzione).

Riproduzione ciclica

È possibile ripetere la riproduzione di un passaggio. Utilizzare i tre pulsanti, nella parte inferiore del pannello controlli
riproduzione, prima per impostare inizio e termine quindi riproduduzione del ciclo. Il ciclo può essere attivato anche con il
pulsante nella barra degli strumenti principale di MuseScore.
L'inizio e fine ciclo sono indicati, nello spartito, da una bandiera blu che sarà orientata rispettivamente a destra e a sinistra.

Sintetizzatore

Overview

Il Sintetizzatore è il pannello di controllo centrale di MuseScore per l'uscita audio. Tra le altre cose, permette di caricare
le Librerie di suoni con strumenti dal suono diverso da utilizzare per la riproduzione, controllare i livelli di equalizzazione e
volume, e modificare altri aspetti del suono in uscita.

Per visualizzare il Sintetizzatore, aprire Visualizza → Sintetizzatore.

Le impostazioni del Sintetizzatore hanno effetto solo globalmente.—cioè se vengono aperte contemporaneamente più
partiture non è possibile apportare modifiche alle impostazioni del sintetizzatore per una di esse che non si applichino alle
altre partiture. Inoltre le, modifiche alle impostazioni del sintetizzatore si applicano alla sessione corrente—al
successivo riavvio di MuseScore le impostazioni del sintetizzatore saranno quelle predefinite. Queste impostazioni
predefinite possono essere modificate, tuttavia, in qualsiasi momento con un clic sul pulsante Reimposta come predefinito  nel
sintetizzatore per rendere le impostazioni correnti come predefinite per le sessioni successive.

È anche possibile salvare le impostazioni di una singola partitura e richiamarle, successivamente, con i pulsanti Salva nello

spartito e Carica dallo spartito . Le impostazioni del sintetizzatore salvate in una partitura non saranno richiamate
automaticamente all'apertura; è necessario indicare manualmente che le impostazioni per la partitura devono
essere caricate con il pulsante Carica dallo spartito .
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Le modifiche apportate nel sintetizzatore non saranno applicate nei file audio a meno che le impostazioni ssiano
state salvate per la partitura con il pulsante Salva nello spartito .

Il dettaglio preciso delle opzioni è visibile nell'esempio di seguito Accordatura (below).

Librerie di suoni

Le Librerie di suoni sono file contenente una serie di suoni che MuseScore può utilizzare per la riproduzione. MuseScore
è dotato di un SoundFont chiamato FluidR3Mono_GM.sf3; altre Librerie di suoni possono essere scaricate da internet (vedi
l'Elenco di Librerie di suoni). Una volta proceduto ad Installare una Libreria di suoni, si può scegliere di utilizzarla per la
riproduzione e controllare gli altri aspetti del suono in uscita con il sintetizzatore.

Per impostazione predefinita, il SoundFont FluidR3Mono_GM.sf3 deve essere caricato nel sintetizzatore:

Clic sul pulsante Aggiungi per caricare un'altra libreria di suoni installata nella directory SoundFont.

Nota: Se non è stato installato nessun altro SoundFonts, non ci sarà nessun'altra libreria di suoni da caricare. Per
utilizzare un SoundFont per la riproduzione, deve essere stata eseguita la procedura Installare una Libreria di suoni (Che
è un'azione unica) e poi caricato nel sintetizzatore (può essere fatto caso per caso, o impostato permanentemente).

Un SoundFont caricato può essere rimosso dal sintetizzatore (ma non disinstallare) selezionandolo dalla lista e facendo
clic sul pulsante Cancellae se più librerie di suoni vengono caricate il loro ordine può essere organizzato con i pulsanti Su e
Giù.

Se non è stato modificato alcun suono nel Mixer, il SoundFont in cima all'elenco sarà quello usato per la riproduzione.
Tuttavia, se si sta utilizzando il mixer per suonare strumenti diversi con suoni provenienti da diverse librerie di suoni,
riproduzione funzionerà correttamente solo se si hanno gli stessi SoundFonts caricati -nello stesso ordine- nel
sintetizzatore Per questo, se si utilizzano più librerie di suoni, si consiglia di fare clic sul pulsante Salva nello spartito nel
sintetizzatore, in modo che alla successiva apertura della partitura sia possibile richiamare l'elenco delle librerie di suoni
caricate (e le altre impostazioni del sintetizzatore) con il pulsante Carica dallo spartito .

Eventualmente, è possibile utilizzare il pulsante Reimposta come predefinito  per modificare le impostazioni predefinite del
sintetizzatore in modo da non dover caricare le impostazioni da una partitura la volta successiva. In caso contrario, il
sintetizzatore avrà le sue impostazioni originali di default nella vostra prossima sessione di MuseScore.

Volume

A destra nella finestra del sintetizzatore ci sono due cursori. Uno controlla il volume di riproduzione, l'altro controlla le
opzioni del volume del metronomo incorporato. Come per tutto il resto dei controlli del sintetizzatore, tutte le modifiche
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fatte qui sono temporanee a meno che siano salvate nello spartito o salvate come nuova impostazione predefinita.

Effetti

La scheda Effetti generali del sintetizzatore ospita l'unità di riverbero stereo Zita 1 e il compressore stereo SC4. I due slot
"Effeto A" e "Effeto B," ntrambi con un elenco a discesa di effetti disponibili – tra cui la possibilità di impostare uno o
entrambi i canali su "No Effect".

Per memorizzare una configurazione di effetti come l'opzione di default per il sintetizzatore, fare clic sul pulsante Reimposta

come predefiniti . Se in seguito si modifica la messa a punto degli effetti, è possibile ripristinare tutte le impostazioni originali
facendo clic sul pulsante Carica predefinito .

È possibile memorizzare una particolare configurazione degli effetti di una partitura con un clic sul pulsante Salva nello

spartito ; ocaricarli da una partitura con il pulsante Carica dallo spartito.

Zita 1 riverbero

Il modulo di riverbero stereo Zita 1 onsente di simulare l'atmosfera di qualsiasi cosa, da una piccola stanza ad una grande
sala. Pre-delay, tempo di riverbero e il tono del riverbero può essere regolato finemente utilizzando i controlli a condizione
che:

Delay: Impostare un pre-delay per il riverbero di 20-100 ms.
Low RT60 (bassa frequenza tempo di riverbero): Utilizzare la manopola grigia per regolare il mid-range (50-1000 Hz)
della banda a bassa frequenza che si desidera modificare: le manopole verdi regolano il tempo di riverbero (1-8 secondi)
di questa banda di frequenza.
Mid RT60 (Mid-range reverb time): Regola il tempo di riverbero (1–8 secs) della banda di frequenza mid-range.
HF Damping: Regola la componente ad alta frequenza del riverbero. Aumentando questo valore aumenta la frequenza
del punto di cut-off e rende il riverbero più brillante e più lungo.
EQ1: Consente di tagliare o enfatizzare (da -15 a +15) una banda di frequenza (midrange = 40-2K Hz) nella parte bassa
dello spettro.
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EQ2: Permette di tagliare o enfatizzare (da -15 a +15) una banda di frequenza (midrange = 160-10K Hz) nella parte alta
dello spettro.
Output: Controlla la quantità di effetto applicato. "Dry" è pari a nessun effetto. "Wet" indica il 100% di riverbero. "Mix" il
50/50 di bilanciameno del segnale wet:dry.

Nota. EQ1 and EQ2 influenzerà solo il tono del riverbero, non il segnale dry (non processato).

Per configurare rapidamente una correzione degli effetti, impostare "Uscita" su"Mix" e regolare il comando "Mid RT60" per
il tempo di riverbero desiderato. Poi mettere a punto l'effetto come spiegato sopra.

Accordatura

Per gli strumenti della Partitura in Do MuseScore utilizza l'accordatura standard del diapason: La4 = 440Hz di default. Il
valore può essere modificato tramite la scheda Accordatura del Sintetizzatore.

Come per tutte le altre impostazioni del sintetizzatore anche l'accordatura principale si riflette sulla riproduzione
internamente a MuseScore ma non ha effetto sui file audio esportati (WAV, OGG, MP3) a meno che sia selezionata
l'opzione Salva nello spartito

Cambiare l'accordatura principale

Nota: Si applica a tutti gli spartiti. Solo per la sessione corrente (l'accordatura si reimposta di default all'uscita da
MuseScore). Si riflette sulla riproduzione internamente a MuseScore ma non ha effetto sui file audio esportati (WAV,
OGG, MP3 e MIDI).

1. Visualizza → Sintetizzatore.
2. Clic su Accordatura tab.
3. Inserire un nuovo valore di Accordatura generale (la scala va dai valori minimo

= 300 Hz; massimo = 600.0Hz; è preimpostata a 440Hz).
4. Clic su Cambia accordatura.

Impostare l'Accordatura predefinita

Nota: Si applica a tutti gli spartiti. Alla corrente sessione e successive (fino a quando la si modifica di nuovo). Ha effetto
sulla riproduzione ma non viene esportata nei file audio (WAV, OGG, MP3, MIDI).

1. Modificare l'Accordatura principale come indicato sopra per la sessione corrente.
2. Selezionare Reimposta come predefinita .

Cambiare l'accordatura per una singola partitura

Nota: Si applica alla partitura caricata per la sessione corrente, utilizzando il pulsante Salva nello spartito. Le impostazioni
possono essere richiamate nelle successive sessioni con il pulsante Carica dallo spartito. Ha effetto sulla riproduzione e sui
file audio esportati (WAV, OGG, MP3, MIDI).

1. Cambiare l'Accordatura principale come indicato sopra per la sessione corrente.
2. Selezionare Salva nello spartito.
3. Ora otterrete questa nuova accordatura nei file audio esportati dalla partitura corrente ma le altre partiture saranno

esportate con l'accordatura preimpostata. Tuttavia, a causa di una limitazione in MuseScore, è necessario fare clic
su Carica da spartito per ottenere la corretta accordatura durante la riproduzione.
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Swing

Le partiture supportano lo swing in riproduzione

Attivare lo swing

1. Fare clic sulla prima nota

2. Fare doppio clic sul testo Swing nella tavolozza Testo

Impostazioni Swing

Le impostazioni generali di swing (a livello di partitura) sono disponibili da Stile → Generale... → Partitura.

Di default lo Swing è disattivato. È possibile selezionare la frequenza di battimento.

Le impostazioni individuali dello swing sono disponibili tramite il tasto destro del mouse → Proprietà testo di accollatura  →

Impostazioni swing.

Disattivare lo swing

Se avete una partitura con il suono "swing" e "anche" e volete che questo si rifletta nella riproduzione:

1. Inserire il testo "Swing" come spiegato sopra
2. Modificare il testo in "anche" (doppio clic sul testo appena inserito)
3. Impostare lo swing senza riproduzione tramite il tasto destro del mouse → Proprietà testo di accollatura  → Impostazioni swing

→ spento

Proprietà Testo

Le proprietà del testo sono quelle dei marcatori di Tempo

Tempo

Il tempo della riproduzione può essere cambiato utilizzando il pannello Controlli Riproduzione oppure con un'indicazione di
Tempo all'interno della partitura.

Controlli Riproduzione

Per visualizzare i Controlli Riproduzione: Visualizza → Controlli Riproduzione o F11 (Mac: fn+F11)

Modificare i battiti per minuto (bpm) utilizzando il cursore Tempo

Questa impostazione non viene salvata nella partitura ed è usata per sostituire ogni Indicazione di Tempo in essa
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impostata

Metronomo

Il Metronomo (indicazione di Tempo) denota il ritmo della partitura, e si riflette sulla riproduzione. Viene salvata nella
partitura (il valore preimpostato è 120 BPM, se non modificato), e se ne possono inserire quante necessarie.

Per aggiungere un'indicazione di tempo

1. Selezionare una nota, o una pausa, per indicare dove deve essere inserita l'indicazione di tempo
2. Dal menu principale: Aggiungi → Testo... → Indicazione di tempo

L'Indicazione di tempo inserita può essere modificata facendo un doppio clic sul testo per attivare la Modalità di modifica.
Potete utilizzare Modifica del testo per inserire il simbolo di una semiminima o un'altra indicazione di tempo.

I battiti per minuto (BPM) di un tempo esistente possono essere cambiati modificando direttamente il testo (se in Ispettore
è selezionato 'Segui il testo' e sono presenti nell'indicazione di tempo appropriate informazioni). Per le impostazioni
avanzate, selezionare l'indicazione di tempo e aprire Ispettore: F8 (Mac: fn+F8)

Nota: Il tempo reale durante la riproduzione potrà essere più lento o più veloce se i BPM nella finestra Controlli
Riproduzione hanno un'impostazione del valore percentuale diverso da 100.

Cambi di tempo graduali come ritardando ("rit.") e accelerando ("accel.") possono essere aggiunti alla partitura come i
Testi, ma al momento non hanno alcun effetto sulla riproduzione.

Vedi anche

How to create a tempo text

Dinamiche

Il volume di riproduzione può essere cambiato per l'intero pezzo attraverso i Controlli di riproduzione F11, oppure
localmente attraverso le dinamiche.

Dinamiche (testo)

Dalla tavolozza delle dinamiche trascina una dinamica sopra a una nota nello spartito. Alternativamente puoi
selezionare una nota nel pezzo e fare doppio clic su di una dinamica nella tavolozza.
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Per aggiungere crescendo e diminuendo vedi Crescendo e diminuendo.

Per ulteriori dinamiche utilizza la Tavolozza Generale (ShiftF9). Puoi anche creare una tavolozza personalizzata
per riutilizzarla in seguito.

Regolare il volume di riproduzione di una dinamica

Fai clic sulla dinamica per selezionarla. Nell'ispettore regola il valore di "Intensità"—più alto per più forte, più basso per più
piano. Se l'ispettore non è visibile, vai in Visualizza-> Ispettore o premi F8 (Mac: fn+F8).

Controlli riproduzione

Per visualizzare i Controlli di riproduzione: Visualizza → Controlli riproduzione

Cambia il volume trascinando lo slider

Collegamenti esterni

Video tutorial: Lezione 10 - Articolazioni, Dinamiche e Testo

Testo

Il capitolo precedente tratta il testo che influenza la velocità di riproduzione, ma ci sono molti altri tipi di testo disponibili in
MuseScore: parole, simboli degli accordi, dinamiche, diteggiatura, basso figurato, intestazioni, marcatori di riferimento e
molti altri. Tutti questi sono accessibili dal menu principale via Aggiungi → Testo.

Per brevi testi generici utilizzare testo di pentagramma o di accollatura. La differenza tra questi due tipi di testo è che si
applicano rispettivamente ad un singolo spartito o all'intera accollatura. I due tipi di testo si comportano differentemente i
fase di estrazione delle parti.

Text basics

Add text

To add a text-based element to the score, use one of the following general methods:

Keyboard shortcut: For example, press Ctrl+Tto enter Staff text , Ctrl+L to enter Lyrics, and so on.
Menu command: Add→Text allows you to chose from a range of text-based elements.
Workspace: Select a note and double-click an icon in one of the palettes; or, alternatively, drag a symbol from a
palette onto the staff. e.g. Swing text, Tempo text etc.

Notes: (1) The exact method depends on the type of text you are adding (see Text). (2) For general-purpose text boxes
attached to staves, see Staff and system text.

Format text
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Every text-based element in the score has three levels of formatting:

Text Style

This is the top level of formatting and affects all text elements in the score of a particular class. All staff text, for example
has a unique text style, as do tempo markings, lyrics, chord symbols and so on. MuseScore comes with many predefined
text styles, which can be customized, but you are also free to create your own.

To edit the text style of a class of elements, use any of the following methods:

From the menu bar, select Style→Text….
Right-click on some text and select Text Style….

Note: Changing a text style affects all text objects in the score which use that style.

See also, Text styles.

Text Properties

This is the next level down in the formatting hierarchy and affects the style of the text in one specific text object only. To
edit the text properties for that object—and no other:

Right click on the text and select Text Properties….

See also, Text properties.

Text editing

While editing the actual text in a text element, you can also apply specific formatting to individual characters, using basic
formatting options such as Bold, Italic, font, font size, subscript and superscript. To edit text:

Double click on the text, or
Right-click on the text and select "Edit element," or
Click on the text and press Ctrl+E (Mac: Cmd+E).

See also, Text editing.

Adjust position of text objects

To position a text object, use any of the following methods:

Drag the object.
Select the object and adjust the horizontal or vertical offset values in the Inspector.
Select the object and apply any of the following keyboard shortcuts:

←: Move text left 0.1 staff space.
→: Move text right 0.1 staff space.
↑: Move text up 0.1 staff space.
↓: Move text down 0.1 staff space.
Ctrl+← (Mac: ⌘+←): Move text left one staff space.
Ctrl+→ (Mac: ⌘+→): Move text right one staff space.
Ctrl+↑ (Mac: ⌘+↑): Move text up one staff space.
Ctrl+↓ (Mac: ⌘+↓): Moves text down one staff space.

Modifica del testo

Modalità di modifica del testo

Per entrare in modalità di modifica del testo ci sono diversi metodi:

Doppio click sul testo
Clic destro sul testo e selezionare "Modifica elemento"
Fare clic sul testo e premere Ctrl+E (Mac: Cmd+E)
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Le opzioni di formattazione e di inserimento sono quindi essere accessibili dalla barra del testo nella parte inferiore della
finestra.

Comandi di modifica e scorciatoie da tastiera

In modalità modifica del testo, sono disponibili i seguenti comandi:

Ctrl+B (Mac: ⌘+B) cambia in grassetto
Ctrl+I (Mac: ⌘+I) cambia in corsivo
Ctrl+U (Mac: ⌘+U)cambia in sottolineato
Home Fine ← → ↑ ↓ spostano il cursore
Ritorno (Mac: Delete) rimuove i caratteri a sinistra del cursore
Canc (Mac: → Delete o fn+Delete) rimuove i caratteri a destra del cursore
A capo inizia una nuova linea
F2 (Mac: fn+F2) Inserisce i simboli di testo (vedi sotto)

Scorciatoie caratteri speciali

In modalità modifica del testo i seguenti tasti di scelta rapida possono essere utilizzati per accedere a determinati caratteri
speciali:

Ctrl+Shift+B: Bemolle
Ctrl+Shift+F: Forte
Ctrl+Shift+H: Bequadro
Ctrl+Shift+M: Mezzo
Ctrl+Shift+N: Niente
Ctrl+Shift+R: Rinforzando
Ctrl+Shift+S: Sforzando
Ctrl+Shift+Z: Z

Simboli e caratteri speciali

Si possono utilizzare i simboli di testo per inserire una semiminima, frazioni e altri simboli o caratteri speciali nel vostro

testo. Nella barra del testo fare clic sull'icona , o premere F2 per aprire la finestra Caratteri Speciali
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Facendo doppio clic su un elemento nella finestra di dialogo i caratteri speciali vengono immediatamente aggiunti al testo
su cui è posizionato il cursore. Elementi multipli possono essere inseriti senza chiudere la finestra di dialogo, e, mentre è
aperta si può anche continuare a digitare normalmente, eliminare i caratteri, inserire i codici di caratteri numerici, ecc.

Notare che non è possibile visualizzare la finestra caratteri speciali quando non si è in modalità di modifica del testo, e
che questo non deve essere confuso con la voce di menu dallo stesso nome nella versione per macOS di MuseScore i

Vedi anche

Simboli degli accordi
Parole
Cornici
Modalità modifica

Stile del testo

Tutti i tipi di testo hanno uno stile di base. Per esempio il testo del Titolo è centrato e utilizza caratteri grandi, il testo
relativo al Compositore è più piccolo e allineato a destra. Per modificare gli stili del testo selezionare dal menù Stile →

Testo... o fare clic destro su un testo e selezionare Stile del testo...

Durante la Modifica del testo è possibile fare delle modifiche a partire dallo stile di base.

Proprietà del testo:

Sono suddivise in due categorie
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Testo :

Carattere: nome del font dei caratteri come "Times New Roman" oppure "Arial"
Dimensione: le dimensioni del font in punti tipografici
Stile: proprietà del carattere, corsivo, grassetto, sottolineato
Colore: un clic sul campione di colore per modificarlo
Dimensioni dipendenti dallo "spazio pentagramma" impostazione: le dimensioni seguono la distanza tra le
due linee in un pentagramma standard di 5 linee
System flag: il testo si applica a tutti i pentagrammi di un sistema.

Spiazzamento

Orizzontale
Verticale
Unità di misura dello spiazzamento: in mm o unità di spazio del pentagramma

Allineamento

Orizzontale: sinistra,destra, al centro:
Verticale: allinea il bordo superiore del testo in base al punto di riferimento, centra il testo verticalmente al
punto di riferimento, centra il testo verticalmente rispetto alla base del testo o allinea bordo inferiore del testo
rispetto al punto di riferimento

Cornici

Cornice: agginge una cornice al testo
Tipo di cornice: Cerchio o rettangolo
Spessore del bordo: spessore del bordo della cornice in unità di spazio
Raggio del bordo: spigoli vivi o arrotondati per le cornici rettangolari
Margini del testo : distanza del testo dalla cornice in unità di spazio
Colore: della cornice (primo piano) e sfondo del testo (sfondo)

Tipi di testo:

Titolo, sottotitolo, compositore, paroliere: ancorati alla pagina
Diteggiature: Le diteggiature sono ancorate alla testa della nota
Parole: Le parole sono ancorate a una posizione di tempo (una nota o un accordo non una pausa).
Simboli degli accordi: anche i simboli degli accordi sono ancorati a una posizione di tempo
Testo di Accollatura: si applica a tutti i pentagrammi di una accollatura.1 È ancorato a una posizione di tempo.
Testo di Pentagramma: si applica a un singolo pentagramma di una accollatura.1 È ancorato a una posizione di
tempo.

Creare un nuovo stile di testo

1. Da Stile → Testo... o fare clic destro su un testo e selezionare Stile del testo...

2. Un clic su Nuovo
3. Attribuire un nome
4. Impostare tutte le proprietà

Questo sarà salvato con la partitura quindi non sarà disponibile in un altro file

Applicare le opzioni

È possibile applicarle sia alla partitura che alla parte visualizzate se si preme "Applica" e poi "OK".
Se siete in una delle parti della partitura è disponibile l'opzione "Applica a tutte le parti" utilizzando il relativo tasto prima di
"OK", in modo da non dover modificare tutte le parti singolarmente.

Reimpostare le opzioni di stile

se avete già modificato lo stile con un'altra versione di MuseScore, e volete che esso corrisponda a quello presente nella
versione 2.0, sarà necessario resettare lo stile.
Per procedere: aprire Ispettore, selezionare il testo da resettare e fare clic su "Reimposta il testo a stile". Per reimpostare
tutti i testi a stile: fare clic destro su un testo e scegliere l'opzione "Seleziona" poi "Tutti gli elementi simili...".

106



Vedi anche

Ispettore
Selezione

1. La distinzione tra testo di accollatura e testo di pentagramma ha importanza per le partiture di musica d'insieme. Il
testo di accollatura sarà estratto in tutte le parti. Il testo di pentagramma sarà estratto solo nella parte alla quale è
ancorato. ↩� ↩�

Testo di accollatura e testo di pentagramma

Per il testo generico utilizzare Testo di pentagramma o Testo di accollatura. La distinzione tra testo di accollatura e
testo di pentagramma consiste nell’assegnazione ad un singolo pentagramma o all’intera accollatura. Questo è rilevante
per l’estrazione parti: il testo di pentagramma apparirà solo nella parte che contiene lo strumento specifico cui il testo è
collegato, mentre il testo di accollatura comparirà in tutte le parti. Inoltre, se si sceglie di nascondere i pentagrammi vuoti,
il testo di pentagramma sarà nascosto come il pentagramma cui è applicato. Il Testo di accollatura non viene mai
nascosto dalla funzione "nascondere i pentagrammi vuoti".

Testo di pentagramma

Il Testo di pentagramma è il testo testo di uso generale associato a un particolare pentagramma in una posizione
particolare nella partitura. Per creare un testo di pentagramma scegliere una posizione, selezionando una nota o una
pausa, e utilizzare l'opzione del menu Aggiungi → Testo → Testo di pentagramma, o utilizzare la scorciatoia Ctrl+T (Mac: ⌘+T).
Viene visualizzata una piccola casella di testo e si può immediatamente iniziare a digitare. Si può uscire dalla casella di
testo in qualsiasi momento (anche senza digitare nulla) premendo Esc.

Il Testo di pentagramma può, per esempio, essere usato per applicare indicazioni come "Solo" o "Pizzicato" ad un
pentagramma nella partitura. A seconda delle istruzioni impartite al testo di pentagramma può essere modificata la
riproduzione MIDI del pentagramma, nel punto di inserimento del testo, facendo clic con il tasto destro sul testo di
pentagramma e selezionando Proprietà del testo del pentagramma ... . Vedi Cambiamenti momentanei di suono (pizz., con
sordino, etc.) .

Testo di accollatura

Il Testo di accollatura viene utilizzato quando si desidera applicare le indicazioni di testo a un intero sistema e non solo ad
un pentagramma. Questo fa la differenza nell’estrazione parti, o se si decide di nascondere i pentagrammi vuoti. Per
creare un testo di accollatura scegliere una posizione, selezionando una nota o una pausa, e utilizzare l'opzione del menu
Aggiungi → Testo → Testo di accollatura, o utilizzare la scorciatoia Ctrl+Maiusc+T (Mac: ⌘+Maiusc+T). Viene visualizzata una
piccola casella di testo e si può immediatamente iniziare a digitare. Si può uscire dalla casella di testo in qualsiasi
momento (anche senza digitare nulla) premendo Esc.

Simboli degli accordi

I Simboli degli accordi si inseriscono selezionando una nota e premendo Ctrl+K (Mac: ⌘+K). Si crea così un oggetto di
testo "Nome accordo" per il nome dell'accordo.

Inserire un simbolo accordo

i simboli degli accordi possono essere inseriti e modificati proprio come normale testo. Diesis e bemolle si inseriscono nel
modo seguente:

Diesis: #.
Bemolle: b.
Doppio diesis: x o ##.
Doppio bemolle: bb.

Nota: Dopo aver digitato il simbolo dell'accordo il carattere assumerà automaticamente il formato corretto: un "#" o "b" si
trasformerà nel correttto simbolo di diesis o bemolle. Non cercate di utilizzare gli attuali segni di diesis o bemolle o
MuseScore non li interpreterà correttamente.
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Dopo aver immesso un simbolo accordo è possibile:

Uscire dalla modalità premendo Esc.
Spostare il cursore avanti o indietro per continuare l'inserimento note (vedi i comandi qui sotto).

Comandi da tastiera

Spazio passa alla nota o pausa successiva.
Maiusc+Spazio passa alla nota, pausa o battito precedente.
Ctrl+Spazio (Mac: ⌘+Spazio) per aggiungere uno spazio al nome dell'accordo.
; passa al battito successivo.
; passa al battito precedente.
Tab passa alla battuta successiva.
Maiusc+Tab passa alla battuta precedente.
Ctrl più numero (1 - 9) sposta il cursore in base alla durata corrispondente al numero (ad es.; 6 per la minima)
Esc esce dalla modalità di modifica dei simboli degli accordi

Modifica di un simbolo accordo

Un simbolo accordo esistente può essere modificato come testo normale. Vedi [node: 35996, title="Modifica del testo"]

Sintassi simbolo accordo

maggiore: M, Ma, Maj, ma, maj, Δ (digitaret o ̂  per triangolo)
minore: m, mi, min, -
diminuito: dim, ° (inserito con la lettera minuscola o, indicato come ° se utilizzate i simboli Jazz style, altrimenti come
o)
semidiminuito: ø (digitare0, zero)
aumentato: aug, +

Notare che per gli accordi semidiminuiti potete naturalmente anche inserire delle abbreviazioni come mi7b5 e saranno
resi in questo modo invece di utilizzare il & oslash;

È inoltre possibile utilizzare le estensioni e alterazioni come b9 o #5, sus, alt, e no3. È possibile indicare inversioni e
accordi barrati utilizzando notazioni come C7/E. È possibile utilizzare parentesi e virgole all'interno dei simboli degli
accordi e si può anche racchiudere un intero simbolo di accordo tra le parentesi.

Testo dei simboli accordo

L'aspetto del testo Simboli degli accordi testo può essere modificato nella finestra Stile del testo. (Tasto destro del
mouse su qualsiasi simbolo accordo e scegliere Stile del testo ... ).

Stile dei simboli accordo

Le opzioni di formattazione per i Simboli degli accordi sono disponibili nel menùStile → Generale... → Simboli degli accordi,

Schemi tastiera. Le proprietà regolabili sono elencate sotto le seguenti voci:

Stile
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MuseScore supporta due stili principali di simboli accordo: Standard e Jazz. È possibile scegliere tra questi utilizzando i
pulsanti di scelta.

Nello stile standard, gli accordi sono resi in modo semplice, con il tipo di carattere determinato dal vostro stile di testo per i
simboli degli accordi.

Nello stile Jazz, il tipo di carattere MuseJazz viene utilizzato per un aspetto più simile al testo scritto a mano, ed apici e
altre formattazioni sono resi altrettanto bene

Lo stile Jazz è selezionato per impostazione predefinita se si utilizza uno dei modelli Jazz.

Il terzo pulsante è per lo più per la compatibilità con i vecchi spartiti. È possibile utilizzarlo anche per specificare il
percorso del file dei propri accordi personalizzati. Questi possono essere creati copiando uno dei file standard e leggendo
la relativa documentazione sulla loro struttura. Questo è raccomandato solo per gli utenti avanzati e non vi è alcuna
garanzia che questi file saranno supportati in futuro.

Ortografia delle note

Per impostazione predefinita MuseScore utilizza le lettere per i simboli accordo. Per gli utenti di regioni dove si usano altri
schemi MuseScore prevede i seguenti controlli:

Standard: A, Bb, B, C, C#, ...
Tedesco: A, Bb, H, C, C#, ...
Puro Tedesco: A, B, H, C, Cis, ...
Solfeggio: Do, Do#, Reb, Re, ...
Francese: Do, Do#, Réb, Ré, ...

Ci sono inoltre le opzioni per controllare le maiuscole. Di default, MuseScore trasforma in maiuscole automaticamente tutti
i nomi delle note, come indicato sopra, precedentemente inserite come maiuscole o minuscole. Tuttavia, è possibile
anche scegliere altre opzioni automatizzate:

Accordi minori in minuscolo: c, cm, cm7, ...
Note basse in minuscolo: C/e, ...
Nomi delle note in maiuscolo: DO, RE, MI, ...

È anche possibile disattivare l'automatismo completamente, in questo caso i nomi saranno visualizzati come digitati.
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Posizionamento

Le informazioni di posizionamento nello stile di testo vengono onorate normalmente, in modo da compensare
l'allineamento orizzontale/verticale del testo, se necessario. Tuttavia, nella finestra di dialogo, ci sono i controlli per lo
spiazzamento

Posizione verticale predefinita: altezza sul pentagramma (utilizza valori negativi)
Distanza dallo schema tastiera: se lo schema tastiera è presente, altezza sopra il diagramma
Distanza minima accordo: spazio da lasciare tra simboli degli accordi
Distanza massima stanghetta: spazio da lasciare prima della stanghetta successiva Dovete regolare questo valore
soltanto se vi è un problema continuo nella partitura con sovrapposizione tra l'ultimo simbolo in una battuta e il primo
simbolo nella successiva.

Nota:Oltre alle impostazioni descritte qui, la posizione di default dei simboli di accordi applicati è determinata anche dalle
impostazioni del menù Stile del testo. L'effetto è cumulativo.

Capotasto

Inserire il numero della posizione di capotasto su cui si desidera visualizzare gli accordi sostitutivi, tra parentesi, dopo
aver inserito tutti i simboli di accordo nella partitura.

Diteggiatura

I simboli per la diteggiatura dei vari strumenti si trovano nella tavolozza Diteggiatura, nell'area di lavoro Avanzata

Per la tastiera si utilizzano i simboli 1–5 che rappresentano le dita delle mani sinistra e destra. La chitarra utilizza i numeri
0–4 per le dita della mano sinistra (T è utilizzato occasionalmente per il pollice); la diteggiatura della mano destra, per
chitarra, è indicata dalle lettere p, i, m, a, c; e le corde sono indicate da numeri inscritti in cerchi. Gli ultimi cinque simboli
sono usati per la diteggiatura del liuto nella musica storica.

Per aggiungere un simbolo diteggiatura a una nota:

Selezionare una nota e fare doppio clic su uno dei simboli diteggiatura nella tavolozza
Trascinare e rilasciare un simbolo diteggiatura della tavolozza sulla nota

Per aggiungere i simboli diteggiatura a una serie di note:

1. Selezionare le note desiderate
2. fare doppio clic su uno dei simboli diteggiatura nella tavolozza

Quando la diteggiatura viene aggiunta ad una nota, il simbolo rimane evidenziato, in modo da poterlo regolare subito.

Regolare la posizione del simbolo

Utilizzare uno dei seguenti metodi:

Per regolazioni fini (0.1 sp) utilizzare le frecce direzionali; Per le regolazioni più ampie (1 sp) utilizzare Ctrl+freccia

Modificare scostamenti orizzontali e verticali nell'Ispettore
Trascinare il simbolo utilizzando il mouse

Per spostare più di un simbolo

1. Selezionare i simboli diteggiatura necessari
2. Regolare gli scostamenti orizzontali e verticali nei campi dell'Ispettore

Per riportare un simbolo nella sua posizione predefinita selezionarlo e premere Ctrl+R
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La Diteggiatura è una forma di simbolo di testo e può essere modificata e impostata come di consueto. Un clic con il tasto
destro mostra le opzioni disponibili.

Parole

1. Per prima cosa inserire le note
2. Selezionare la prima nota
3. Dal menù principale selezionare Aggiungi → Testo → Parole o utilizzare Ctrl+L (Mac: ⌘+L) e digitare la sillaba

corrispondente alla prima nota
4. Continuare a immettere parole:

Premere Spazio (o Ctrl+→) alla fine di una parola o sillaba per spostarsi alla nota successiva
Digitare un trattino - alla fine di una sillaba per spostarsi alla nota successiva. Le sillabe saranno collegate da
un trattino
Maiusc+Spazio (o Ctrl+←) riporta alla sillaba precedente
↵ porta alla seconda riga di testo (Nota: non il tasto Invio del tastierino numerico)
Premere Su per tornare alla sillaba della riga superiore

5. Premere Esc per uscire dalla modalità di inserimento parole
6. Per inserire una seconda, o ulteriore, riga di testo ripetere i punti 2 e 3 o selezionare la prima sillaba, premere ↵ e

inserire la sillaba corrispondente alla nota, poi continuare come ai punti 4 e 5

Alcuni esempi:

Le sillabe possono essere collegate alle successive dal trattino basso Shift+_ per annotare un melisma:

Si inserisce così: soul, Maiusc+___ To Esc.

Digitando ripetutamente - si avanzerà alle note successive, verrà mostrato un solo trattino e a sillaba sarà allineata a
destra sotto alla prima nota, in modo analogo al melisma dell'esempio sopra.

Due sillabe sotto una nota possono essere unite con il simbolo di Sinaléfe, una specie di piccola legatura

Cliccare nella barra degli strumenti di testo, nella parte bassa dello schermo, sull'icona  o premere F2 per aprire la
finestra Caratteri Speciali. La sinaléfe è il penultimo simbolo (U+203F ‿ "undertie"). La sinaléfe sarà uniformemente
centrata separando le sillabe con due spazi e inserendola dopo il primo.
Per l'esempio "e ͜ A" qui sopra:
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1. Digitare e
2. Inserire la sinaléfe come detto sopra
3. Digitare Ctrl+Spazio (Mac: ⌥+Spazio)
4. Digitare A

Non tutti i set di caratteri includono la sinaléfe. Per verificare quali di essi la prevedono, sul vostro computer, scorrere la
"fontlist " ((cercando qualsiasi carattere che mostri un trattino curvo invece di un rettangolo bianco). L'allineamento del
carattere varia a seconda del font.

Caratteri speciali

Le parole sono un normale testo cui si può applicare la consueta modifica del testo con l'eccezione di pochi caratteri. Se
si desidera inserire uno spazio, un trattino o un trattino basso (underscore) all'interno di una sillaba utilizzare le seguenti
scorciatoie:

Ctrl+Spazio (Mac: ⌥+Spazio) per inserire uno spazio ( ) all'interno del testo
Ctrl+- (Mac: ⌥+-) o AltGr+- per inserire un trattino (-) alla fine della sillaba
Alt+Maiusc+_ (Mac: ⌥+_) per inserire un trattino basso (_) alla fine della sillaba
Ctrl+↵ (Mac: ⌥+Return) o Invio (dal tastierino numerico) aggiunge la riga successiva

Vedi anche

Testi
Simboli degli accordi
Come inserire i testi
Come spostare i testi delle parti cantate
Come aggiungere un blocco di testo negli spartiti

External links

Video tutorial: MuseScore in Minutes: Lesson 6 - Text, Lyrics and Chords

Numeri di chiamata

I Numeri di chiamata sono utilizzati per identificare i punti specifici di una partitura per facilitare le prove. Sono tipicamente
lettere consecutive o numeri (A, B, C ..., o 1, 2, 3 ...), o contengono il numero della battuta cui sono collegati (anche se
sono generalmente più grandi dei semplici numeri della battuta, spesso in grassetto e/o inscritti in una cornice).
Qualunque sia la vostra scelta MuseScore può visualizzare automaticamente le lettere o i numeri appropriati per ogni
numero di chiamata. Possono essere utilizzati anche come segnalibri cui si può immediatamente arrivare durante la
creazione di una partitura di molte pagine (vedi→sotto).

Aggiungere Numeri di chiamata

Posizionamento manuale

Il modo più semplice per aggiungere un Numero di chiamata è quello di cliccare su una nota (o pausa) all'inizio di una
sezione di prova e utilizzare la scorciatoia da tastiera Ctrl+M (Mac: Cmd+M), o usare il menù Aggiungi → Testo → Numero di

chiamata: poi immettere il testo desiderato.

Posizionamento automatico

In alternativa, selezionare una nota, aprire la tavolozza Testo, e fare doppio clic sull'icona [B1] del numero di chiamata: la
lettera o il numero corretto vengono inseriti automaticamente, secondo le seguenti regole:

1. Il primo Numero di chiamata inserito sarà etichettato "A," il secondo "B," il terzo "C," e così via. Se si desidera
utilizzare un formato diverso (minuscolo, numero o numero di battuta), modificare il primo marcatore prima di
aggiungere il secondo. I marcatori aggiunti successivamente seguono il formato del precedente.

2. Se si aggiunge (dalla tavolozza) un marcatore tra due preesistenti marcatori alfabetici , un "1" viene aggiunto al
nome del nuovo marcatore: quello aggiunto tra le lettere "C" e "D" diventerà "C1"," e così via.
Analogamente, se si aggiunge un nuovo marcatore tra due numerici , una "A" verrà aggiunta: quello aggiunto tra i
numeri "3" e "4" diventerà "3A" e così via. In seguito, potrete sequenziare automaticamente i marcatori, se
necessario (vedi→sotto).
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3. Per creare una serie basata sul numero di battuta, il primo marcatore deve essere modificato (prima di crearne un
secondo) in modo da coincidere con il numero di battuta cui è collegato. (Se il numero del marcatore è diverso dal
numero di battuta, quelli successivi assumeranno un ordine numerico.)

Risequenziare automaticamente numeri di chiamata

MuseScore permette all'utente di riordinare automaticamente una serie di numeri di chiamata se sono fuori sequenza per
qualsiasi motivo. Utilizzare il seguente metodo:

1. Prima di effettuare una selezione, è possibile stabilire un nuovo formato (minuscole/maiuscole, un numero o numero
di battuta), modificando manualmente il primo marcatore nella selezione.

2. Selezionare l'intervallo di battute cui applicare il comando Risequenzia (se non c'è una selezione il programma
applicherà la modifica a tutte le battute).

3. Selezionare Modifica → Attrezzi → Risequenzia Numeri di chiamata.

MuseScore rileva automaticamente la sequenza in base al primo marcatore nella selezione—tutti quelli nella selezione
saranno modificati di conseguenza. Sono possibili le seguenti sequenze:

A, B, C ecc.
a, b, c ecc.
Numerici: 1, 2, 3 ecc.
Numerici: in base al numero di battuta. Questo richiede che il numero del primo numero di chiamata della serie
cioncida con il numero di battuta cui è collegato.

Ricerca del Numero di chiamata

Potete raggiungere un determinato numero di chiamata con Ctrl+F per aprire la casella Cerca, poi inserire il nome del
numero di chiamata. Il primo carattere dovrà essere una lettera per essere trovato: i caratteri successivi possono essere
lettere o numeri.

Nota: Se nella barra di ricerca sono inseriti solo numeri, il programma presuppone che si stia cercando un numero di
battuta. Vedere Visualizzazione e navigazione: Trova..

Stile del Testo

I Numeri di chiamata sono un genere di Testo di Pentagramma. Appaiono su ogni parte e sulla partitura. Le pause di
battuta vengono automaticamente interrotte prima e dopo un numero di chiamata

Per impostazione predefinita i numeri di chiamata sono in grassetto, in grande dimensione del carattere, ed inscritti in
cornici con angoli arrotondati. Tutti gli elementi del loro aspetto possono essere modificati a livello globale tramite lo Stile
del testo del Numero di chiamata.

See also

Text properties

Formattazione

Impaginazione e formattazione

Finita la partitura si può stamparla stamparlo. Ma si vuole migliorarne l'aspetto. Questa pagina descrive molti modi diversi,
e come lavorano insieme.

Modi per modificare l'impaginazione

Impaginazione → Impostazioni pagina...: Modifica delle impostazioni globali come dimensione della pagina, quanto è
grande uno "Spazio pentagramma" (sotto "Scala"), e quanto grandi i margini della pagina. Spazio pentagramma è
utilizzato in altri contesti (esempio: "5.0sp"), in modo che modificare "Spazio pentagramma" influirà su molte altre
impostazioni
Impaginazione → Aumenta/Diminuisci larghezza battuta: Allarga o restringe le battute pecificamente selezionate.
Stile → Generale... → Pagina: Modifica le impostazioni globali che influiscono su quanto vicini sono i pentagrammi,
quanto margine abbiano le parole e così via.
Stile → Generale... → Accollatura: Regola ampiezza. distanza e spessore della graffa.
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Modifica → Attrezzi → Aggiungi/rimuovi interruzioni di riga: Fissa il numero di battute per accollatura.
Stile → Generale... → Spartito: Modifica i dettagli della partitura , ad esempio se ci sono pause di battuta o righi vuoti
nascosti.
Stile → Generale... → Battuta: Imposta la spaziatura della battuta, è la chiave per controllare il numero di battute per
accollatura.
Tavolozze→ Interruzioni& Spaziatori: Spezzano un'accollatura alla una misura specifica, una pagina alla
determinata accollatura, o aggiungono spazio tra le battute.
Stile → Generale... → Dimensioni: Imposta la dimensione proporzionale di "piccolo" per note e note di abbellimento. La
modifica di questo parametro sarebbe insolita.

Nota: Qui le opzioni saranno quasi sempre applicate a tutti gli elementi della partitura cui si riferiscono, alcune opzioni
possono essere applicate individualmente con Ispettore e proprietà degli elementi ad uno o a una selezione di elementi...

Impaginazione → Impostazioni pagina...

Si potranno di impostare l'unità di scala e di margine. Questo è il modo principale per influenzare tanto l'impaginazione
che molti altri elementi influenzati da questo fattore. Può essere espresso in mm o pollici (es).

Ampiezza spazi pentagramma→ Spazio pentagramma
Questa è la dimensione dello spazio tra 2 linee di un pentagramma. Poiché le note si adattano in questo spazio controlla
anche la dimensione delle teste delle note. Dal momento che la musica è proporzionale alle dimensioni delle note, questo
riguarda anche gambi della nota, alterazioni, chiavi e molto altro. Viene indicato con sp in molte altre impostazioni
(esempio: distanza accollature "9.2sp"). Così modificando il parametro "Spazio pentagramma" molte altre impostazioni
cambiano proporzionalmente.
Per questo motivo talvolta è anche definito "scala".

La modifica della scala può modificare il numero di accollature per pagina, a causa della "soglia riempimento pagina"
(vedi sotto). Per visualizzare gli effetti delle modifiche alla scala senza interferenze, impostare la "soglia riempimento
pagina" a100%.

Area stampabile → Margini
Da qui si impostano i margini della pagina. Per visualizzare i margini della pagina nella partitura sullo schermo andare su
Visualizza → Margini pagina e selezionare (mettere la spunta).
Nota: Si possono avere margini differenti sulle pagine pari e dispari. E si possono vedere in anteprima con il navigatore,
appena a destra della finestra.

Dimensioni pagina
È possibile selezionare il formato di carta da utilizzare, con il nome (Letter, A4 ...) o con l'altezza e la larghezza in mm o
pollici (es). Quello di default dipende dal vostro paese.
Ci sono due caselle selezinabili: Orizzontale (se non c'è la spunta sarà applicato il formato verticale), e fronte retro (come
pari e dispari). Notare che se fronte retro saranno modificabili solo i margini delle pagine dispari ma tali modofiche saranno
poi applicate a tutte le pagine

Numero prima pagina
Imposta il numero della prima pagina della singolapartitura
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I numeri di pagina Inferiori a 1 non verranno stampati, così ad esempio un -1 comporterà che la prima e la seconda pagina
non vengano numerate e la terza sia la pagina numero 1.

Applica a tutte le parti
Quando si modifica una parte della partitura (quando è attiva la scheda della parte quando, si accede a questa finestra di
dialogo, piuttosto che quella della partitura, che è quella più asinistra), questo pulsante permette di applicare la modifica a
tutte le parti in una volta.

impaginazione → Aumenta/Diminuisci larghezza battuta

È possibile selezionare le battute, poi ampliarle in modo che ce ne siano meno su un'accollatura ("Aumenta larghezza
battuta"), o comprimerle perl'effetto contrario ("Diminuisci larghezza battuta").

Stile → Generale... → Spartito

Da qui potete creare le Pause di battuta e se nascondere i pentagrammi vuoti. Queste opzioni possono influenzare
significativamente le dimensioni dello spartito; Nascondi pentagrammi vuoti è utile per condensare lo spartito. È
inoltre possibile specificare la dimensione minima e la durata minima delle pause di battuta.

"Nascondi il nome dello strumento, se ce n'è solo 1" può essere un valido metodo per risparmiare spazio nelle Parti (o
nello spartito per il solista) dato che non scriverà il nome dello strumento all'inizio del pentagramma.

È inoltre possibile modificare il tipo di carattere musicale per testo e simboli. Ci sono 3 tipi di carattere musicali disponibili
(per i simboli utilizzati nei pentagrammi): Emmentaler, Gonville, e Bravura. Ci sono 4 font di testo musicale disponibili (per
l'uso in testi come dinamiche, indicazioni di tempo, ecc): Emmentaler, Gonville, Bravura e MuseJazz. Di questi
Emmentaler è quello predefinito e Bravura quello più completo.

(Per cambiare il font del testo e le proprietà vedere Stile del testo)
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Alcune opzioni sono specifiche per l'early music, e riproduzione swing.

Stile → Generale... → Pagina

Qui ci sono un molte opzioni che possono influenzare la vostra impaginazione. Le caselle selezionabili che possono
influenzare l'impaginazione riguardano il mostrare o meno elementi di cortesia (armatura di chiave, unità di tempo e
chiavi). Si può anche determinare la presenza di questi tre elementi in ciascuna accollatura.

Interazione della musica con i margini delle pagine

Margine superiore/inferiore Musica: il margine tra la musica (rispettivamente la linea superiore del pentagramma
superiore dell'accollatura superiore e quello inferiore del pentagramma inferiore dell'accollatura inferiore) e i
corrispondenti margini impostati in →Impaginazione → Impostazioni pagina.

Altre distanze musicali

Distanza pentagramma : Lo spazio tra i righi all'interno di un'accollatura
Distanza doppio pentagramma: spazio tra i righi di uno strumento multi pentagramma come pianoforte e organo
Distanza Minima e Massima tra accollature: Permette di impostare la distanza minima e massima tra un'accollatura
e l'altra. Se entrambe sono uguali la distanza tra accollature sarà identica

Margine parole

Margine superiore e inferiore: Distanza tra pentagramma e testi e e tra i testi e il pentagramma successivo.
Altezza Testo: si tratta di una proporzione da Stile del testo

Margine cornice verticale

Margine cornice verticale superiore e inferiore: spazio sopra e sotto le cornici verticali.

Soglia di riempimento ultima accollatura

Se l'ultima accollatura è più ampia della percentuale della larghezza della pagina, si adatta per riempire la larghezza
definita.

Stile → Generale... → Intestazione, Piè di pagina, Numeri
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È possibile visualizzare il contenuto di metadati di una partitura (vedi Informazioni sullo spartito) in un'intestazione o piè di
pagina. Per creare un'intestazione o piè di pagina per una partitura con parti collegate, assicurarsi che sia attiva la scheda
della partitura. Per creare un'intestazione o piè di pagina per una singola parte, deve essere attiva la scheda della parte.

Se si passa con il mouse sopra la zona del testo dell'intestazione o piè di pagina, verrà visualizzato un elenco di macro,
che mostrano il loro significato, così come i metadati esistenti e il loro contenuto.

È possibile modificare intestazioni e piè di pagina sulle pagine pari e dispari.

È anche possibile decidere se e quanto debbano appaiono numeri delle battute.

Nota: Si possono avere diversi testi sulle pagine pari e dispari.

Stile → Generale... → Accollatura{#style-edit-general-style-system}

117



Graffe
Vedi Graffe

Distanze
È possibile impostare la distanza tra graffe e accollatura
Ampiezza
È possibile impostare l'ampiezza della graffa

Stile → Generale... → Battuta{#style-edit-general-style-measure}

Imposta la spaziatura e i margini della battuta. La spaziatura e la larghezza minima della battuta sono le chiavi per
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controllare il numero di battute per rigo. La modifica delle altre impostazioni sarebbe inusuale.

Stile → Generale... → Stanghette

Per modificare le stanghette all'inizio del pentagramma o di più pentagrammi
Ridimensionare le stanghette della dimensione del pentagramma: Vedi Barline adjustment possibilities

Sono inoltre disponibili le percentuale di spessore e distanza , ma modificarle sarebbe inusuale.

Tavolozze→ Interruzioni& Spaziatori

Usando questa tavolozza, è possibile scegliere dove posizionare interruzioni di pagina, linea o di sezione, o aumentare la
distanza tra due pentagrammi o singole accollature che utilizzano gli spaziatori. Alcuni decidono queste impostazioni
prima, e altri alla fine, dopo aver modificato le impostazioni globali.

Per inserire un'interruzione di pagina, trascinarla fino a una misura. Per inserire una interruzione di linea trascinarla fino
all'ultima battuta che si desidera su quel rigo. Per avere lo stesso numero di battute per diverse accollature, selezionarle e
utilizzare Modifica → Strumenti → Aggiungi/rimuovi interruzioni di riga.Se alcune battute finiscono da sole sul rigo o sulla pagina,
ridurre la scala, o utilizzare Impaginazione → Aumenta/Diminuisci larghezza battuta.

Vedi anche Break or spacer.

Stile → Generale... → Note
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Distanza e spessore di una nota e relativi elementi (gambo, tagli addizionali, punti, alterazioni). La modifica di queste
impostazioni sarebbe inusuale.

Stile → Generale... → Chiavi

È possibile scegliere tra Serif e Chiave standard per le vostre tablature.

Stile → Generale... → Arpeggi
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Qui ci sono proporzioni altezza per distanza dalla nota, spessore della linea e gancio.
La modifica di queste impostazioni sarebbe inusuale.

Stile → Generale... → Gruppi di note

Stile → Generale... → Legature di valore/portamento
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Stile → Generale... → Dimensioni{#style-edit-general-style-sizes}

Imposta la dimensione proporzionale di "piccolo" per note e note di abbellimento. La modifica di questo parametro
sarebbe insolita.

Stile → Generale... → Forcelle, Volta, Ottava
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Il pulsante  riporta l'impostazione al valore originale.

Stile → Generale... → Pedale, Trillo

Stile → Generale... → Simboli degli accordi, Schemi tastiera
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Consente di modificare l'aspetto e altre caratteristiche.
Vedi anche Schemi tastiera

Stile → Generale... → Basso continuo

Opzioni per i font del basso continuo, Stile e allineamento.
Vedi anche Basso continuo

Style → Generale... → Articolazioni, Abbellimenti{#style-edit-general-style-articulations}
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Posizione delle articolazioni rispetto a note e pentagrammi

Style → Generale... → Alterazioni

Opzioni per i naturali al variare della tonalità

Style → Generale... → Gruppi irregolari
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Modifica spaziatura tra le singole note

È possibile modificare la spaziatura tra le note nella partitura con i seguenti passaggi.

1. Fare doppio clic sulla testa della nota che si desidera spostare
2. Premere il tasto freccia nella direzione (destra o sinistra) in cui spostare la nota
3. Premere il tasto Esc per finalizzare il processo (questo ridisegna il gambo della nota).

Nota: potrebbe essere necessario eliminare e quindi reinserire le legature di valore, a volte non correttamente ridisegnate

Pulsanti Applica e OK

Con il pulsante Applica è possibile vedere (senza chiudere la finestra) quali sono le modifiche apportate.
OK salverà le modifiche apportate nello spartito e chiuderà la finestra.

Applica a tutte le parti in una sola volta

Dalla scheda di una parte, mentre si modificano impaginazione e formattazione, è possibile utilizzare il pulsante Applica a

tutte le parti per applicare tutte le modifiche (anche da Impaginazione → Impostazioni pagina... che da Stile → Generale...) e le nuove
impostazioni a tutte le parti in un solo clic.

Salva e carica stile

È possibile, dopo averlo definito, salvare il vostro stile per applicarlo con facilità a tutti gli spartiti.

1. Andare su Stile / Salva Stile
2. Selezionare una cartella e attribuirle un nome (la cartella predefinita sarà quella impostata nelle preferenze). Gli stili

sono memorizzati in formato *.mss

Nota: è possibile definire uno stile preferito per spartiti e parti Preferenze sezione spartito

Vedi anche

A tutorial by Nicolas Froment
A post by Marc Sabatella
Aggiornare da MuseScore 1.x, Ridefinire l'impaginazione locale
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Collegamenti esterni

A video tutorial, part 1
A video tutorial, part 2

General style: Measure

Style → General → Measure  allows you to adjust the distance between various items within measures.

Introduction

If you change a measure style property (see image above), MuseScore automatically adjusts the score to maintain the
correct spacing between notes and rests according to best music engraving practice. It will also correctly reposition any
elements attached to notes or rests, such as fingerings, dynamics, lines etc.
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All settings related to measure width and note spacing are minimum values. Measures are automatically stretched, if
necessary, to maintain existing page margins.

All the properties listed below use the staff space (abbreviated to "sp") as the basic unit of measurement. See Page
settings: Scaling for more details.

Options

Minimum measure width
Sets the minimum horizontal length of measures. In measures containing very little content (e.g., a single whole note
or whole measure rest), the measure will only shrink as far as this minimum.

Spacing (1=tight)
Condenses or expands the space after notes or rests. This setting thus affects not only space between notes but
also between the last note and the ending barline. For the space between the beginning of the measure and the first
note or rest, see Barline to note distance (below).

Note: Changes to an individual measure's Stretch (under Layout → Increase Stretch, Decrease Stretch ) are calculated after,
and proportional to, the global Spacing setting.

Barline to note distance
Sets the distance between the barline which begins a measure and the first note or rest in that measure. For the
initial measures of systems, which start with clefs instead of barlines, use Clef/key right margin (below).

Barline to grace note distance
Sets the distance between a barline and a grace note that occurs before the first actual note in a measure
(independently of the "Barline to note distance" setting).

Barline to accidental distance
Sets the distance between a barline and an accidental placed before the first note in a measure (independently of
the "Barline to note distance" setting).

Note to barline distance
(To be added).

Minimum note distance
Specifies the smallest amount of space MuseScore will allow after each note (depending on other factors, more
space may be allowed).

Clef left margin
Sets the distance between the very beginning of each line and the clef. (This option is rarely needed.)

Key signature left margin
Sets the distance between the key signature and the clef preceding it.

Time signature left margin
Sets the distance between the time signature and the key signature or clef preceding it.

Clef/key right margin
Sets the distance between the material at the beginning of each line (such as the clef and key signature) and the
first note or rest of the first measure on the line. (Note that, although not named in the option, if a time signature is
present, it is the element from which the spacing begins.)

Clef to barline distance
Sets the distance between a barline and a clef change preceding it.

Multi-measure rest margin
Sets the distance between a multi-measure rest and the barlines on either side.

Staff line thickness
Sets the thickness of the lines of the staff, which allows you to make the staff thicker and darker, if you need greater
visibility on your printouts.

Impostazioni pagina
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Impaginazione → Impostazioni pagina... (Stile → Generale...) consente di modificare l'impaginazione e la formattazione di una
partitura. La finestra di dialogo gestisce le opzioni generali di formattazione tra cui Dimensione pagina, Area stampabile,
e Ampiezza del pentagramma (Spazio pentagramma). Impostazioni pagina è il primo strumento da utilizzare per
aumentare o diminuire le dimensioni della partitura.

Dimensione pagina

Qui è possibile selezionare il formato della carta, in base al nome standard (ad esempio, Lettera o A4), oppure
specificando l'altezza e la larghezza in mm o pollici (utilizzare i pulsanti di opzione per scegliere l'unità di misura da
utilizzare). La dimensione iniziale, predefinita, della pagina dipende dalla vostra localizzazione, in Italia, il formato carta A4
è di serie.

Si può anche scegliere di formattare la pagina in orientamento Orizzontale (deselezionare la casella di controllo per
ottenere il formato Verticale ), ed è possibile utilizzare l'opzione Fronte-retro (ad esempio, in formato libro, con margini
diversi per pagine pari e dispari vedere sotto).

Margini-pagina

Le impostazioni Margini pagina pari e Margini pagina dispari consentono di definire l'area di stampa delle pagine. Oltre
che modificare i margini attorno alla partitura sulla pagina, altre impostazioni, come ad esempio le posizioni di intestazioni
e piè di pagina, sono calcolate rispetto ai margini qui definiti.

Se si seleziona la casella di controllo "Fronte-retro" in "Dimensione pagina", è possibile impostare i margini in modo
differente per le pagine pari e dispari. Altrimenti, se un solo set di margini viene modificato, si applicherà a tutte le pagine.

Per visualizzare i margini della pagina nella partitura sullo schermo (anche se non sulla stampa), utilizzare Visualizza →

Mostra margini pagina .

Ampiezza spazi pentagramma

Spazio pentagramma (sp) è la dimensione dello spazio tra due righe di un pentagramma (o un quarto delle dimensioni
dell'intero pentagramma di cinque linee). Poiché le note si adattano a quello spazio, esso controlla anche la dimensione
delle teste delle note, come, proporzionalmente, la dimensione degli steli, delle alterazioni, chiavi ecc. Inoltre, molte altre
opzioni di formattazione sono definite in termini di sp inteso come unità di misura (es. 5.0sp). Poichè la modifica della
dimensione spazio pentagramma ha un effetto proporzionale su quasi tutto, è a volte chiamato anche scala.

Nota: La modifica della scala non modifica sempre il numero di sistemi per pagina, perché la distanza del sistema può
variare tra limiti fissati da "distanza minima tra accollature" e "distanza massima tra accollature" (vedi Stile → Generale... →

Pagina).

Miscellanea

Numero prima pagina
Imposta il numero della prima pagina della specifica partitura.
Un numero inferiore a 1 non sarà stampato, così ad esempio -1 darà come risultato che la prima e la seconda pagina non
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saranno numerate e la terza diventerà la pagina 1.

Applica a tutte le Parti
Quando si modifica una parte della partitura (che significa selezionare la finestra di dialogo mentre si utilizza la scheda di
una parte piuttosto che quella dell'intera partitura, che è la prima a sinistra), il pulsante Applica a tutte le Parti  permette di
applicare la modifica a tutte le parti simultaneamente.

Interruzioni e spaziatori

Le interruzioni di pagina, le interruzioni di riga (interruzioni di accollatura) e le interruzioni di sezione possono essere
inserite nella partitura trascinando il simbolo corrispondente dalla tavolozza a una zona vuota di una battuta o di una
cornice orizzontale. L'interruzione sarà posizionata dopo questa battuta o cornice. I simboli di interruzione sono visibili in
azzurro sullo schermo ma non appaiono nella stampa.

Le interruzioni di accollatura all'interno di una battuta sono a volte necessarie (specialmente negli inni a strofe o
lieder). Per esempio se si vuole dividere una battuta di 4/4 in una di 3/4 e una di 1/4 in levare si devono creare due battute
distinte di minor durata. Per i dettagli vedi Operazioni sulle battute: Dividere e unire.

Gli spaziatori si usano per aumentare la distanza tra due pentagrammi contigui o accollature. Trascinare il simbolo dalla
tavolozza al di sopra della battuta nell'area dove si desidera avere più spazio Fare doppio clic sullo spaziatore e trascinare
la "maniglia" con il mouse per modificare le dimensioni del distanziatore.

Per aumentare lo spazio tra i pentagrammi in tutta la partitura utilizzare le impostazioni dello Stile Generale. I distanziatori
servono per le modifiche in punti specifici.

Aggiungere interruzioni e spaziatori

1. Utilizzare la tavolozza Interruzioni e Spaziatori (vedi sopra)
2. Trascinare lo spaziatore da utilizzare.
3. Rilasciarlo nella battuta da modificare.

Eliminare interruzioni e spaziatori

In alcune occasioni è necessario eliminare interruzioni e spaziatori. Per eliminare interruzioni e spaziatori:

1. Un clic sul simbolo (diventa blu per indicare la selezione).
2. Premere il tasto Canc (Mac: Fn+Delete)

Interruzioni di sezione

L'interruzione di sezione può essere utilizzata per esempio per separare i movimenti in un concerto.
Può essere utilizzato sia con la riga che con la pagina. Ripristina anche il numero di battuta a 1. Così, come nella prima
battuta della partitura, nessun numero appare sulla prima battuta dopo l'interruzione se configurato in questo modo (vedi
Proprietà delle battute).

Se si cambia Unità di Tempo o Armatura di chiave all'inizio della nuova sezione, non ci sarà l'indicazione 'di cortesia' al
termine dell'ultima battuta precedente. Vedere l'esempio seguente :

Vedi anche
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Aggiungi/rimuovi interruzioni di riga

Cornici

L Cornici forniscono lo spazio vuoto al di fuori delle normali battute. Possono anche contenere testo o immagini.
MuseScore utilizza tre tipi di cornici: Orizzontale, Verticale e Testo:

Cornice orizzontale

Le cornici orizzontali sono usate per creare un'interruzione in un sistema. La larghezza della cornice inserita è regolabile,
l'altezza è uguale all'altezza del sistema. (Notare che la 'larghezza negativa' delle cornici orizzontali - creata trascinando la
maniglia oltre il confine a sinistra della cornice - non è attualmente riselezionabile) Il loro utilizzo include:

La creazione di una coda, con una distanza regolabile, separa dal resto della partitura (come nella figura
precedente).
Creazione di una compensazione all'inizio dello spartito, dove non ci sia il nome del pentagramma, per svolgere la
stessa funzione.
Creazione di un margine destro registrabile al termine della partitura.
Creazione di spazio per un testo o un'immagine.
Creazione di uno spazio tra un 'incipit storico' e l'inizio dell'edizione moderna.

Per aggiungere uno o più oggetti di testo o immagini alla cornice fare clic destro su di essa e selezionare Aggiungi → Testo o
Aggiungi → Immagine.

Una cornice orizzontale può essere inserita anche in una Cornice verticale o Cornice di testo facendo clic destro sulla
cornice e selezionando Aggiungi → Inserisci cornice orizzontale . Essa è allineata a sinistra automaticamente e riempie l'intera
cornice verticale. Fare doppio clic sulla cornice permette di regolarne la larghezza utilizzando la maniglia di modifica. Per
allineare a destra, trascinarla attraverso la cornice verticale usando il mouse, dopo averla reso prima più piccola. Un
singolo clic sulla cornice consente di modificarne i diversi parametri in Ispettore:

Spazio vuoto a sinistra: ?
Spazio vuoto a destra: ?
Larghezza: Regola la larghezza cornice.

Cornice verticale

Le cornici verticali creano spazi vuoti, prima o dopo i sistemi. Esse possono contenere uno o più oggetti di testo e/o
immagini. L'altezza è regolabile e la larghezza pari alla larghezza del sistema.
Una cornice verticale viene creata automaticamente all'inizio della partitura - mostra titolo, sottotitolo, compositore, autore
dei testi, ecc. - quando si riempiono in campi delle informazione presenti nel Creazione guidata nuova partitura.
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Se la partitura non dispone di una cornice verticale all'inizio, ne viene creata una automaticamente quando si fa clic su
uno spazio vuoto e si selezionaTesto → Titolo/sottotitolo/compositore/paroliere.

La selezione di una cornice consente di regolarne i vari parametri nell'Ispettore:

Spazio vuoto superiore: Regola distanza tra cornice ed elemento superiore (i valori negativi non sono attualmente
supportati).
Spazio vuoto inferiore: Regola distanza tra cornice ed elemento inferiore (i valori negativi sono supportati).
Altezza: Regola l'altezza della cornice
Margine sinistro: Sposta a destra gli oggetti di testo allineati a sinistra
Margine destro: Sposta a sinistra gli oggetti di testo allineati a destra
Margine superiore: Sposta in basso gli oggetti di testo allineati in basso (vedi anche Stile → Generale... → Pagina).
Margine inferiore: Sposta in alto gli oggetti di testo allineati in basso (vedi anche Stile → Generale... → Pagina).

Un doppio clic sulla cornice verticale consente di modificarne l'altezza utilizzando la maniglia di modifica. Utile per
regolare lo spazio tra sistemi particolari.

Un clic destro sulla cornice porta in primo piano un menù che permette di creare un oggetto all'interno della cornice:
questo può essere il testo (Titolo/sottotitolo/compositore/paroliere e nome della Parte), un' immagine o una cornice
orizzontale. È possibile creare il numero di gli oggetti deiderati all'interno di una cornice. Ogni oggetto può essere spostato
e impostato indipendentemente dagli altri. Gli oggetti di testo possono essere posizionati all'interno o all'esterno dei confini
dela cornice.

Ogni oggetto di testo creato all'interno della cornice può essere spostato con un clic del tasto sinistro e trascinando
(utilizzare i tasti Ctrl o Maiusc per vincolare il movimento in orizzontale o verticale). È inoltre possibile fare clic sull'oggetto di
testo e apportare modifiche a colore, visibilità, spiazzamento orizzontale e verticale nell'Ispettore. Cliccando col tasto
destro su un oggetto di testo si apre un menù che consente di applicare uno stile unico per il testo ( "Proprietà del testo") o
di modificare lo stile generale per quella classe di oggetti ("Stile testo").

Cornice di testo

Una cornice di testo appare come una cornice verticale - e condivide alcune delle sue caratteristiche - ma è
specificamente progettata per consentire all'utente di inserire il testo rapidamente e facilmente: non appena la cornice è
stata creata l'utente può iniziare a digitare. A differenza della cornice verticale, è consentito un solo oggetto di testo per
cornice, l'altezza si adatta automaticamente al contenuto e non c'è la maniglia di regolazione dell'altezza. La selezione
della cornice (non dell'oggetto di testo) consente di modificare vari parametri in Ispettore:

Spazio vuoto superiore: Regola distanza tra cornice ed elemento superiore (i valori negativi non sono attualmente
supportati).
Spazio vuoto inferiore: Regola distanza tra cornice ed elemento inferiore (i valori negativi sono supportati).
Altezza: Non è applicabile alle cornici di testo.
Margine sinistro: Sposta a destra gli oggetti di testo allineati a sinistra
Margine destro: Sposta a sinistra gli oggetti di testo allineati a destra
Margine superiore: Sposta in basso gli oggetti di testo allineati in alto
Margine inferiore: Sposta in alto gli oggetti di testo allineati in basso

È inoltre possibile fare clic sull'oggetto di testo e apportare modifiche al colore, la visibilità, offset orizzontale e verticale
nellì Ispettore

Creare una cornice

Le cornici possono essere inserite o aggiunte dal menù Aggiungi.

Per inserire una cornice, selezionare una battuta e scegliere dal menù Aggiungi → Cornice. La cornice viene inserita prima
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della battuta selezionata. Per aggiunger una cornice alla fine della partitura non è necessario selezionare una battuta.
Scegliere la cornice da aggiungere dal menù Aggiungi → Cornice.

Cancellare una cornice

Selezionare la cornice e premere Canc.

Vedi anche

Come aggiungere un blocco di testo negli spartiti
Stile del testo—inserisce una cornice visibile (bordo) intorno al testo

Collegamenti esterni

Page Formatting in MuseScore 1.1 - 1. Frames, Text & Line Breaks  [video]

Immagini

È possibile utilizzare Immagini per illustrare spartiti, o aggiungere i simboli che non sono inclusi nelle tavolozze standard.

Per aggiungere un'immagine, trascinare e rilasciare un file di immagine in una cornice o su una nota o altro punto della
partitura. Per modificare le dimensioni dell'immagine, selezionarla e usare Ispettore o fare doppio clic ed utilizzare le
maniglie.
In alternativa, fare clic destro in una cornice, scegliete Aggiungi → Immagine quindi scegliere un'immagine da una cartella di
file.

MuseScore supporta i seguenti formati di immagine:

PNG (*.png)
file JPEG (*.jpg and *.jpeg)
file SVG (*.svg) (MuseScore attualmente non supporta ombreggiatura, sfocatura, ritaglio o mascheratura SVG.)

Vedi anche

Acquisizione immagini
Creare un Ossia con la modalità acquisizione immagine

Acquisizione immagini

Cattura immagine consente di creare frammenti di immagini di spartiti. Può essere attivata con il pulsante attiva/disattiva

acquisizione immagine .

Nella modalità di acquisizione di immagini, un rettangolo di selezione può essere generato con Maiusc + trascinamento del
mouse.

Il rettangolo di selezione può essere spostato con il mouse, o ridimensionato spostando una delle otto maniglie.

Dopo aver specificato il rettangolo di selezione del frammento immagine che si vuole generare, fare clic destro nel
rettangolo per aprie la finestra del menu contestuale:
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Il salvataggio nel formato PNG genera questo file:

Se si salva il frammento in "modalità di stampa", apparirà come un ritaglio della partitura come sarebbe stampata. In
"Modalità di cattura dell'immagine", l'immagine sarà simile alla partitura sul vostro schermo (incluse interruzioni di linea,
marcatori, pause, ecc.) che non vengono stampati (esempio a 100dpi ):

Vedi anche

Immagini
Creare un Ossia con la modalità acquisizione immagine

Allineare gli elementi

Quando si seleziona e si trascina un elemento

Premere Ctrl per vincolare il movimento solo orizzontalmente.
Premere Maiusc per vincolare il movimento solo verticalmente.

Attivare Aggancia alla griglia

A destra delle finestre per lo spiazzamento, nell'Ispettore ci sono due pulsanti aggancia alla griglia:

Quando Aggancia alla griglia è attivato, è possibile trascinare l'elemento con incrementi di 0,5 sp. unità, e la posizione
quando si trascina sarà sempre all'unità di spazio 0,5 sp. più vicina.

Argomenti avanzati
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Accessibilità

MuseScore è dotato di supporto per il lettore dello schermo libero e open source NVDA screen reader  per Windows. Al
momento non c'è supporto per gli altri lettori come Jaws  per Windows, o VoiceOver  per macOS.

Introduzione

Questo documento è scritto per gli utenti non vedenti e ipovedenti di MuseScore 2.0.1 Non è destinato a fornire una
descrizione completa di tutte le caratteristiche di MuseScore; vi consigliamo di leggere congiuntamente la normale
documentazione di MuseScore. Comunque data il continuo sviluppo di MuseScore 2.0.1 la documentazione non è ancora
completa.

Questo documento si applica a qualsiasi nightly build recente (dal 1 novembre 2014). Le funzioni di accessibilità sono
state introdotte con la versione Beta 1 dell'agosto 2014, ma ci sono stati un gran numero di correzioni e miglioramenti da
allora, sia in materia di accessibilità che di funzionalità di base. Le funzioni in questo documento sono state testate su
Windows con NVDA. Altri lettori di schermo e altri sistemi operativi possono funzionare in modo diverso, o non funzionare.

In questo momento MuseScore 2.0.1 è in gran parte accessibile come lettore di partiture, non altrettanto per la
composizione delle partiture. Quindi questo documento è focalizzato sulle caratteristiche di lettura della partitura e
accenna solamente alla compilazione.

Configurazione iniziale

Quando si esegue MuseScore per la prima volta, si consiglia di disabilitare in modo permanente la Finestra di Avvio. Per
prima cosa chiudere la finestra di avvio, pio dal menù Modifica (Alt+E), selezionare Preferenze e deselezionare la casella
Mostra finestra di avvio. Premere applica e OK e chiudere la finestra preferenze

Trovare il vostro percorso

L'interfaccia utente di MuseScore funziona come altri programmi di notazione, o altri programmi di testo in genere. Ha una
sola finestra principale del documento in cui lavorare su una partitura. All'interno di questa finestra MuseScore supporta le
schede multiple. Supporta anche una visione a schermo diviso per permettervi di lavorare con due documenti alla volta, e
si possono avere più schede in ogni finestra.
Oltre alla finestra della partitura MuseScore ha una barra dei menù da cui è possibile accedere, tramite scorciatoie, ai
sottomenù:

File: Alt+F

Modifica: Alt+E

Visualizza: Alt+V

Aggiungi: Alt+A

Note: Alt+N

Impaginazione: Alt+L

Stile: Alt+S

Plugin: Alt+P

Aiuto: Alt+H

Tra questi e il menù File quello di maggior interesse quando si usa MuseScore come lettore di partiture. Una volta che si
apre un menù, possono essere necessarie diverse pressioni dei tasti Su o Giù prima che tutto sia letto correttamente.

Ci sono anche una serie di barre degli strumenti, tavolozze e sottofinestre all'interno MuseScore, ed è possibile scorrere
ciclicamente i relativi controlli utilizzando Tab (o Maiusc+Tab per spostarsi all'indietro attraverso questo stesso ciclo). Al
primo avvio di MuseScore, o all'apertura di una partitura, l'attenzione dovrebbe essere focalizzata sulla finestra della
partitura. La pressione di Tab vi porta a una barra degli strumenti che contiene una serie di pulsanti per le operazioni
come Nuovo, Apri, Riproduci e così via. Tab ometterà i pulsanti che non sono attualmente attivi. I nomi e le scorciatoie (se
applicabili) per questi pulsanti devono essere letti da screen reader.

Dopo aver esplorato i pulsanti della barra degli strumenti la successiva finestra che Tab illustrerà è Tavolozza. Questa è
utilizzata per aggiungere vari elementi alla partitura, ma attualmente non è accessibile che per due pulsanti visitati con
Tab: un menu a discesa per scegliere tra le diverse aree di lavoro (un set di tavolozze salvato), e un pulsante per creare
un nuova area di lavoro.

Se avete aperto una delle finestre opzionali, come l'Ispettore, o il filtro di selezione, il tasto Tab esplorerà anche questi. È
possibile chiudere le finestre non necessarie dal menù Visualizza assicurandosi che siano deselezionate tutte le caselle di
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controllo del primo gruppo (quelle prima delle impostazioni dello zoom). Per impostazione predefinita solo la tavolozza
Navigatore deve essere selezionata e non è inclusa nell'elenco del tabulatore.
Per ritornare alla finestra della partitura, dopo aver esplorato la barra degli strumenti, o una sottofinestra, premere Esc.
Questo elimina anche qualsiasi selezione potreste aver fatto nella finestra della partitura.

Finestra della partitura.

Al primo avvio MuseScore 2.0.1 viene caricato di default un esempio "My First Score". Se volete sperimentare le
funzionalità di modifica questo è un buon punto di partenza. In caso contrario, si può iniziare caricando un brano.
MuseScore utilizza i tasti di scelta rapida standard per accedere ai comandi di sistema come Ctrl+O (Mac: Cmd+O) per
aprire un file, Ctrl+S (Mac: Cmd+S) per salvare, Ctrl+W (Mac: Cmd+W) per chiudere, ecc.

Se premete Ctrl+O (Mac: Cmd+O) per caricare una partitura, viene visualizzata con una finestra di dialogo standard
(attualmente fornita da Qt). MuseScore è in grado di aprire partiture nel proprio formato (MSCZ o MSCX) come di
importare quelli nel formato standard MusicXML, in formato MIDI, o quelli di alcuni programmi come Guitar Pro, Capella,
e Band-in-a-Box. Una volta caricato un brano esso viene visualizzato in una nuova scheda all'interno della finestra
principale. È possibile spostarsi tra le schede nella finestra utilizzando Ctrl+Tab (non si applica a Mac).

Ci sono un paio di cose interessanti che si possono fare con una partitura caricata, oltre la lettura nota per nota. È
possibile premere la barra spaziatrice perchè MuseScore riproduca la partitura. È possibile utilizzare File/Esporta per
convertire in altri formati, tra cui PDF, PNG, WAV, MP3, MIDI, MusicXML, ecc. E, naturalmente, è possibile stampare
tramite File/Stampa o Ctrl+P (Mac: Cmd+P).

Se un partitura contiene molteplici strumenti, potrebbe aver già generato le parti collegate. Le parti collegate vengono
presentate come schede all'interno della finestra della partitura, ma attualmente, non c'è modo di navigare tra queste
schede di parte utilizzando la tastiera. Le parti normalmente non contengono informazioni diverse dalla partitura;
potrebbero solo essere visualizzate in modo diverso (ogni parte sulla propria pagina). Se la partitura non ha già generato
parti, è possibile farlo attraverso File/Parti..., dalla finestra di dialogo accessibile. Se si desidera stampare le parti, è
possibile aggirare l'impossibilità di accedere alle relative schede individualmente utilizzando la finestra di dialogo Esporta
parti... che esporta automaticamente tutte le parti in PDF (o altri formati) in un solo passaggio.

Lettura partitura

Quando si carica un partitura, la finestra partitura è attiva, ma non ci sarà nulla di selezionato. Il primo passo per la lettura
di un punteggio è selezionare qualcosa, e il punto più naturale da cui partire è il primo elemento del punteggio. Ctrl+Home

(Mac: Cmd+Home) lo individuerà. Potreste aver bisogno di utilizzare questo comando qualora aveste cancellato la selezione
premendo Esc.

Mentre si naviga tra gli elementi, il lettore dello schermo dovrebbe dare il nome dell'elemento selezionato (molto
probabilmente la chiave all'inizio del pentagramma superiore della partitura). Si sentiranno leggere il nome dell'elemento
(ad esempio, "chiave di violino") e anche le informazioni di posizione (per esempio, "Misura 1; Battito 1; Pentagramma 1").
La quantità di informazioni lette non è attualmente personalizzabile, ma abbiamo cercato di mettere il più importante al
primo posto in modo da poter passare rapidamente all'elemento successivo prima di aver terminato la lettura, o
semplicemente ignorare il resto di ciò che viene letto. Premere Maiusc attualmente interrompe la lettura (potrebbe essere
utile).

La maggior parte della navigazione in MuseScore è incentrata solo su note e pause - si omettono chiavi, tonalità, unità di
tempo, stanghette, e altri elementi. Quindi, se si utilizzano i tasti standardDestra e Sinistra per spostarsi attraverso la
partitura si sentiranno solo nomi di note e pause (e gli elementi ad esse collegati). Tuttavia, ci sono due comandi di
navigazione speciale che troverete utili per ottenere un riepilogo più completo della partitura:

Elemento successivo: Ctrl+Alt+Maiusc+Destra (Mac: Cmd+Opzioni+Maiusc+Destra)
Elemento precedente: Ctrl+Alt+Maiusc+Sinistra (Mac: Cmd+Opzione+Maiusc+Sinistra

Questi comandi includono chiavi e altri elementi che gli altri comandi di navigazione saltano, e si spostano attraverso tutte
le voci all'interno del pentagramma attuale, mentre altri comandi di navigazione, come Destra and Sinistra navigano solo
attraverso la voce attualmente selezionata finché non si modificano in modo esplicito le voci. Per esempio, se siete su una
semiminima sul battito 1 della battuta 1, e ci sono due voci nella battuta, premendo il pulsante destro si passa alla nota
successiva della voce 1 che sarà sul battito 2 mentre premendoCtrl+Alt+Maiusc+Destra (Mac: Cmd+Opzione+Maiusc+Destra) si
rimarrà sul battito 1, ma si passerà alla nota della voce 2. Solo dopo essersi spostati attraverso tutte le note del battito e
del pentagramma corrente, con la scorciatoia si passa alla battuta successiva. L'idea è che questo sia essere utile per la
navigazione nella partitura, se non se ne conosce già il contenuto.

Quando si accede a un elemento il lettore di schermo dovrebbe leggere le informazioni su di esso. Per le note e le pause,
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leggerà anche le informazioni sugli elementi ad esse connessi, come testi, articolazioni, simboli degli accordi, ecc. Per il
momento, non vi è alcun modo per accedere direttamente a questi elementi.
Una nota importante: Su e Giù da sole o associate a Maiusc, o a Ctrl / Cmd non sono scorciatoie utili per la navigazione!
Viceversa cambiano l'intonazione della nota o delle note attualmente selezionate. Fate attenzione a non modificare
inavvertitamente una partitura che si sta tentando di leggere. Su e Giù devono essere utilizzati con Alt/Opzione se il vostro
intento è solo spostarsi. Vedere l'elenco dei tasti di scelta rapida per la navigazione sotto.

Spostamento in avanti o indietro nel tempo

Le seguenti scorciatoie sono utili per lo spostamento "orizzontale" attraverso una partitura

Elemento successivo: Ctrl+Alt+Maiusc+Destra

Elemento presedente: Ctrl+Alt+Maiusc+Sinistra

Accordo o pausa successiva: Destra

Accordo o pausa precedente: Sinistra

Battuta successiva: Ctrl+Destra

Battuta precedente: Ctrl+Sinistra

Vai alla battuta: Ctrl+F

Primo elemento: Ctrl+Home

Ultimo elemento: Ctrl+End

Spostamento tra le note di un battito

Le seguenti scorciatoie sono utili per lo spostamento "verticale" attraverso una partitura

Elemento successivo: Ctrl+Alt+Maiusc+Destra

Elemento presedente: Ctrl+Alt+Maiusc+Sinistra

Successiva nota più alta della Voce, Voce precedente, o pentagramma superiore: Alt+Su

Successiva nota più bassa della Voce, Voce precedente, o pentagramma inferiore:: Alt+Giù

Nota superiore dell'accordo: Ctrl+Alt+Su

Nota inferiore dell'accordo: Ctrl+Alt+Giù

I comandi Alt+Su e Alt+Giù sono simili ai comandi Ctrl+Alt+Maiusc+Destra and Ctrl+Alt+Maiusc+Sinistra in quanto sono progettati per
aiutare a scoprire il contenuto di una partitura. Non hai bisogno di sapere quante note ci sono in un accordo, quante voci
sono in un pentagramma o quanti sistemi ci sono in una partitura per spostarti verticalmente attraverso la partitura
utilizzando questi comandi.

Filtro lettura partitura

Escludere alcuni elementi come testi, o nomi degli accordi durante la lettura della partitura è possibile utilizzando il filtro di
selezione (F6). Deselezionare gli elementi che non si desidera leggere.

Riproduzione partitura

La barra spaziatrice serve sia per avviare che per interrompere la riproduzione. La riproduzione inizia con la nota
attualmente selezionata, se se ne è selezionata una; dal punto in cui la riproduzione è stata interrotta la volta precedente.
O all'inizio della partitura alla prima riproduzione.

MuseScore supporta la riproduzione ciclica in modo da poter ripetere una sezione di un pezzo per fare pratica. Per
impostare i punti di "inizio" e "fine" ciclo per la riproduzione tramite il pannello Controlli di riproduzione (F11):

1. Selezionare la nota da cui il ciclo deve iniziare
2. Nel pannello Controlli di riproduzione premere il pulsante Riproduzione ciclica
3. Dalla finestra della partitura selezionare la nota su cui la riproduzione deve terminare
4. Passare nuovamente al pannello Controlli di riproduzione premere il pulsante "fine ciclo"
5. Per attivare o disattivare la riproduzione ciclica premere il pulsante "Riproduzione ciclica"

È inoltre possibile controllare la riproduzioneciclica e controllare altri parametri di riproduzione, come ad esempio
modificare tempo di base di un partitura, utilizzando il pannello di visualizzazione (F11)/ Controlli riproduzione.

Modifica partitura

Attualmente la modifica delle partiture non è molto accessibile - troppi elementi richiedono l'intervento del mouse in modo
da inserire gli oggetti su un partitura. Inoltre è a volte necessario un riferimento visivo, e la regolazione manuale della
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posizione dei vari elementi, a causa del limitato supporto di MuseScore nell'evitare conflitti di elementi.

Per contro MuseScore fornisce un default ampio e una piattaforma per sperimentare con le basi dell'inserimento note.
Per attivare la modalità inserimento note in primo luogo posizionarsi sulla battuta in cui si desidera inserire le note, quindi
premere il tasto "N". Quasi tutto ciò che riguarda l'inserimento note è progettato per essere accessibile dalla tastiera e la
documentazione standard dovrebbe essere valida per aiutare l'utente attraverso la procedura. Tenete a mente che
MuseScore può essere sia in modalità inserimento note che in modalità normale, e non sarà sempre chiaro in quale
modalità ci si trova. In caso di dubbio, premere Esc. Se si è in modalità inserimento note questo la sospenderà. Se si è in
modalità normale si rimarrà in questa condizione anche se si perderà la selezione.

Personalizzazione

È possibile personalizzare le scorciatoie da tastiera utilizzando Modifica/Preferenze/Scorciatoie. In alcuni punt, si possono
impostare una serie di speciali tasti di scelta rapida ottimizzati per l'accessibilità e/o la possibilità di salvare e caricare
gruppi di definizioni di scorciatoie.

Album

Gestione album permette di preparare una lista di partiture. La lista può quindi essere salvata come file album ("*
.album").

Stampare Album

Le partiture vengono stampate nell'ordine selezionato con i numeri di pagina corretti,
sovrascrivendo i valori di offset dei numeri di pagina in Impaginazione → Impostazioni pagina.... L'album viene stampato in un
unico processo di stampa, così anche la stampa fronte-retro (stampa duplex) funzionerà come ci si aspetta.

Unire partiture

Le partiture sono unite nell'ordine selezionato in un unico spartito.
Se non già presenti linee- e interruzioni di sezione vengono aggiunte all'ultima battuta o cornice di ciascuna partitura.
È necessario che tutte la partiture abbiano lo stesso numero di parti e pentagrammi, o inferiori alla prima partitura.
Qualsiasi parte, o pentagramma che non si trova nella prima partitura andrà perduto nello spartito complessivo.
Questo dovrebbe presentare gli stessi strumenti nello stesso ordine, in caso contrario, quelli della prima partitura
sovrascriveranno quelli delle successive.

Attrezzi

Sono stati sviluppati alcuni strumenti. Si trovano in Modifica → Attrezzi

Aggiungi/rimuovi interruzioni di riga

Questo strumento aggiunge o elimina automaticamente le interruzioni di linea :

Aggiungi interruzioni di linea
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ogni X battute
esplicitamente alla fine di ogni sistema corrente

Rimuovi
tutte le correnti interruzioni di riga

Questo comando opera su una selezione di battute, o, di default, sull'intera partitura.

C'è l'opzione per applicarlo ad una selezione di battute

Modifica → Attrezzi → Aggiungi/rimuovi interruzioni di riga

Premere OK.

Esplodi/Implodi

Questi comandi consentono di esplodere il contenuto di un pentagramma che contiene una serie di accordi in singole
linee melodiche sul successivo pentagramma, o ad implodere pentagrammi contenenti singole linee melodiche in una
serie di accordi su un singolo rigo.

Esplodi

Selezionare un intervallo su un pentagramma di origine contenente accordi con più note, eseguire Modifica → Attrezzi →

Esplodi. Gli accordi saranno "esplosi" sul pentagramma di destinazione in basso (una nota per pentagramma). Se si parte
selezionando l'intervallo su un singolo pentagramma MuseScore userà tanti pentagrammi di destinazione quanti sono
necessari - se l'accordo più grande ha quattro note, utilizzerà quattro pentagrammi. Tuttavia, se si avvia selezionando
l'intervallo su più pentagrammi MuseScore si limiterà all'ultimo pentagramma selezionato.

Implodi

Selezionare un intervallo di battute su più pentagrammi che hanno ritmi sostanzialmente simili, eseguire Modifica → Attrezzi

→ Implodi. MuseScore combinerà il contenuto dei pentagrammi in accordi sul rigo superiore - l'opposto di esplodere. C'è un
caso speciale, se si seleziona un solo pentagramma - MuseScore farà essenzialmente la stessa cosa, ma unirà il
contenuto di multiple voci di quel pentagramma in accordi nella voce 1.

Riempire con slash

Questo comando riempie la selezione con slash, una per ogni battito. Le barre saranno centrate sulla linea centrale del
personale e sono impostate per non trasporre o riprodurre il suono.
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Commutare a notazione a slash ritmica

Questo comando converte le note selezionate in notazione slash ritmica: le note hanno le teste a barra e sono impostate
per non trasporre o riprodurre il suono. Per le note delle voci uno o due, le note sono ancorate al rigo centrale.

Per le note delle voci tre o quattro, le note sono ancorate al di sopra o al di sotto del pentagramma e sono rappresentate
piccole (detta anche notazione "accentata"). Potrebbe essere utile utilizzare il filtro selezione per escludere le voci uno e
due dalla selezione, prima di eseguire questo comando, in modo che solo le note delle voci tre e quattro siano interessate.

Risequenziare marcatori di riferimento

Questo comando risequenzia i marcatori di riferimento nell'intervallo selezionato

1. Aggiungere un marcatore di riferimento
2. Selezionare un intervallo
3. Modifica → Attrezzi → Risequenzia marcatori di riferimento

MuseScore rileva automaticamente la sequenza in base al primo marcatore di riferimento nella selezione - tutti i marcatori
di riferimento nella selezione vengono modificati di conseguenza.

La sequenza può essere:

a, b, c,
A, B, C,
semplice sequenza numerica - 1, 2, 3,
numericamente corrispondente ai numeri delle battute

Vedi anche

Marcatori di riferimento
Plugins

Basso continuo

Aggiungere una nuova indicazione di basso continuo
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1. Selezionare la nota a cui applicare il basso continuo
2. Premere la scorciatoia Basso continuo (di default Ctrl+G; può essere modificata da Preferenze)
3. Inserire il testo nella 'casella blu' dell'editore di testo (vedi sotto)
4. Premere Spazio per spostarsi alla nota successiva per inserire un'altra indicazione di basso continuo (o fare clic al di

fuori dell'editore di testo per chiuderlo)

Con Spazio l'editore avanza alla nota, o pausa, successiva del pentagramma al quale è stato aggiunto il basso continuo.
Per passare a un punto intermedio, o estendere un gruppo di basso continuo a una durata più lunga, vedi sotto Durata
gruppo.

Tab sposta la casella di modifica all'inizio della misura successiva.

Maiusc+Spazio sposta la casella di modifica alla nota, o pausa, precedente nel pentagramma.

Maiusc+Tab sposta la casella di modifica all'inizio della battuta precedente.

Formato testo

Numeri

I numeri vengono immessi direttamente. Gruppi di più numeri sovrapposti in una stessa posizione si inseriscono
separandoli con Invio:

Alterazioni

Le alterazioni possono essere inserite con i normali tasti:

Per inserire: digitare:

doppio bemolle bb

bemolle b

naturale h

diesis #

doppio diesis ##

Questi caratteri si trasformeranno automaticamente nei segni corretti quando si lascia l'editor. Le alterazioni possono
essere inserite prima o dopo un numero (e, naturalmente, al posto di un numero, per terze alterate), secondo lo stile
richiesto; entrambi gli stili sono allineati correttamente, con l'accidentale 'agganciato' a sinistra o destra.

Forme combinate

Numeri tagliati o con una croce si inseriscono aggiungendo \, / o + dopo il numero (combinando i suffissi); la forma
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combinata corretta verrà applicata al momento di lasciare l'editor:

Il carattere integrato può gestire combinazioni equivalenti, privilegiando la sostituzione più comune:

1+, 2+, 3+, 4+ diventa  (o )

e 5\, 6\, 7\, 8\, 9\ diventa  (o )

Ricordare che / può essere combinato solo con 5; qualsiasi altra figura 'barrata' è resa con un punto interrogativo.

+ può anche essere usato prima di un numero; iin questo caso non è combinato, ma allineato correttamente ('+'
agganciato al lato sinistro).

Parentesi

Parentesi rotonde: '(', ')' e quadre: '[', ']', aperte e chiuse, possono essere inserite prima o dopo un'alterazione, un numero
o una linea di prosecuzione; le parentesi aggiunte non interferiranno con il corretto allineamento del carattere principale

Nota:

L'editore di testo non verifica che le parentesi, aperte e chiuse, rotonde o quadrate, siano correttamente equilibrate.
Diverse parentesi in fila non sono sintatticamente corrette ed impediscono la corretta ricognizione del testo inserito.
Una parentesi tra una cifra e un suffisso ('+', '\', '/') è accettato, ma esclude le forme combinate

Durata gruppo

La linea di durata gruppo si inserisce aggiungendo un '_' (sottolineato) alla fine della linea. Ogni numero di un gruppo può
avere una propria linea di continuazione:

Le righe di durata gruppo si estendono per tutta la durata del gruppo di basso continuo (ma attualmente non continuano
sul successivo sistema come per il melisma delle parole).

Durata gruppo 'esteso'

Occasionalmente, una riga di durata gruppo deve connettersi con quella di un gruppo successivo, quando un grado di
accordo deve essere tenuto tra due gruppi. Esempi (entrambi da J. Boismortier, Pièces de viole, op. 31, Paris 1730):

Nel primo caso, ciascun gruppo ha una propria linea di durata; nella seconda, la linea del primo gruppo confluisce 'nella'
seconda.
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Questo si ottiene inserendo diversi (due o più) trattini bassi "__" alla fine della linea di testo del primo gruppo.

Durata

Ogni gruppo di basso continuo ha una durata, che è indicata, sopra di questo, da una linea grigio chiaro (naturalmente,
questa linea è indicativa e non è stampato o esportata in PDF).

Inizialmente, un gruppo ha la stessa durata della nota alla quale è collegato. Una durata diversa può essere necessaria
per soddisfare diversi gruppi con una sola lettera o per estendere un gruppo su un arco di più note.

Per questo scopo si utilizzano le combinazioni di tasti sotto elencate; ognuna di loro

sposta la casella di testo per la durata indicata
E
imposta la durata del gruppo precedente fino alla nuova posizione della casella di testo.

Pressing several of them in sequence without entering any figured bass text repeatedly extends the previous group.

Digitare: per ottenere:

Ctrl+1 1/64

Ctrl+2 1/32

Ctrl+3 1/16

Ctrl+4 1/8 (croma)

Ctrl+5 1/4 (semiminima)

Ctrl+6 half note (minima)

Ctrl+7
whole note
(semibreve)

Ctrl+8 2 whole notes (breve)

(i numeri sono gli stessi utilizzati per impostare la durata delle note)

L'impostazione della durata esatta del gruppo basso continuo è obbligatoria solo in due casi:

1. Quando più gruppi sono sotto una nota di un unico pentagrammapersonale (non c'è altro modo).
2. Quando si utilizzano linee di durata gruppo poiché la lunghezza dipende dalla durata

Tuttavia è buona norma impostare sempre la durata al valore previsto per l'utilizzo di plugin e MusicXML.

Modifica basso continuo (già inserito)

Per modificare l'indicazione di basso continuo già inserita:

Selezionare il b.c., o la nota a cui appartiene, e premere la stessa scorciatoia per il basso continuo utilizzata per
creare uno nuovo
o
Evidenziarlo con un doppio clic

La consueta casella di testo si aprirà con il testo convertito in caratteri normali ('b', '#' e 'h' per alterazioni, combinazioni di
suffissi, sottolineature, ecc) pronto per una semplice modifica

Poi premere Spazio per spostarsi alla nota successiva, o fare clic fuori della casella di testo per uscirne, come per inserire
nuove indicazioni.

Stile

Il menù Stile → Generale... permette di configurare l'aspetto del basso continuo. Selezionare "Basso continuo" nella colonna
di sinistra della finestra di dialogo per visualizzare:
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L'elenco dei Font contiene tutti i caratteri configurati per il basso continuo. Una installazione standard contiene solo un set
di caratteri, "MuseScore Figured Bass", che è anche quallo preimpostato.

Dimensione è la grandezza del font (in punti). È collegata al valore di spazio: per spazio predefinito viene utilizzato il
valore immesso; per valori di spazio maggiori o minori viene utilizzato un carattereadeguato proporzionalmente.

Posizione verticale è la distanza (in spazi) dal margine alto del pentagramma alla linea di testo del basso continuo. I
valori negativi spostano in su (basso continuo sopra il rigo) i valori positivi in basso (basso continuo sotto il rigo: un valore
superiore a 4 è necessario per scavalcare il pentagramma).

Altezza linea è la distanza tra la linea di base di ogni basso continuo; è espressa in valore percentuale della dimensione
del font.
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L'immagine seguente visualizza ciascun parametro numerico:

Il pulsante Allineamento margine superiore/inferiore seleziona l'allineamento verticale: con Superiore a linea superiore di
ogni gruppo è allineata con la posizione verticale principale e il basso vi è 'ancorato' (è normalmente utilizzato per la
notazione del basso continuo ed è l'impostazione predefinita); con Inferiore, la linea inferiore è allineata con la posizione
verticale principale e il gruppo 'siede' su di essa (è talvolta usato in alcuni tipi di notazioni di analisi armonica):

Il pulsante Stile Moderno/Storico seleziona lo stile tipografico delle forme combinate. La differenza tra gli stili è mostrata
sotto:

Sintassi corretta

Perchè le sostituzioni rilevanti e le forme combinate siano applicate e correttamente allineate il meccanismo di basso
continuo prevede che i testi inseriti rispettino alcune regole (che sono, in ogni caso, le regole per la sintassi delle
indicazioni di basso continuo):

Ci può essere una sola alterazione (prima o dopo), o un solo suffisso combinato per figura;
Non ci possono essere un'alterazione e un suffisso combinato;
Può esserci un'alterazione senza numero (terza alterata) ma non un suffisso combinato senza un numero.
Qualsiasi altro carattere non elencato sopra non è previsto.

Se un testo immesso non segue queste regole, non sarà elaborato: sarà memorizzato e visualizzato così com'è, senza
alcuna configurazione.

Elenco tasti

Digitare: per ottenere:

Ctrl+G Aggiunge un nuovo gruppo di basso continuo alla nota selezionata.

Spazio Sposta la casella di modifica alla nota successiva.

Maiusc+Spazio Sposta la casella di modifica alla nota precedente.

Tab Sposta la casella di modifica alla battuta successiva.

Maiusc+Tab Sposta la casella di modifica alla battuta precedente.

Ctrl+1 Sposta la casella di modifica di 1/64, impostando la durata del gruppo precedente.

Ctrl+2 Sposta la casella di modifica di 1/32, impostando la durata del gruppo precedente.

Ctrl+3 Sposta la casella di modifica di 1/16, impostando la durata del gruppo precedente.

Ctrl+4 Sposta la casella di modifica di 1/8 (croma), impostando la durata del gruppo precedente.

Ctrl+5
Sposta la casella di modifica di 1/4 (semiminima), impostando la durata del gruppo
precedente.

Ctrl+6 Sposta la casella di modifica di una minima, impostando la durata del gruppo precedente.

Ctrl+7 Sposta la casella di modifica di una semibreve, impostando la durata del gruppo precedente.
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Ctrl+8 Sposta la casella di modifica di una breve, impostando la durata del gruppo precedente.

B B Inserisce un doppio bemolle

B Inserisce un bemolle

H Inserisce un naturale.

# Inserisce un diesis.

# # Inserisce un doppio diesis.

_ Inserisce una linea di durata.

_ _ Inserisce una linea di durata estesa.

Digitare: per ottenere:

Estrazione parti

Se avete scritto una partitura completa per musica d'insieme MuseScore può creare gli spartiti contenenti le parti per un
singolo strumento dell'ensemble.

Impostazione delle parti

È possibile definire le parti in qualsiasi momento dopo la creazione di una nuova partitura. È necessario solo definire le
parti una volta per ciascuna partitura ed è possibile apportare modifiche quando necessario. Le seguenti istruzioni
utilizzano un quartetto come esempio, ma gli stessi principi si applicano a qualsiasi altro ensemble.

1. Dal menù principale, scegliete File → Parti...

2. Nella finestra Parti un clic su Nuova per creare una "definizione parte"

3. Nel riquadro di destra, digitare le parole che si desidera utilizzare per il "Titolo della parte" (questo serve anche per il
nome del file della corrispondente parte durante l'esportazione)

4. Scegliere lo strumento che si desidera visualizzare nella vostra parte contrassegnando l'apposita casella nel
riquadro a destra. Generalmente si usa un solo strumento per parte ma a volte potreste avere bisogno di una parte
che comprenda più di uno strumento (come più righi per le percussioni). MuseScore consente di contrassegnare
quanti strumenti per parte si desidera
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5. Ripetere i passaggi da due a quattro (sopra) per ciascuna parte, se necessario

6. Una volta fatto, premere OK per chiudere la finestra Parti

Ora avete finito di impostare le parti. Non c'è bisogno di farlo di nuovo, a meno di aggiungere o rimuovere uno strumento
dalla partitura completa. Nella versione corrente di MuseScore, non è possibile dividere un singolo pentagramma (che
contiene due o più voci) in parti separate. Quindi per qualsiasi strumento si voglia stampare come parte separata è
necessario creare il relativo pentagramma nella partitura.

Impostazione di tutte le parti in una sola volta

Se avete una partitura orchestrale in cui ogni strumento deve essere estratto, è possibile creare le parti più facilmente:

1. Dal menù File → Parti...

2. Premere il pulsante Nuovo tutti (le parti sono denominate con il nome dello strumento e, se necessario, con l'aggiunta
di un "-<numero>")

3. Premere OK

Ora il vostro spartito verrà mostrato con una scheda per ogni parte.

Esportare le parti

1. Dal menù File → Esporta Parti...

2. Individuate la destinazione in cui esportarle e selezionate il formato del file (quello preimpostato è PDF)
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3. Per il nome del file inserite qualsiasi prefisso sia funzionale per tutte le parti, o lasciate il valore predefinito (il nome
del file della partitura)

4. Premere OK

Questo genererà il file con i nomi "<prefisso>" + "-" + "<nome parte>.<estensione>". Inoltre, durante l'esportazione in
formato PDF, questo genererà anche il file "<prefisso>" + "-Partitura_e_Parti.pdf".

Salvare

Parti e partitura sono "collegati", il che significa che qualsiasi modifica al contenuto di una influenzerà l'altra, ma le
modifiche all'impaginazione non lo faranno. Dopo aver creato le parti, esse verranno salvate con la partitura (se si apre lo
spartito avrete le schede per la partitura e ogni parte creata).

È possibile, tuttavia, salvare ogni parte individualmente, selezionando la linguetta e utilizzando File → Salva come...

Formato dei file

MuseScore supporta un'ampia varietà di formati di file, che permette di condividere e pubblicare i punteggi nel formato più
adatto alle vostre esigenze.
È possibile importare i file tramite File → Apri... ed esportare da File → Esporta....
Oltre ai formati descritti nel seguito, è possibile salvare e condividere i proprispartiti sul Web all'indirizzo
MuseScore.com  File → Salva Online.... Vedi Condividere le partiture online.

Formato nativo di MuseScore

Questi sono i formati utilizzati da File → Salva o dal pulsante  o dalle Scorciatoie tastiera (Ctrl+S) e dalla finestra di
dialogo File → Salva come....

Formato MuseScore (*.mscz)

MSCZ è il formato standard dei file MuseScore raccomandato per la maggior parte degli utilizzi.

Una partitura salvata in questo formato occupa pochissimo spazio su disco, ma mantiene tutte le informazioni necessarie.
Il formato è una versione compressa (ZIP) di file .mscx e include tutte le immagini.

Formato non compresso di MuseScore ( *.mscx)

MSCX è la versione non compressa del formato dei file MuseScore.

Una partitura salvata in questo formato conserverà tutte le informazioni, tranne le immagini. È consigliato per quando si
modifica manualmente il formato del file (usando un editor di testo).

Le precedenti versioni di MuseScore utilizzano l'estensione del file *.msc. Poichè questo formato è in conflitto con
un'estensione di file utilizzata da Microsoft Windows, e viene bloccato da alcuni provider di posta elettronica, è stato
sostituito dalla più recente estensione MSCX.

I formati MSCZ e MSCX di MuseScore 2.0 non possono essere letti da MuseScore 1.3 o precedenti, utilizzare allora
→XML o →MXL.

Nota sui font: MuseScore non incorpora i font di testo nel file, tranne che per i set di caratteri FreeSerif, FreeSerifBold,
FreeSerifItalic, FreeSerifBoldItalic e FreeSans. Per condividere un file MuseScore con terzi, scegliere questi font per il
testo, o un tipo di carattere che anche gli altri abbiano installato. Quando un sistema operativo non dispone dei caratteri
specificati nel file, MuseScore utilizzerà un ripiego - e, in questo caso, la partitura apparirà differente.

MuseScore file di backup

File di backup di MuseScore ( *.mscz, o *.mscx,)

I file di backup vengono creati automaticamente e salvati nella stessa cartella dei normali file MuseScore. Il file di backup
aggiunge un punto all'inizio del nome del file (.) e una virgola (,) alla fine (es. se il file normale è chiamato "senzatitolo.mscz",
la copia di backup sarà ".senzatitolo.mscz,").

La copia di backup contiene la versione precedentemente salvata del file MuseScore e può essere importante se la copia
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normale viene danneggiata, o per guardare una versione precedente della partitura.

Per aprire un file di backup MuseScore, il punto e la virgola devono essere rimossi dal nome. Poichè il file viene salvato
nella stessa cartella dei normali file MuseScore, Potrebbe anche essere necessario attribuire un nome univoco (ad
esempio, cambiando ".senzatitolo.mscz," in "senzatitolo-backup1.mscz").

Per visualizzare i file di backup di MuseScore, potrebbe essere necessario modificare le impostazioni del sistema a
"Mostra file nascosti". vedi anche Come recuperare una copia di backup di una partitura (MuseScore 2) .

Visualizzare e stampare (solo esportazione)

PDF (*.pdf)

Il formato PDF (Portable Document Format) è l'ideale per condividere una partitura con altri che non abbiano bisogno di
modificarne il contenuto. La maggior parte degli utenti ha un visualizzatore di PDF sul proprio computer quindi, per
visualizzarla, non è richieto software supplementare.

PNG (*.png)

PNG (Portable Network Graphics) è un formato di immagine bitmap ampiamente supportato dal software su Windows,
macOS e Linux.

Il formato immagine è particolarmente popolare sul web. . Spartiti di più pagine vengono esportati con un file PNG per
ogni pagina. genera le immagini come apparirebbero sulla pagina stampata. Nella scheda Modifica → Preferenze... (Mac:
MuseScore → Preferenze...) è possibile impostare la risoluzione e l'utilizzo dello sfondo trasparente.
Per creare immagini che mostrano solo alcune parti della partitura, con o senza elementi solo dello schermo come cornici,
note invisibili o fuori estensione, colori ecc. utilizzare Acquisizione immagini

SVG (*.svg)

I file SVG Scalable Vector Graphics  possono essere aperti dalla maggior parte dei browser web (ad eccezione delle
versioni precedenti alla 9 di Internet Explorer) e dalla maggior parte dei software di grafica vettoriale. Ma la maggior parte
dei software SVG non supportano i font incorporati, quindi i caratteri appropriati per MuseScore devono essere installati
per poter visualizzare questi file in modo corretto.

Ascoltare (solo esportazione)

WAV audio (*.wav)

WAV (Waveform Audio Format) è un formato audio non compresso.

Sviluppato da Microsoft e IBM è ampiamente supportato dal software per Windows, macOS e Linux. Si tratta di un
formato ideale da utilizzare per la creazione di CD perchè mantiene intatta la qualità del suono. Però i file di grandi
dimensioni rendono difficile la condivisione via e-mail o via web.

FLAC audio (*.flac)

FLAC Free Lossless Audio Codec  è un formato audio compresso.

I file FLAC richiedono circa la metà delle dimensioni di un file audio non compresso e sono di altrettanto buona qualità.
Windows e macOS non sono dotati di supporto per FLAC, ma un software come VLC media player  può riprodurre i file
FLAC su qualsiasi sistema operativo.

Ogg Vorbis (*.ogg)

Ogg Vorbis  è inteso come un sostituto, libero da brevetto, per il popolare formato audio MP3.

Come per gli MP3 i file Ogg Vorbis sono relativamente piccoli (spesso un decimo di un file audio non compresso), ma un
po' della qualità del suono si perde. Windows e macOS non sono dotati di supporto per Ogg Vorbis. Ma, software come
VLC media player  and Firefox  può riprodurre i file Ogg su qualsiasi sistema operativo.

MP3 (*.mp3)

I file MP3 sono relativamente piccoli (spesso un decimo di un file audio non compresso), ma la qualità del suono è
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inferiore.

Per poter creare i file MP3, è necessario installare una libreria aggiuntiva: lame_enc.dll (Windows) o libmp3lame.dylib
(Mac). MuseScore chiederà la sua posizione. È disponibile su http://lame.buanzo.org/ .

Alcuni utenti Mac possono riscontrare che MuseScore rileva un errore durante il caricamento della libreria MP3. Il
problema potrebbe essere dovuto al fatto che quella è una libreria a 32 bit. Una build a 64-bit, che funzionerà con
MuseScore, è disponibile su http://www.thalictrum.com/en/products/lame.html  (nota: è necessario rinominare il file in
libmp3lame.dylib per consentire a MuseScore di riconoscerlo).

Condividere con altri software musicali

MusicXML (*.xml)

MusicXML  è lo standard universale per gli spartiti.

È il formato raccomandato per la condivisione di spartiti tra diversi programmi notazionali inclusi Sibelius, Finale, e più di
altri 100.

MusicXML compresso (*.mxl)

MusicXML compresso crea file più piccoli rispetto al formato MusicXML normale.

Questo è uno standard più recente e attualmente non è ancora ampiamente supportato da altri programmi notazionali.

MIDI (*.mid, *.midi, *.kar)

MIDI Musical Instrument Digital Interface  è un formato ampiamente supportato da sequencer e software di notazione
musicale.

I file MIDI sono progettati per scopi di riproduzione e non contengono informazioni sull'impaginazione della partitura, sulla
formattazione, ortografia delle altezze dei suoni, abbellimenti, articolazioni, ripetizioni, o tonalità ed altri elementi. Per
condividere i file tra i diversi software di notazione musicale si consiglia il formato MusicXML. Utilizzate i file MIDI se siete
interessati solo alla riproduzione, .

MuseData (*.md) (solo importazione)

MuseData  è un formato sviluppato da Walter B. Hewlett a partire dal 1983 come uno dei primi mezzi di condivisione tra
i software di notazione musicale .

Da allora è stato eclissato dal il formato MusicXML, ma sono ancora disponibili online diverse migliaia di partiture in
questo formato.

Capella (*.cap, *.capx) (solo importazione)

I file CAP e CAPX sono generati dal programma "Capella" .

MuseScore importa dalla versione 2000 (3.0) o successive in modo abbastanza preciso (2.x non funziona, mentre il
formato * .all non è supportato dalle versioni 1.x).

Bagpipe Music Writer ( *.bww) (solo importazione)

BWW sono generati dal software di nicchia "Bagpipe Music Writer" .

BB (*.mgu, *.sgu) (solo importazione)

I file BB sono generati dal software per arrangiamenti "Band-in-a-Box" .

Il supporto di MuseScore è sperimentale.

Overture (*.ove) (solo importazione)

I file OVE sono generati dal software "Overture" .

Questo formato è popolare soprattutto in ambienti di lingua cinese, come la Cina continentale, Hong Kong e Taiwan.
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Il supporto di MuseScore è sperimentale.

Guitar Pro (*.GTP, *.GP3, *.GP4, *.GP5, *.GPX) (solo importazione)

Vedi anche

Salva/Esporta/Stampa

Funzionalità Early music (musica antica)

MuseScore 2.0 offre numerose nuove funzioni per creare stampe di musica antica (in particolare medievali e
rinascimentali) affini alle edizioni commerciali del 20 ° secolo in poi.

Notazione senza divisione in battute

La maggior parte della musica rinascimentale non presentava la divisione in battute. Avere le note lunghe suddivise o
collegate da legature di valore al di sopra delle stanghette modifica significativamente l'aspetto della partitura. Riconoscere
le grandi linee melodiche e i motivi ripetuti potrebbe diventare più difficile. Così MuseScore fornisce un metodo di
visualizzazione, sperimentale, in cui i valori di nota rimangono intatti. Questo metodo può essere attivato barrando la
casella di controllo nella sezione Spartito della finestra di dialogo Stile che si apre da Stile → Generale...

Il pulsante Applica esegue la modifica immediatamente.

Notazione originale (De Profundis Clamavi per 4 voci di Nicolas Champion)

Prima delle modifiche di stile
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Dopo le modifiche di stile

Notare che la funzione è ancora in fase sperimentale e potrebbe contenere bug. Il valore della nota più lungo supportato è
la longa (una longa puntata è ancora divisa e presenta la legatura superiormente).
Per eliminare le stanghette è sufficiente deselezionare la casella "Mostra stanghette" nella finestra Proprietà del
pentagramma. Tuttavia, vi è un'altra opzione.

Mensurstrich

Dal momento che una completa mancanza di stanghette potrebbe rendere ai musicisti moderni più difficoltosa
l'esecuzione della musica molti editori hanno stabilito un compromesso chiamato Mensurstrich che prevede le stanghette
tra i pentagrammi e non attraverso i righi. Ora questo è possibile: un doppio clic su una stanghetta, trascinare l'estremità
inferiore alla parte superiore del pentagramma inferiore e l'estremità superiore alla parte inferiore del pentagramma
superiore. Eseguite questa operazione accuratamente (tenendo premuto Maiusc). Quindi deselezionare la stanghetta e le
modifiche saranno applicate a tutto il pentagramma.

Può essere più facile utilizzare l'ispettore per modificare manualmente i numeri. Per aprire l'Ispettore premere F8 e
selezionare una stanghetta. I valori corretti sono:

 Default Mensurstrich

Pentagrammi estesi 1 2

Estendi da 0 8

Estendi da 8 0

Potreste voler reimpostare le stanghette ai valori di default alla fine della partitura o di una sezione, ricordatevi di tenere
premuto Ctrl, o verrà ripristinato l'intero pentagramma.

Ambitus

Prima che si realizzasse l'idea di altezza assoluta agli esecutori era richiesto di trasportare, al volo, la musica vocale ad
una tonalità adatta al loro ensemble. Per aiutarli veniva a volte inserito all'inizio del pentagramma un ambitus per indicare
l'estensione dell'intervallo della voce. L'ambitus si trova nella tavolozza nella parte inferiore della sezione linee, trascinarlo
dalla tavolozza ad una chiave. Rileverà automaticamente l'intervallo.
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L'ambitus comprenderà tutte le battute fino alla successiva interruzione di sezione, oltre la quale può essere applicato un
nuovo ambitus. Può essere regolato manualmente o automaticamente con l'Ispettore. Selezionare prima l'ambitus da
modificare. Per le regolazioni manuali modificare i valori delle note superiore e inferiore. Per la regolazione automatica
fare clic sul pulsante Aggiorna intervallo nell'Ispettore.

Unità di Tempo Mensurale

Nel sistema di notazione mensurale le unità di tempo non definiscono la lunghezza di una battuta ma la lunghezza di
breve e semibreve. MuseScore supporta i simboli di tempo mensurali come metodo di visualizzazione nella finestra di
dialogo Proprietà dell'unità di tempo, proprio solo come simboli visualizzati. per esempio la proporzione tra minima e
semibreve non può essere modificata.
Un utilizzo di questi simboli è la riproduzione delle composizioni del Rinascimento, in cui sono presenti più voci con
diverse unità di tempo simultaneamente, senza l'utilizzo di gruppi irregolari. Modificare l'unità tempo in base al singolo
pentagramma fino a far coincidere l'inizio e la fine di una battuta in tutti i pentagrammi. Se questo risulta impossibile
prendere in considerazione la possibilità di aumentare le dimensioni delle battute in base al minimo comune
denominatore.

De Profundis Clamavi per 5 voci di Josquin Des Prez

Vedi anche

Azioni sulle battute: Dividere e unire

Gruppo di note tra pentagrammi

Negli spartiti per pianoforte è frequente l'utilizzo di tutti e due i pentagrammi (chiave di basso e chiave di violino) per
scrivere frasi musicali.

Questo effetto può essere ottenuto in MuseScore come segue:

Per prima cosa inserire tutte le note della frase in un pentagramma:

Ctrl+Maiusc+↓ spostano le note o accordi selezionati nel pentagramma sottostante.(Mac: ⌘+Maiusc+↓.)

Per posizionare le code: un doppio clic sull'elemento per entrare in Modalità di modifica. Trascinare la maniglia per
modificarne la posizione.

Vedi anche

Stanghette : come estenderle su più pentagrammi.
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Informazioni partitura

Diversi metadati vengono generati automaticamente alla creazione di una partitura, altri possono essere aggiunti in
seguito. Possono essere utilizzati nel piè di pagina/intestazione della partitura.

File → Info... mostra i valori dei meta tag esistenti (alcuni possono essere vuot).

Metadati preesistenti

Ogni partitura ha i seguenti metadati. Alcuni vengono riempiti automaticamente alla creazione della partitura, come i
seguenti dettagli dell'elenco:

Versione di MuseScore: La versione di MuseScore dell'ultimo salvataggio della partitura.
Revisione: La revisione di MuseScore dell'ultimo salvataggio della partitura.
Livello API: La versione del formato del file.
arrangiatore: (vuoto)
compositore: Come inserito nella procedura guidata di un nuovo spartito (è utilizzato anche per la casella di testo
'compositore' nella cornice superiore; ricordare che le modifiche successive dell'una non si riflettono nell'altra)
diritto d'autore: Come inserito nella procedura guidata. Le informazioni sul diritto d'autore appaiono come testo
apparentemente non modificabile in fondo ad ogni pagina di una partitura, ma può essere modificato o rimosso
variandolo qui.
Data creazione: Data di creazione partitura. Questo potrebbe essere vuoto, se il punteggio è stato salvato in
modalità test (vedi Opzioni da linea di comando).
paroliere: Come inserito nella procedura guidata (è utilizzato anche per la corrispondente casella di testo paroliere
nella cornice superiore; ricordare che le modifiche successive dell'una non si riflettono nell'altra))
Numero movimento: (vuoto)
Titolo movimento: (vuoto)
piattaforma: La piattaforma su cui la partitura è stata creata: "Microsoft Windows", "Apple Macintosh", "Linux" o
"Sconosciuto". Potrebbe essere vuoto, se il punteggio è stato salvato in modalità test
poeta: (vuoto)
fonte: (vuoto)
traduttore: (vuoto)
Numero opera: (vuoto)
Titolo opera: Come inserito nella procedura guidata (è utilizzato anche per la corrispondente casella di testo Titolo;
ricordare che le modifiche successive dell'una non si riflettono nell'altra).

Ogni parte ha i seguenti metadati, generati e parzialmente riempiti alla creazione una parte:

Versione di MuseScore: (vuoto per parti collegate, altrimenti come sopra per la partitura)
Revisione: (come sopra per la partitura)
Livello API: (come sopra per la partitura)
Nome parte: Nome della parte, come indicato alla creazione (è utilizzato anche per la casella di testo 'nome parte'
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nella cornice superiore; ricordare che le modifiche successive dell'una non si riflettono nell'altra).

I primi tre metadati dell'elenco qui sopra non possono essere utilizzati nell'intestazione o piè di pagina.

Modificare metadati

Per modificare un metadato di una partitura con parti collegate, assicurarsi che la scheda della partitura sia attivata. Per
modificare un metadato di una singola parte, assicurarsi che la scheda della parte sia attivata.
Utilizzare File → Info... e modificare il testo corrente, o compilare il campo vuoto, per uno qualsiasi dei dati elencati.

Aggiungere metadati

Per aggiungere un metadato ad una partitura con parti collegate, assicurarsi che la scheda della partitura sia attivata. Per
aggiungere un metadato ad una singola parte assicurarsi che la scheda della parte sia attivata.

Utilizzare File → Info... → Nuovo

Inserire il nome del metadato e fare clic su OK (o Annulla). Il metadato sarà aggiunto all'elenco dati. Sarà quindi possibile
compilare il contenuto del tag.

Intestazione/Piè di pagina

È possibile visualizzare il contenuto dei meta tag in un'intestazione o piè di pagina nella partitura. Per creare
un'intestazione o piè di pagina per una partitura con parti collegate, assicurarsi che la scheda della partitura sia attivata.
Per creare un'intestazione o piè di pagina per una singola parte la relativa scheda deve essere attiva.

Utilizzare Stile → Generale... per aprire la finestra Modifica stile e selezionare Intestazione, piè di pagina, numeri  nella sezione a
sinistra della finestra.

Se si passa con il mouse sopra la zona del testo dell'intestazione o piè di pagina, verrà visualizzato un elenco di macro,
che mostrano il loro significato, così come i metadati esistenti e il loro contenuto.
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È possibile utilizzare i tag con $:Nomedeldato:

nelle apposite caselle per creare intestazioni o piè di pagina.

Clic su Applica per vedere come l'intestazione o piè di pagina apparirà nella partitura. Clic su OK per assegnare
l'intestazione o piè di pagina alla partitura o alla parte attiva. Se la scheda di una parte è attivata è possibile fare clic su
Applica a tutte le parti se è quello che si desidera e poi OK per chiudere la finestra di dialogo. Annulla permette di uscire senza
applicare le modifiche.

Vedi anche

Impaginazione e formattazione: Intestazioni e piè di pagina
Opzioni da linea di comando: Modalità test

Modalità di inserimento note

Dalla versione 2.1, è possibile inserire la notazione usando uno di più delle nuove modalità inserimento note in aggiunte
ai preesistenti Un passo alla volta e Modifica altezze modi. Sono accessibili facendo clic sulla piccola freccia, elenco a
discesa, accanto al pulsante di inserimento note nella barra degli strumenti di inserimento note.

Un passo alla volta

Questo è il metodo di inserimento note che MuseScore ha avuto fin dall'inizio. Inserisci le note in modalità Un passo alla
volta scegliendo una durata usando il mouse o la tastiera e scegliendo un’altezza usando il mouse, la tastiera, la tastiera
MIDI o il piano virtuale.
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Per i dettagli vedere Nozioni di base .

Modifica altezze

La modalità Modifica altezze consente di modificare l’altezza delle note esistenti senza influenzare la loro durata (da non
confondere con Sostituzione enarmonica delle alterazioni).

Selezionare una nota come punto di partenza ;
Selezionare l’opzione Modifica altezze dal menù a discesa __Inserimento note __ (è possibile impostare una
scorciatoia da tastiera Preferenze, se desiderato);

Ora inserite le altezze utilizzando la tastiera, la tastiera MIDI o la tastiera tastiera pianoforte.

Nota: Nelle versioni precedenti la 2.1 di MuseScore, la modalità Repitch può essere attivata utilizzando la
scorciatoia preimpostata Ctrl+Maiusc+I (Mac: Maiusc+Cmd+I).

Potete utilizzare la funzione Modifica altezze per correggere le altezze di una sequenza di note che sono già della durata
corretta. Un'altra possibilità è quella di creare un nuovo passaggio da uno esistente, della stessa sequenza di durate -
copiando e incollando quest'ultimo, quindi applicando la funzione modifica altezze.

Ritmo

La modalità Ritmo consente di immettere durate con la pressione di un solo tasto. La combinazione di modalità Ritmo e
Modifica altezze consente di ottenere un metodo molto efficiente di inserimento nota.

1. Selezionare il punto di partenza nella partitura e attivare la modalità Ritmo.
2. Selezionare una durata dalla barra degli strumenti inserimento nota o premere una scorciatoia della durata (numeri

1-9) sulla tastiera del computer. Una nota verrà aggiunta alla partitura con la durata selezionata. A differenza di
Nozioni di base, premendo il tasto . alternerà in puntate o non puntate tutte le durate seguenti. Tutti i ritmi seguenti
saranno puntati fino a che il tasto . sarà premuto di nuovo. a differenza di Nozioni di base, dove il punto deve essere
premuto prima di inserire il ritmo.

3. L'immissione della pausa è simile a quella delle note puntate. Premere il tasto 0 per attivare/disattivare la modalità
inserimento. Tutti i ritmi inseriti saranno ripristinati fino al momento della successiva pressione del tasto 0. Questo
può essere usato in concomitanza con le note puntate.

4. Continuare a premere i tasti di durata per inserire note con le durate selezionate.
5. Ora usare Modifica altezze per impostare l’altezza delle note inserite.

Tempo reale (automatic)

Le modalità Tempo reale consente di eseguire il brano con una tastiera MIDI (o la tastiera pianoforte) ottenendo la
notazione aggiunta per te. Tuttavia, dovresti essere a conoscenza delle seguenti limitazioni attualmente applicabili:

Non è possibile utilizzare la tastiera del computer per l'inserimento in Tempo reale
Non è possibile inserire gruppi irregolari o note più brevi della durata selezionata
Non è possibile inserire note in più di una voce alla volta

Tuttavia, queste restrizioni significano che MuseScore non ha molto da indovinare quando esegue l'analisi del modo in cui
il tuo input deve essere notato, e questo aiuta a mantenere accurata la modalità Tempo reale.

Nella versione automatica di inserimento Tempo reale si suona a un tempo fisso indicato da un clic del metronomo . È
possibile regolare il tempo modificando il ritardo tra i clic da Modifica → Preferenze...→ Inserimento note (Mac: MuseScore →

Preferenze...→ Inserimento note).

1. Selezionare la posizione di partenza nella partitura e attivare la modalità Tempo reale (automatica).
2. Selezionare una durata dalla barra degli strumenti di inserimento note .
3. Premere e tenere premuto un tasto della tastiera MIDI o della tastiera pianoforte (una nota verrà aggiunta alla

partitura).
4. Ascoltare i clic del metronomo. Con ogni clic la nota cresce fino alla durata selezionata.
5. Rilasciare il tasto quando la nota ha raggiunto la durata desiderata.

La partitura smette di avanzare non appena si rilascia il tasto. Se si desidera che la partitura continui ad avanzare (ad
esempio per consentire di inserire le pause) è possibile utilizzare il comando Tempo reale Advance shortcut per avviare il
metronomo.
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Tempo reale (manual)

Nella versione manuale di inserimento Tempo reale è necessario indicare il tempo di inserimento premendo un tasto o un
pedale, ma è possibile suonare a qualsiasi velocità desiderata, e non deve essere costante. Il tasto predefinito per
impostare il tempo (detto "Tempo reale Avanzato") è Invio sul tastierino nuerico (Mac: fn+A capo, ma è consigliabile
cambiarlo con un tasto MIDI o nel pedale MIDI (vedi sotto).

1. Selezionare la posizione di partenza nella partitura e attivare la modalità Tempo reale (automatica).
2. Selezionare una durata dalla barra degli strumenti di inserimento note .
3. Premere e tenere premuto un tasto della tastiera MIDI o della tastiera pianoforte (una nota verrà aggiunta alla

partitura).
4. Premere il tasto Tempo reale Advance. Ad ogni pressione la nota cresce fino alla durata selezionata.
5. Rilasciare la nota quando ha raggiunto la durata desiderata.

Tempo reale Advance shortcut

La scorciatoia Tempo reale Advance è utilizzata per picchiettare i battiti nella modalità manuale in tempo reale o per
avviare i clic del metronomo in modalità automatica in tempo reale. Viene chiamato "Real-time Advance" perché sposta il
punto di inserimento in avanti o "avanza" nella partitura.

Il tasto predefinito per Tempo reale Advance è Ivio sul tastierino nuerico (Mac: fn+A capo, ma è consigliabile cambiarlo con
un tasto MIDI o nel pedale MIDI dai controlli remoti Midi di MuseScore. I controlli remoti Midi sono disponibili in
Preferenze > Inserimento note.

In alternativa, se si dispone di un pedale USB o un pedale del computer che può simulare i tasti della tastiera, è possibile
impostarlo per simulare l'immissione sul tastierino numerico.

Vedi anche

Note input
Copy and paste

Collegamenti esterni

Introduction to the new Repitch Mode  (YouTube)

Plugin

I plugin sono delle piccole parti di codice che aggiungono a MuseScore particolari caratteristiche. Se si installa un plugin
verrà aggiunta una nuova voce nel menù Plugin che permetterà eseguire una determinata azione nella partitura o in una
parte di essa. I plugins consentono agli utilizzatori, con un minimo di competenze come programmatori, di aggiungere
nuove funzionalità al programma.

Alcuni plugin sono già forniti con MuseScore, vedi →sotto . Potete trovare altri plugin nel repository dei plugin . Alcuni
plugin funzionano con MuseScore 2; altri funzionano solo con le versioni precedenti di MuseScore.

Installazione

Notare che alcuni plugin per poter lavorare possono richiedere l'installazione di altri componenti (come font, ecc.).
Leggere la documentazione del plugin per maggiori informazioni.

La maggior parte dei plugin è fornita come file zip: scaricare il file ed estrarlo in una delle cartelle elencate più avanti.
Alcuni possono essere forniti direttamente come file .qml, scaricarli e metterli in una di queste cartelle.

Windows

MuseScore cerca i plugin nella cartella %ProgramFiles%\MuseScore 2\Plugins (o %ProgramFiles(x86)%\MuseScore 2\Plugins per le
versioni a 64 bit) e in %LOCALAPPDATA%\MuseScore\MuseScore 2\plugins su Vista e Sette o C:\Documents and

Settings\USERNAME\Local Settings\Application Data\MuseScore\MuseScore 2\plugins (da adattare in base alla lingua del sistema) su
XP.

macOS
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Con macOS, MuseScore cerca i plugin nel bundle di MuseScore nella cartella /Applications/MuseScore

2.app/Contents/Resources/plugins e in ~/Library/Application Support/MuseScore/MuseScore 2/plugins. Per essere in grado di spostare i file
nel bundle app, fare clic con il tasto destro su MuseScore.app e selezionare "Show package contents" scoprire qual'è la
cartella Contents. Fare attenzione a utilizzare Contents/Resources/plugins e non Contents/plugins.

Linux

Con Linux MuseScore cerca i plugin nella cartella /usr/share/mscore-2.0/plugins e in ~/.local/share/data/MuseScore/MuseScore 2/plugins.

Abilitare/Disabilitare plugin

Per poter accedere ai plugin installati dal menu Plugin è necessario attivarli in Gestione Plugin...:

Creare/modificare/eseguire plugin

È possibile creare un nuovo plugin o modificarne uno esistente ed eseguirlo da Creatore Plugin...:

Qui è anche possibile trovare la documentazione di tutti gli elementi disponibili
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Plugin già installati

Alcuni plugin sono pre-installati con MuseScore ma non sono attivati, per impostazione predefinita. vedi →sopra per
abilitare i plugin.

ABC Import

Questo plugin importa un testo ABC  da un file o dagli appunti. È necessaria una connessione a Internet, in quanto
utilizza una connessione esterna  per la conversione, che utilizza abc2xml  e inviati i dati ABC, restituisce MusicXML e
li importa in MuseScore.

Break Every X Measures

Questo plugin inserisce le interruzioni di riga nell'intervallo di misure selezionate o, se non sono selezionate le misure,
nell'intera partitura. Esso non viene più distribuito ed è stato sostituito da Modifica → Strumenti → Aggiungi/Rimuovi interruzioni di

riga. Se avete mai usato una versione beta iniziale di MuseScore 2 potrete vedere che il plugin è ancora presente

Notes → Color Notes

Questo plugin colora le teste di tutte le note in tutti i pentagrammi secondo la convenzione BoomWhackers. Ogni altezza
di nota ha un colore diverso. Do e Do# avranno colori differenti. Do# e Reb avranno lo stesso colore.
Per ricolorare in nero tutte le note eseguite nuovamente il plugin (sulla stessa selezione). Potete anche utilizzare, a
questo scopo, il plugin 'Remove Notes Color' plugin .

Create Score

Questo plugin dimostrativo crea una nuova partitura. Esso crea una nuova partitura per pianoforte con Do Re Mi Fa in
4/4. E 'un buon punto di partenza per imparare a compilare una nuova partitura e aggiungere note da un plugin.

helloQml

Questo plugin dimostrativo mostra alcune operazioni di base.

Notes → Note Names

Questo plugin attribuisce i nomi alle note. Mostra i nomi delle note in inglese (come Stile del testo), per le voci 1 e 3 sopra
il rigo, per la 2 e la 4 sotto il rigo, gli accordi in un elenco separato da una virgola a partire dalla nota superiore.
Una versione tradotta, che utilizza nomi delle note secondo la lingua impostata, è disponibile presso il repository dei
plugin .

Panel

Questo plugin dimostrativo crea un pannello GUI.

random

Crea una partitura casuale.

random2

Anche questo crea una partitura casuale.

run

Questo plugin dimostrativo esegue un comando esterno. Probabilmente funziona solo su Linux.

scorelist

Questo plugin in fase test scorre l'elenco delle partiture.

ScoreView

Plugin dimostrativo dell'uso di ScoreView
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Walk

Questo plugin in fase test "passeggia" attraverso tutti gli elementi di una partitura

Tools

Alcuni strumenti agiscono come plugin nell' "automatizzare" alcune cose, vedi Strumenti, effettivamente alcuni di quelli ivi
menzionati erano plugin.

Preferenze

Lavorando con MuseScore è possibile utilizzare uno stile generale predefinito o determinate cartelle.
Queste preferenze si possono modificare via Modifica → Preferenze... (Mac: MuseScore → Preferenze...):

Si aprirà la finestra delle preferenze con il alto le linguette per navigare nelle diverse schede :

La modifica di alcune preferenze richiede il riavvio di MuseScore. In questi casi comparirà una finestra di messaggio
quando si fa clic su Applica oppure OK.

Selezionando Reimposta predefinite si ritorna alle preferenze predefinite (quelle presenti al momento dell'installazione).
Selezionando Cancella si annullano le modifiche appena effettuate.

Generale
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In questa scheda si possono definire:

La partitura da aprire all'avvio del programma
Le cartelle predefinite per spartiti, librerie di musica, modelli e così via
L'intervallo di tempo per il salvataggio automatico
La lingua di MuseScore (gli aggiornamenti delle traduzioni si possono scaricare da qui)
Lo stile delle finestre e le dimensioni delle icone
Le finestre da aprire all'avvio (Controlli di riproduzione, Navigatore, MuseScore Connect).
Notare che l'aggiornamento della traduzione può essere fatto anche via Aiuto → Gestione delle risorse...

Area di visualizzazione

In questa scheda si possono selezionare il colore e l'immagine da utilizzare come sfondo e come carta della partitura.

Nell'area Miscellanea, l'opzione Usa funzione anti-aliasing (selezionata di default) renderà le linee diagonali e i contorni delle
figure più lisci (meno dentellati). Distanza tra elementi selezionati definisce la distanza che ci può essere tra il mouse e un
oggetto e poterci ancora agire. Valori bassi richiedono maggiore precisione, quindi è più difficile fare clic su oggetti piccoli.
Valori alti comportano minor precisione, rendendo più difficile la selezione non intenzionale di oggetti vicini. Selezionare
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un valore valido per lavorare senza difficoltà.

Inserimento note

In questa scheda si possono selezionare le preferenze per l'inserimento note e per il controllo remoto MIDI. Qui si può
selezionare:

Inserimento delle note via MIDI
Far suonare le note al momento dell'inserimento
La durata di questo suono
Colore le note fuori estensione
Definire il controllo remoto MIDI

Spartito

Le preferenze per la partitura comprendono:

I file predefiniti con l'elenco strumenti (se ne possono selezionare due)
Lo stile predefinito per la partitura e le parti
Lo zoom predefinito
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I/O e suoni

Questa scheda è per selezionare le preferenze di Input e Output

Importazione

Queste impostazioni determinano come vengono importati i file da altre sorgenti:

Utilizzando lo stile predefinito di MuseScore oppure un altro stile
L'insieme dei caratteri dei programmi Guitar Pro e Overture
Le opzioni di impaginazione di MusicXML
Le note più corte nei file MIDI

Esportazione
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Queste impostazioni determinano come vengono esportati i file di MuseScore:

La risoluzione (in DPI) delle immagini PNG/SVG e se utilizzare lo sfondo trasparente
Se espandere le ripetizioni nei file di esportazione MIDI
La frequenza di campionamento per i file audio digitali
Se esportare l'impaginazione e come esportare le interruzioni di accollatura e di pagina nei file MusicXML

Scorciatoie

In questa scheda sono elencate tutte le azioni possibili con MuseScore e le relative scorciatoie, se presenti. Selezionando
il pulsante Imposta è possibile definire una nuova scorciatoia per un'azione. È possibile utilizzare fino a quattro tasti per
definire una scorciatoia. Inoltre è possibile azzerare le scorciatoie personalizzate ripristinando quelle predefinite, oppure
cancellare una singola scorciatoia.

(Notare che alcune scorciatoie, comprese alcune predefinite, non possono essere utilizzate con alcune tastiere. Verificare
la possibilità.)

Aggiornamenti
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In questa scheda l'impostazione Controllo automatico aggiornamenti indica a MuseScore di controllare all'avvio la presenza di
eventuali aggiornamenti del programma.

Il controllo della presenza di aggiornamenti può essere eseguito manualmente selezionando Aiuto → Controlla per gli

aggiornamenti

vedi anche

Scorciatoie
Impostazioni lingua e aggiornamenti traduzioni
Controllo degli aggiornamenti

Proprietà tipi di pentagramma

Sfondo

In MuseScore, il pentagramma di ogni strumento ha un numero di proprietà che possono essere modificate. Ogni
pentagramma appartiene a uno dei 3 gruppi:

Standard (il classico, 'normale', tipo di pentagramma)
Tablature
Percussioni

Alcune delle proprietà di un pentagramma dipendono dal gruppo di appartenenza. Le proprietà generali possono essere
esaminate e modificate con la finestra di dialogo Modifica proprietà pentagramma/parte questa finestra di dialogo
consente di rivedere e modificare le proprietà specifiche del gruppo.

I gruppi di pentagrammi cui il pentagramma di uno strumento può appartenere dipendono dallo strumento: qualsiasi
pentagramma può essere un pentagramma standard, ma solo quelli degli strumenti a percussione possono essere (o
essere trasformati in) pentagrammi percussioni e soltanto quelli degli strumento a corda possono essere (o essere
trasformati in) pentagrammi tablature.

Ogni partitura viene inizialmente creata con 17 modelli di pentagrammi incorporati: quello standard, tre percussioni e 13
modelli di tablature. Ogni modello si rivolge ad un bisogno specifico, abbastanza comune o abbastanza standardizzato da
meritare un modello specifico; ogni modello può essere modificato (indipendentemente per i pentagrammi di ogni
partitura) e nuovi modelli possono essere creati per soddisfare esigenze specifiche.

Come arrivarci

Questa finestra di dialogo è accessibile facendo clic destro su un punto vuoto di un pentagramma, selezionando Proprietà

del pentagramma...
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e poi premendo il pulsante Stile, proprietà avanzate..., che per un pentagramma normale si presenta così:

Per un rigo di percussioni così:
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Per un pentagramma tablature così:

e così:

168



Elementi comuni

La finestra di dialogo mostra diversi elementi a seconda del gruppo del tipo di pentagramma selezionato: standard,
tablature e percussioni.
Alcuni elementi di dialogo, tuttavia, sono comuni a tutti i tipi:

Nome
Un nome leggibile

Linee
Il numero di linee che compongono il pentagramma

Distanza linea
La distanza tra due linee di un pentagramma, espressa in spazi (abbr.:sp), cioè la distanza predefinita tra due linee
di un pentagramma; 1.0 è (piuttosto ovviamente) il default, un valore più alto genera linee distanziate più
ampiamente, un valore inferiore meno distanziate. Si raccomanda di non modificare questo valore per il gruppo
standard (anche se è possibile); altri gruppi possono avere diversi valori di default, ad esempio le tablature di solito
hanno una distanza in linea di 1,5 sp.

Mostra chiave
Viene visualizzata la chiave del pentagramma.

Mostra l'unità di tempo
La divisione del tempo del pentagramma(i) verrà visualizzata o meno.

Mostra stanghette
Mostra le linee di battuta del pentagramma.

Ci sono anche alcuni pulsanti:

Modelli

Visualizza l'elenco di tutti i modelli di pentagramma disponibili nelle partiture che possono essere applicati al
pentagramma attuale.

< Ripristina a Modello

Ripristina tutte le proprietà del pentagramma alle proprietà del modello selezionato.

Aggiungi a Modelli
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Aggiunge la proprietà corrente impostata per la partitura come un nuovo modello (non ancora implementato).

OK

Chiude la finestra di dialogo, accetta le modifiche.

Annulla

Chiude la finestra di dialogo, rifiuta le modifiche.

Pentagramma standard e per percussioni, elementi specifici.

Mostra armatura di chiave
Verrà mostrata la tonalità.

Mostra tagli addizionali
Verranno mostrate le linee addizionali.

Senza gambi
Se selezionato, le note del pentagramma non avranno gambo, coda o travature.

Elementi specifici del pentagramma Tablature

Capovolto
Se non è selezionato, la linea di tablature superiore farà riferimento alla corda più alta e la linea di fondo a quella più
bassa (caso più comune). Se selezionata, la linea superiore della tablatura farà da riferimento per la corda più
bassa e la più bassa per quella più alta (utilizzato nelle tablature per liuto in stile italiano).

Marcatori tasti

Questo gruppo di proprietà definisce la comparsa dei simboli dei tasti.

Font
Il font utilizzato per disegnare i segni. Attualmente sono disponibili 4 font che supportano tutti i simboli necessari in 4
stili differenti (modern serif, modern sans, Renaissance, Late Renaissance). Altri tipi di carattere (o la possibilità di
utilizzare caratteri personalizzati) potranno essere disponibili in futuro.

Dimensione
La dimensione del font da utilizzare, in punti tipografici. I set di caratteri incorporati appaiono generalmente ben
dimensionati a 9-10pt.

Spiazzamento verticale
MuseScore cerca di posizionare i simboli in modo ragionevole e questo valore non è di solito necessario (impostato
a 0) per i font incorporati. Se il carattere ha simboli non allineati sulla linea di base (o in qualche altro modo inatteso
per MuseScore), questo valore permette di spostare simboli su (offset negativo) o giù (offset positivi) per un migliore
posizionamento in verticale. I valori sono in sp.

Numeri/Lettere
Utilizzare i numeri ('1', '2' ...) o lettere ('a', 'b' ...) come marcatori di tasto. Quando si utilizzano le lettere, 'j' viene
saltata e 'k' è usato per il 9 ° tasto.

Sulle linee/Sopra le linee
Se i marcatori devono essere posizionati sulle linee della corda o sopra.

Continua/Spezzata

Quando le linee delle corde dovrebbero passare 'attraverso' i marcatori di tasto o interrompersi prima.
Esempio di numeri sulle linee spezzate:

Esempio di lettere sopra linee continue:
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Esempio di tablatura 'capovolta' (stesso contenuto esempio numeri di cui sopra):

Valore della nota

Questo gruppo di proprietà definisce l'aspetto dei simboli che indicano il valore delle nota.

Font
Il carattere usato per disegnare i simboli di valore. Attualmente sono disponibili 3 tipi di carattere contenenti tutti i
simboli necessari in 3 diversi stili ((modern, Italian tablature, French tablature). Altri tipi di carattere (o la possibilità di
utilizzare caratteri personalizzati) potranno essere disponibili in futuro. Utilizzato solo con l'opzione nota simboli.

Dimensione
La dimensione del font da utilizzare, in punti tipografici. I set di caratteri incorporati appaiono generalmente ben
dimensionati a 15pt. Utilizzato solo con l'opzione nota simboli.

Spiazzamento verticale
Come per i Marcatori tasti qui sopra, ma riferito ai simboli di valore. Utilizzato solo con l'opzione nota simboli.

Mostra come: Nessuno
Nessun valore nota sarà visualizzato (come negli esempi qui sopra)

Mostra come: Simboli Note

Simboli sotto forma di note saranno mostrati sopra il rigo. Quando questa opzione è selezionata, i simboli sono
mostrati solo quando cambia il valore della nota, senza essere ripetuti (per impostazione predefinita) per una
sequenza di note tutte dello stesso valore.
Esempio di valori indicati da simboli della nota:

Mostra come: Gambi e travi

I gambi delle note e le travi saranno visualizzati. I valori sono indicati per ogni nota, utilizzando le stesse
caratteristiche tipografiche di un pentagramma regolare; tutti i comandi della tavolozza Proprietà gruppo note
possono essere applicati a questi elementi
Esempio di valori indicati con il gambo della nota:

Ripeti: Mai/Alla nuova accollatura/Alla nuova battuta/Sempre
Se e quando ripetere lo stesso simbolo della nota, se più note in sequenza hanno lo stesso valore (disponibile solo
con l'opzione Simboli della nota).

Accanto al pentagramma/Attraverso il pentagramma
I gambi sono posizionati come linee ad altezza fissa sopra/sotto il rigo oppure attraversano il pentagramma per
raggiungere il marcatore del tasto cui si riferisce (disponibile solo con l'opzione gambi e travi).

Sopra/Sotto il pentagramma
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Gambi e travi sono disegnati sopra o sotto il rigo (disponibile solo con l'opzione gambi e travi/sub-opzione Accanto al
pentagramma).

Nessuno/Gambo corto/Gambo barrato
Per selezionare tre differenti stili di gambo per le semibrevi (disponibile solo con l'opzione gambi e travi/sub-opzione
Accanto al pentagramma).

Mostra pause
I simboli della nota dovrebbero essere utilizzati per indicare anche le pause; quando utilizzati per le pause, i simboli
delle note sono mostrati in una posizione leggermente più bassa. Utilizzato solo con l'opzione Simboli della nota.

Anteprima

Visualizza una breve partitura in formato tablatura con applicati tutti i parametri correnti.

Recovered files

If MuseScore or your computer should crash, or if power is lost, a pop-up message upon restarting MuseScore will ask if
you wish to restore the previous session.

If you click No, any work from your previous session will be lost. If you click Yes, MuseScore will attempt to recover the files
that were open.

Behavior of saving after session recovery

When MuseScore recovers files after a crash, it renames them with the full path name added in front of the original file
name. This very long name will appear in the tab(s) above the active score window. On some operating systems, when a
user saves any of these recovered files, it will be saved in the folder in which the program itself is running. This is not
necessarily the same directory in which the scores were saved when they were created. You may not be able to
locate the revised file in the usual folder.

To avoid this, do not use "Save" the first time you save a recovered file. Use the "Save As..." menu item before making any
revisions to the score, to save each recovered file under either its original name or a new name. This will open a window
to allow you to navigate to the correct folder and directory. This is important in order to ensure that the file is saved to
the folder in which you expect to find it later.

Finding recovered files

In the event that "Save" is used instead of "Save As..." with a recovered file, you will have to find the files in your computer.
The actual location of those files will vary, depending on your operating system, and in which directory MuseScore is
installed.

For Windows 7, with a default installation of MuseScore to the x86 program files directory, recovered files are auto-saved
to C:\Program Files (x86)\MuseScore2\bin.

For Windows 10, look in C:\Users\[User Name]\AppData\Local\VirtualStore\Program Files (x86)\MuseScore 2\bin

You may need to run a system-wide search in order to find files saved directly after a session recovery. Use keywords
from the original file name as well as wildcards, and specify the date modified.

See also

Save/Export/Print
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External links

How to recover a backup copy of a score

Schemi tastiera

Musescore permette di creare schemi tastiera (o diagrammi di accordi) per gli strumenti a corda. Troverete i diagrammi
per gli accordi più comuni per chitarra (maggiori, minori e di settima) già disponibili nella tavolozza Schemi tastiera,
nell'Area di lavoro Avanzata.

È possibile personalizzare qualsiasi schema tastiera a proprio piacimento, ed eventualmente aggiungerlo alla tavolozza
personalizzata  per futuri utilizzi.

Aggiungere uno schema tastiera

Per aggiungere lo schema tastiera alla partitura, aprire la tavolozza Schemi tastiera (che potrebbe essere la tavolozza
predefinita Schemi tastiera nell'area di lavoro avanzata, o una tavolozza personalizzata) e:

Selezionare una nota nella voce 1 e fare doppio clic sul diagramma dell'accordo.
Trascinare e rilasciare lo schema di tastiera in posizione sulla partitura

Modifica schema tastiera (accordo) {# edit-tastiera-diagramma}

1. Clic con il tatso destro sul diagramma e selezionare Proprietà schema tastiera....
2. Impostare il numero di corde dello strumento, utilizzando la casella di selezione "Corde" in basso a sinistra della

finestra.
3. Impostare il numero di capotasti utilizzando la barra di scorrimento sul lato destro.
4. Regolare il numero di tasti da visualizzare (in altezza) con lla casella di selezione "Capotasti" in basso a destra

della finestra.
5. Per posizionare un punto su un tasto della corda fare clic su quel tasto. Per rimuovere il punto, cliccare nuovamente

sul tasto.
6. Fare clic sul tasto più basso per variare la corda tra:

Corda aperta (o),
muta/corda non suonata (x)
Off.

7. Per creare un barré o un barré parziale, assicurarsi che il capotasto scelto sia privo di punti. Premere su un
capotasto tenendo premuto Maiusc (vedi "passo 2" di seguito). Eliminare il barré con Maiusc+ clic sullo stesso
capotasto. Nota: Può essere applicato un solo barré per capotasto.

Ad esempio, per creare l'accordo Fa (che è disponibile per impostazione predefinita come il decimo diagramma della
tavolozza) dall'accordo Do (che è disponibile per impostazione predefinita come primo diagramma della tavolozza):

1. Dopo aver posizionato il diagramma Do, Proprietà schema tastiera, fare clic sulle relative posizioni sui tasti per
stabilire i punti di diteggiatura.
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2. Creare il barré utilizzando Maiusc e clic sul primo tasto della sesta corda, in questo modo:

Risultato:

Si noti che il principio è lo stesso se si desidera un barrè su quattro corde (o altro). In questo caso un accordo di La7
Maiusc, e clic , secondo capotasto. Il risultato sarà:

Regolare posizione, dimensione, colore

Dimensione ("Scale"), colore e posizione di uno schema tastiera possono essere modificati con un clic e la modifica delle
impostazioni nell'Ispettore.

La posizione può essere regolata anche più direttamente con la Modalità modifica:

1. Doppio clic sul diagramma (o clic e premere Ctrl+E (Mac: Cmd+E) , o clic sull'elemento e selezionare "Modifica
elemento").

2. Premere le frecce direzionali per regolazioni fini (0.1 sp at a time); o premereCtrl+Freccia (Mac: Cmd+Freccia) per
regolazioni più ampie (1 sp alla volta).
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Stile dello schema Tastiera

Alcune proprietà di default dei diagrammi (spessore barre, posizione verticale, dimensioni, ecc) possono essere
modificate da Stile → Generale… → Simboli accordi, Schemi tastiera… . Tutte le modifiche apportate qui influiscono sugli schemi
esistenti come su quelli inseriti successivamente.

Sostituire le altezze delle note senza modificare i ritmi

Se in un passaggio è necessario modificare le note ma non il ritmo, cosa più complicata di una semplice trasposizione,
questa funzionalità è molto utile. In sostanza in questo modo l'altezza delle note sarà sostituita mantenendo il ritmo
precedente.

Da non confondere con Alterazioni: Sostituzione enarmonica delle alterazioni

Per attivare la funzionalità utilizzare il pulsante, , accanto al pulsante Inserimento note, , o utilizzare la scorciatoia
Maiusc+Ctrl+I (Mac: Maiusc+Cmd+I).

Per riprodurre un brano ritmico con altezze diverse selezionare il passaggio, copiarlo ed incollarlo dove si desidera. (Nel
caso in cui siano state inserite le note sbagliate, con il giusto ritmo, non è necessario il copia e incolla.)

Quindi fare clic sulla prima nota da modificare, selezionare la Modalità Inserimento Note e attivare "Sostituisci altezza
note...". Iniziare a digitare le nuove altezze. A differenza della normale situazione, in cui la durata è basata sulla nota
scelta nella barra inserimento note, in questa modalità il ritmo (la durata delle note) sarà lo stesso.

Vedi anche

Inserimento note
Copia e incolla
Trasposizione
Introduction to the new re-pitch mode

Tavolozza generale

La tavolozza generale consente di accedere a tutti i possibili elementi che potrebbero essere aggiunti alle tavolozze
personalizzate e, in caso di Unità di tempo e Armature di chiave, creare quelli personali.

Si accede da Visualizza → Tavolozza generale o utilizzando la scorciatoia Maiusc+F9 (Mac: fn+Maiusc+F9).

Passando il mouse sopra un elemento viene mostrato un suggerimento (una breve definizione in nero su sfondo giallo).
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Vedi anche

Tavolozza
Tavolozza personalizzata
Nonexistant node nid: 39841

Teste delle note sovrapposte

Le teste delle note sovrapposte (in diverse voci) sono particolarmente comuni nella musica per chitarra classica e
fingerstyle. MusScore permette la sovrapposizione della testa della nota di default (per le tablature funziona in modo
diverso: vedi sotto) quando entrambe le note sono una semiminima o valore inferiore - non sono necessarie ulteriori
regolazioni da parte dell'utente.

Se una testa della nota sovrapposta ha un valore superiore alla semiminima (ad esempio, semiminima puntata, minima,
minima puntata ecc), MuseScore posiziona separatamente le due note. esempio:

Questo spiazzamento può essere ignorato facilmente, nascondendo la testa della nota di valore minore con la scorciatoia
V, deselezionando l'opzione "visibile" o modificando il tipo di testa della nota adeguandola a quella di valore maggiore (n
questo caso da "Auto" a "Semibreve") da Ispettore:

Se si desidera anche una riproduzione corretta, togliere in Ispettore la spunta a "Riproduci" per la nota di valore minore.

Nelle tablature collegate, le teste delle note sovrapposte si traducono in due note separate. Per correggerle nascondere
semplicemente una delle note del pentagramma tablatura con la scorciatoia da tastiera V o deselezionando l'opzione
"visibile" da Ispettore.

Nuove funzionalità di MuseScore 2.0

Per una panoramica sulle nuove funzionalità vedi Le novità di MuseScore 2 , MuseScore 2.0 Note di rilascio  e
Modifiche di MuseScore 2.0 .
La documentazione delle nuove funzionalità è disponibile nei relativi capitoli (ad eccezione di quelle riferite
all'aggiornamento da 1,3 a 2,0) , ma per gli utenti delle versioni 1.x ecco una raccolta di collegamenti per afferrare a colpo
d'occhio cosa si può fare ora ...

Album (→Argomenti avanzati)
Modalità di visualizzazione: Vista continua e Navigatore (→Nozioni di base)
Copia e incolla: Filtro selezione (→Nozioni di base)
Tavolozza personalizzata  (→Argomenti avanzati)
Funzionalità Early music (→Argomenti avanzati )
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Basso continuo (→Argomenti avanzati)
Griglia di spostamento di simboli o del testo di pentagramma (→Testo)
Acquisizione immagini (→Formattazione)
Ispettore e proprietà degli elementi (→Argomenti avanzati)
Operazioni sulle battute: Dividi e unisci (→Nozioni di base)
Importazione MIDI (→Suono e riproduzione )
Cambio strumento lungo il pentagramma (→Suono e riproduzione)
Estrazione parti (nuova opzione disponibile) (→Argomenti avanzati)

Marcatori di riferimento: Marcatore di riferimento successivo automatico and Ricerca del marcatore di
riferimento (→Testo)

Salva/Esporta (→Nozioni di base) - Proprietà tipo di pentagramma (→Argomenti avanzati)
Swing (→Suono e riproduzione)
Tablature (→Argomenti avanzati)
Nonexistant node nid: 39841 (→Argomenti avanzati)
Tavolozza generale (→Argomenti avanzati)
Impaginazione e formattazione (alcune opzioni sono cambiate, e c'è una nuova funzionalità "si applica a tutte le
parti") (→Formattazione)
Interruzioni e spaziatori, interruzione sezione (→Formattazione)
Modalità selezione, seleziona tutti gli elementi simili, nuova opzione (stesso sottotipo) (→Nozioni di base)
Creare un nuovo spartito, finestra di avvio (→Nozioni di base)
Impostazione lingua e aggiornamenti traduzione (→Nozioni di base)
Contribuire e migliorare la traduzione (→Supporto)
Alterazioni, sostituzione altezza note (→Notazione)
Sostituzione altezze delle note senza modificare i ritmi (→Argomenti avanzati)
Strumenti (→Argomenti avanzati)
Meta tag (→Argomenti avanzati)
Aggiornamento da MuseScore 1.x

Aggiornare da MuseScore 1.x

Come aggiornare MuseScore

Scaricare e installare l'ultima versione dalla pagina di Nonexistant node nid: 27 come descritto in Installazione. Se si
desidera rimuovere 1.x, controllare la pagina Installazione  del manuale 1.x

L'installazione MuseScore 2 non disinstalla 1.x - entrambe le versioni possono coesistere pacificamente e possono anche
essere utilizzate in parallelo. Quindi questo non è realmente un aggiornamento ma l'installazione di un nuovo e diverso
programma.

Aprire spartiti 1.x in MuseScore 2.0

MuseScore 2.0 ha migliorato significativamente la qualità della composizione tipografica per rendere gli spartiti attraenti e
facile da leggere. I miglioramenti riguardano numerosi elementi quali l'inclinazione delle travi, l'altezza gambi, la
disposizione delle alterazioni negli accordi e in generale la spaziatura delle note. Tuttavia questo significa che gli spartiti
realizzati con MuseScore 1.x sono leggermente diversi da quelli realizzati con 2.x.

Significa anche che gli spartiti salvati con 2.0 non si apriranno con 1.x.

Per prevenire la sovrascrittura accidentale delle partiture 1.x, 2.0 li considera come un'importazione, il che significa:

la partitura viene contrassegnata come modificata, anche se non è stata modificato nulla
all'uscita da MuseScore viene chiesto di salvare la partitura (come risultato di quanto sopra)
MuseScore utilizza la finestra di dialogo 'Salva con nome " per salvare, non quella "Salva"
MuseScore usa il titolo della partitura per creare il nome del file predefinito, piuttosto che adottare il vecchio nome
del file

Ridefinire l'impaginazione locale

Se non avete regolato manualmente l'impaginazione di una partitura 1.x MuseScore utilizza il motore di composizione 2.x
per l'impaginazione della partitura. Se avete regolato l'impaginazione della partitura in 1.x essa dovrebbe rimanere uguale
dopo l'apertura in MuseScore 2.x. Se volete utilizzare il motore di composizione 2.x per l'impaginazione, selezionare
l'intera partitura (Ctrl+A) e utilizzare Ctrl+R per reimpostare l'impaginazione.
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Ottenere il suono da MuseScore 1.x

Anche se il suono in 2.0 è stato molto migliorato, potreste preferire quello di MuseScore 1.x. In questo caso, è possibile
avere il suono della 1.x nella 2,0 scaricando la libreria di suoni della versione 1,3 e aggiungendola alla 2.0. È possibile
farlo in due fasi:

1. Scaricare la libreria di suoni per 1.3 soundfont nominata TimGM6mb
2. Come cambiare la libreria di suoni (SoundFont) utilizzato per la riproduzione o aggiungerne un altro per

MuseScore

Supporto

Questo capitolo descrive come trovare aiuto per utilizzare MuseScore: i posti migliori dove guardare, il modo migliore per
porre una domanda sui forum, e suggerimenti per la segnalazione di un bug.

Come chiedere supporto o segnalare un errore

Per cortesia usate la funzione ricerca  sulla pagina per verificare se qualcuno ha riscontrato lo stesso problema

Prima di inviare la richiesta nel forum :

Cercate una soluzione nel Manuale .
Controllate i Come fare , FAQs  e Tutorial

Se si invia un commento nel issue tracker  (per errori confermati) o nel forum (per richieste o discussioni):

Cercate di riprodurre il problema con l'ultima versione Nightly  (non le versioni 1.x, che non vengono più
aggiornate). È anche possibile visualizzare la vecchia  e nuova  cronologia delle versioni per verificare se è già
stato risolto o implementato.

Per cortesia aggiungete la maggior parte possibile delle seguenti informazioni in vostro possesso e limitatevi a
segnalare un problema per intervento:

Versione/revisione di MuseScore che state usando (es. versione 2.0, revisione 2902cf6) Controllate Aiuto →

Informazioni... (Mac: MuseScore → About MuseScore...).
Sistema operativo in uso (es. Windows Vista, Windows 7, macOS o Ubuntu 10.10)
Se state segnalando un errore (bug) cercate di descrivere in maniera precisa i passaggi che hanno condotto al
problema (dove si è fatto clic, quali tasti sono stati premuti, cosa è stato visualizzato, ecc.).
Se non riuscite a riprodurre il problema seguendo gli stessi passaggi probabilmente non vale la pena
segnalarlo perché gli sviluppatori non saranno in grado di riprodurre (ed eliminare) l'errore. Ricordate che
l'obiettivo della segnalazione non è solo mostrare l'errore ma è anche permettere agli altri di riprodurlo
facilmente.
Ricordarsi di allegare la partitura che presenta il problema. Utilizzare l'opzione "File allegati" in fondo alla
pagina sulla quale si sta inserendo il post, appena sopra i pulsanti Salva e Anteprima.

Vedi anche

How to write a good bug report: step-by-step instructions

Aiutare e migliorare la traduzione

Avete una traduzione da aggiungere? Questo può essere fatto facilmente via web, come indicato in Sviluppo / Tradurre
...

Traduzione del software

1. Chiedete nel forum Traduzione
2. Connettersi a Transifex/MuseScore http://translate.musescore.org , che vi reindirizzerà a

https://www.transifex.com/projects/p/musescore
3. Selezionare la lingua e poi la sezione cui si vuole contribuire (musescore o strumenti)
4. Fare clic sul pulsante "tradurre" (il testo del pulsante dipenderà dalla lingua ...)
5. Cercate le "stringhe" (in senso informativo) che volete tradurre (è possibile filtrare per "elementi già tradotti")

Qui c'è una spiegazione tecnica: Continuous translation for MuseScore 2.0
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Traduzione stringhe del sito e manuale

Vedi Translation instructions

Vedi anche

Impostazione lingua e aggiornamenti traduzione, Aggiornare traduzioni

Ripristinare le impostazioni predefinite

Le versioni più recenti di MuseScore hanno incorporata l'opzione di ritornare alle impostazioni predefinite o "impostazioni
di fabbrica". Questa opzione a volte può essere utile se le impostazioni personalizzate sono corrotte. Attenzione il
ripristino alle impostazioni di fabbrica rimuove tutte le modifiche apportate alle preferenze, tavolozze, o le impostazioni
della finestra. Questa non è una procedura comunemente necessaria; consultare il forum prima, può esserci un modo per
risolvere il problema senza reimpostare tutto.

MuseScore 2.0.3 e superiori

Nelle versioni recenti è possibile ripristinare dall'interno MuseScore, a condizione che MuseScore sia in grado di avviarsi.
Vai a Aiuto → Ripristina impostazioni di fabbrica. Apparirà una finestra di avviso:

Un clic su Si ripristina tutte le impostazioni di MuseScore come se il programma fosse installato per la prima volta e
MuseScore viene immediatamente riavviato. No annulla in modo sicuro il ripristino.

da MuseScore 2.0 a 2.0.2

Nelle versioni precedenti di MuseScore o nelle versioni successive, se non si avviano, è necessario eseguire questa
procedura tramite la riga di comando.

Istruzioni per Windows

1. Se MuseScore è aperto per prima cosa dovete chiuderlo (File → Esci)
2. Premere i tasti⊞ Win+R per aprire la finestra di dialogo "Esegui". (Il tasto Windows key  è il tasto con il logo di

Microsoft Windows).
3. Fare clic su Sfoglia...

4. Cercare il file eseguibile MuseScore.nel computer. La posizione del file può variare (dipende dal processo di
installazione) ma probabilmente lo si può trovare in Risorse del computer → disco locale (C) → Programmi (o
Program Files (x86)) → MuseScore2 → bin → MuseScore.exe

5. Fare clic su Apri per lasciare la finestra di dialogo "sfoglia" e tornare alla finestra di dialogo "Esegui". Nella finestra di
dialogo compare ora una linea di testo tipo

"C:\Programmi\MuseScore2\bin\MuseScore.exe"

Per Windows 64-bit, la posizione è

"C:\Program Files (x86)\MuseScore2\bin\MuseScore.exe"

6. Fare clic dopo le virgolette, aggiungere uno spazio seguito da un trattino e una F maiuscola: -F

7. Premere OK

Dopo pochi secondi MuseScore si avvia e tutte le impostazioni sono state ripristinate a "impostazioni di fabbrica").
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Per gli utilizzatori esperti, le principali preferenze sono nel file:

Windows Vista o successivi: C:\Utenti\<Nomeutente>\AppData\Roaming\MuseScore\MuseScore2.ini

Windows XP o precedenti: C:\Documents and Settings\Nomeutente\Application Data\MuseScore\MuseScore2.ini

Le altre preferenze (tavolozze, sessioni...) sono nel file:

Windows Vista o successivi: C:\Utenti\<Nomeutente>\AppData\Local\MuseScore\MuseScore2\

Windows XP o precedenti: C:\Documents and Settings\Nomeutente\Local Settings\Application Data\MuseScore\MuseScore2\

Istruzioni per macOS

1. Se MuseScore è aperto per prima cosa dovete chiuderlo (File → Esci)
2. Aprire Terminal (in Applicazioni/Utilities o tramite ricerca Spotlight) e dovrebbe apparire una finestra di sessione

3. Digitare (oppure copiare e incollare) la seguente linea di comando (incluso il carattere '/' all'inizio):

/Applications/MuseScore\ 2.app/Contents/macOS/mscore -F

Questo ripristina le impostazioni di MuseScore a "impostazioni di fabbrica" e avvia immediatamente MuseScore. Notare
che non è possibile chiudere il terminale senza uscire da MuseScore. Si può uscire tranquillamente da MuseScore, uscire
dal terminale, e quindi riaprire MuseScore normalmente, pronto a continuare ad utilizzarlo.

Per gli utilizzatori esperti: il file in cui sono registrate le principali preferenze è
~/Library/Preferences/org.musescore.MuseScore2.plist.

Le altre preferenze (tavolozze, sessioni...) sono nel file: ~/Library/Application\ Support/MuseScore/MuseScore2/

Instruzioni per Linux

Quanto segue si applica per Ubuntu, e molto probabilmente per tutte le altre distribuzioni Linux e sistemi operativi di tipo
UNIX.

1.Se MuseScore è aperto per prima cosa dovete chiuderlo (File → Esci)
2. Dal menù principale di Ubuntu selezionare Applicazioni → Accessori → Terminale. Apparirà una finestra per una sessione
"Terminale"
3. 3. Digitare (oppure copiare e incollare) la seguente linea di comando (Ctrl+Shift+V per copiare nel terminale):

    mscore -F

Oppure, se si utilizza la versione AppImage, è necessario prima utilizzare il comando cd per cambiare directory ovunque
sia stato salvato AppImage. Ad esempio, se è stato salvato sul desktop:

    cd ~/Desktop
    ./MuseScore*.AppImage -F

Questo ripristina le impostazioni di MuseScore a "impostazioni di fabbrica" e avvia immediatamente MuseScore. È
possibile chiudere il terminale e continuare ad utilizzare MuseScore.

Per gli utilizzatori esperti, le principali preferenze sono nel file: ~/.config/MuseScore/MuseScore2.ini. Le altre preferenze
(tavolozze, sessioni...) sono nel file: ~/.local/share/data/MuseScore/MuseScore2/

Vedi anche

Opzioni da linea di comando

Incompatibilità conosciute

Incompatibilità conosciute

I software qui elencati mandano in errore MuseScore (crash) all'avvio del programma:

Samson USB Microphone, nome del driver "Samson ASIO Driver", samsonasiodriver.dll. Maggiori informazioni
Digidesign MME Servizio di aggiornamento. Maggiori informazioni
Windows XP SP3 + Realtek Azalia Audio Driver. Maggiori informazioni
Wacom tablet. Maggiori informazioni  and QTBUG-6127
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Incompatibilità software

Maple virtual cable è noto per impedire a MuseScore  la corretta chiusura.
Alcune configurazioni delle finestre in ambiente KDE (Linux) possono far spostare l'intera finestra quando si tenta di
spostare una nota. È consigliabile modificare le impostazioni delle finestre  per evitare questo problema.

AVG Internet Security blocca MuseScore

MuseScore richiede l'accesso alla connessione internet con AVG.MuseScore non necessita di una connessione ad
internet per poter funzionare, ma AVG lo blocca e MuseScore si arresta.

Se AVG lo richiede, Autorizzare MuseScore and check "e selezionate l'opzione "Salva la mia risposta come regola
permanente e non chiedere la prossima volta".

Se non lo richiede,

1. Aprire l'interfaccia utente di AVG (clic con il tasto destro sull'icona di AGV, vicino all'orologio -> Apri Interfaccia
Utente di AVG

2. Clic su Firewall
3. Clic su Impostazioni avanzate
4. Click Applicazioni
5. Trovare MSCORE.EXE nella lista a fare doppio clic
6. Modificare Application Action in Allow for All (Permetti a tutti)

Problemi di font su macOS

Può accadere che MuseScore mostri dei quadrati al posto delle note, questo quando alcuni font sono danneggiati in
ambiente macOS.
Per correggere questo errore:

1. Selezionare Applications -> Font Book
2. Selezionare un font e premere ⌘+A per selezionarli tutti
3. Selezionare quindi File -> Validate Fonts
4. Se un font è segnalato come danneggiato o con altri problemi, selezionatelo e cancellatelo
5. Riavviare MuseScore se necessario

In questo intervento nel forum  un utente segnala il font "Adobe Jenson Pro (ajenson)" come possibile causa di questo
malfunzionamento, anche se il sistema operativo non lo segnala come danneggiato oppure con dei problemi. Il problema
è stato risolto cancellando il font. Vale la pena verificare.

Problemi di font su Linux

Se il font di default per l'ambiente grafico desktop è selezionato come "grassetto" (bold), MuseScore non mostrerà
correttamente le note.
Per risolvere il problema (gnome 2.*/MATE users):

1. Fare clic con il tasto destro in un punto vuoto del desktop e selezionare "Cambia sfondo scrivania"
2. Fare clic sulla scheda "Tipi di carattere"
3. Alla voce "Caratteri per applicazioni" selezionare lo stile "regular"
4. Riavviare MuseScore

Per gli utilizzatori di GNOME 3/SHELL

1. Aprire la shell e selezionare "Advanced Settings"
2. Fare clic su "Fonts option"
3. Selezionare un font di default che non sia grassetto (non-bold)
4. Riavviare MuseScore se ecessario

Finestra di dialogo "Salva come..." vuota su Linux

Alcuni utenti hanno segnalato che la finestra di dialogo "Salva come..." appare vuota. con Debian 6.0 e Lubuntu 10.10
Per risolvere il problema:

1. Aprire un terminale e scrivere:
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which mscore

2. Come risposta al comando sarà mostrato il percorso dove trovare questo file. Modificare questo file con un
programma editor di testo (es. Gedit) inserendo all'inizio la seguente riga:

export QT_NO_GLIB=1

Riavviare MuseScore: il problema dovrebbe essere stato risolto.

Appendice

Incompatibilità conosciute di MuseScore 2.0

Benchè tutti i membri del team di sviluppo abbiano fatto del loro meglio per rendere il software facile da usare e privo di
bug, ci sono alcuni problemi e limitazioni note di MuseScore 2.0.

Nozioni di base

Salva selezione

'Salva selezione ...' è attualmente piuttosto limitata: Se la selezione non contiene una chiave, tempo e tonalità, la partitura
sarà salvata in chiave di violino, unità di tempo 4/4, e tonalità di Do maggiore, anche se tutte le altezze delle note sono
salvate, aggiunte le necessarie alterazioni e mantenute anche le misure irregolari.

Unità di tempo locale

La funzione di unità di tempo locale, che consente di avere diverse unità di tempo in diversi pentagrammi, allo stesso
tempo, è molto limitata. È possibile aggiungerne una solo alle misure vuote e solo se non ci sono parti collegate. Quando
si aggiungono le note alle misure con le unità di tempo locali, è possibile inserire le note normalmente tramite la modalità
di inserimento note, ma copia e incolla non funziona correttamente e può portare alla corruzione o addirittura al blocco. I
comandi Dividi e Unisci battute sono disabilitati per quelle con unità di tempo locali.

Inserimento note

Pentagramma Tablatura collegato con pentagramma standard

con pentagramma standard e tablatura collegati se si inseriscono le note multiple degli accordi nel pentagramma standard
ogni accordo dovrebbe essere 'costruito' inserendo le note dall'alto al basso, altrimenti i tasti assegnati alle note, nel
pentagramma tablatura, potrebbero essere inattese
(Nota: non si applica a:
a) inserimento note direttamente nel pentagramma tablatura;
b) inserimento note in un pentagramma standard non collegato alla tablatura: in entrambi i casi l'ordine di inserimento è
indifferente).

Suono e riproduzione

Modifica strumenti

La modifica di uno strumento non implica la trasposizione, ma gli strumenti interessati potrebbero richiederlo, in questo
caso è necessario utilizzare diversi pentagrammi e l'opzione "Nascondi pentagrammi vuoti". In realtà non vi è alcun
cambiamento reale dello strumento ma solo un cambio di suono, quindi non solo la trasposizione non è presa in
considerazione ma nemmeno l'estensione dello strumento, e il nome della parte rimane invariato.

Mixer

La modifica dei valori nel mixer non rende lo spartito 'sporco'. Ciò significa che se si chiude una partitura non si riceve
l'avviso "Salvare le modifiche dello spartito prima di chiudere?". I valori del mixer modificati non sono annullabili.

Impaginazione

Intestazione e piè di pagina

Non vi è alcun modo per modificare Intestazione e piè di pagina in modo WYSIWYG. I campi in Stile → Generale →

182



Intestazione, piè di pagina, numeri sono semplice testo. Possono contenere "HTML" come sintassi, ma lo stile del testo,
l'impaginazione ecc. non possono essere modificati
o con un editor WYSIWYG.

Scorciatoie da tastiera

Molte scorciatoie da tastiera possono essere personalizzate selezionando Modifica → Preferenze... → Scorciatoie tab (Mac:
MuseScore → Preferenze... → Scorciatoie tab). Di seguito si riporta un elenco delle impostazioni iniziali di queste scorciatoie.

Navigazione

Inizio della partitura: Home

Fine della partitura:: Fine

Spartito successivo: Ctrl+Tab

Spartito precedente: Maiusc+Ctrl+Tab

Zoom avanti: Ctrl++ o Ctrl + rotella del mouse
Zoom indietro: Ctrl+- o Ctrl + rotella del mouse

Pagina successiva: Pg Dn or Maiusc + rotella del mouse
Pagina precedente: Pg Up or Maiusc + rotella del mouse

Battuta successiva: Ctrl+→ (Mac: ⌘+→)
Battuta precedente: Ctrl+← (Mac: ⌘+←)

Nota successiva: →
Nota precedente: ←

Nota inferiore (dentro un accordo o in un pentagramma inferiore): Alt+↓

Nota superiore (dentro un accordo o in un pentagramma superiore): Alt+↑

Nota più alta dell'accordo: Ctrl+Alt+↑ (Ubuntu invece utilizza questa scorciatoia per le aree di lavoro)
Nota più bassa dell'accordo: Ctrl+Alt+↓ (Ubuntu invece utilizza questa scorciatoia per le aree di lavoro)

Inserimento note

Attivare la Modalità inserimento note: N
Lasciare la Modalità inserimento note: N o Esc

Durata note

1 ... 9 selezionano la durata. Vedi anche Inserimento note.

Dimezza la durata della precedente scelta: Q
Raddoppia la durata della precedente scelta: W

Voci

Voci 1: Ctrl+I Ctrl+1 (Mac ⌘+I ⌘+1)
Voce 2: Ctrl+I Ctrl+2 (Mac ⌘+I ⌘+2)
Voie 3: Ctrl+I Ctrl+3 (Mac ⌘+I ⌘+3)
Voce 4: Ctrl+I Ctrl+4 (Mac ⌘+I ⌘+4)

Altezza note

L'altezza delle note da inserire può essere selezionata con con le lettere corrispondenti alla notazione inglese (A-G),
oppure utilizzando una tastiera MIDI. Vedi Inserimento note per maggiori dettagli.

Ripeti l'ultima nota inserita: R

Aumenta l'altezza di un'ottava: Ctrl+↑ (Mac: ⌘+↑)
Diminuisce l'altezza di un'ottava: Ctrl+↓ (Mac: ⌘+↓)

Aumenta l'altezza di un semitono (utilizza i diesis): ↑
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Diminuisce l'altezza di un semitono (utilizza i bemolle): ↓
Aumento diatonico dell'altezza: Alt+Maiusc+↑

Diminuzione diatonica dell'altezza: Alt+Maiusc+↓

Circolo enarmonico delle note: J

Pausa: 0 (zero)

Intervalli

Aggiunge un intervallo sopra la nota corrente: Alt+[Numero]

Direzione

Inverte la direzione (gambi note, legatura di valore o portamento, graffe dei gruppi irregolari, ecc.): X
Rovescia la testa della nota: Maiusc+X

Articolazioni

Staccato: Maiusc+S

Crescendo: <
Decrescendo: >

Inserimento Testi

Testo di pentagramma: Ctrl+T

Testo di sistema Ctrl+Maiusc+T

Testo Tempo: Ctrl+Alt+T

Marcatori di riferimento: Ctrl+M

Inserimento parole

Inserire il testo su una nota: Ctrl+L

Sillaba precedente: Maiusc+Spazio

Sillaba successiva: se la corrente e la successiva sono separate da '-': -, o Spazio

Spostare la sillaba a sinistra di 1sp: ←
Spostare la sillaba a destra di 1sp: →
Spostare la sillaba a sinistra di 0.1sp: Ctrl+←

Spostare la sillaba a destra di 0.1sp: Ctrl+→

Spostare la sillaba a sinistra di 0.01sp: Alt+←

Spostare la sillaba a destra di 0.01sp: Alt+→

Strofa precedente (su una riga): Ctrl+↑ (Mac: ⌘+↑)
Strofa successiva (giù una riga): Ctrl+↓ (Mac: ⌘+↓)

Per altre scorciatoie per parole vedi Parole.

Mostra

Navigatore: F12 (Mac: fn+F12)
Controlli rirpoduzione: F11 (Mac: fn+F11)
Mixer: F10 (Mac: fn+F10)
Tavolozze: F9 (Mac: fn+F9)
Ispettore: F8 (Mac: fn+F8)

Vedi anche

Preferenze: Shortcuts

Glossario

Questo glossario è un "work in progress", per favore date un contributo, se potete. Potete discutere sul
contenuto di questa pagina nel forum inglese documentation forum  o nel forum documentazione
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La lista sottostante è un glossario di termini usati frequentemente in MuseScore, con una breve descrizione. Le differenze
tra l'inglese americano e britannico sono contrassegnati rispettivamente con "(AE)" e "(BE)".

Acciaccatura
Tipo di ornamento musicale. Si scrive con notine di croma o semicroma tagliate obliquamente →Note di
abbellimento.

Alterazioni
Segno di notazione che, posto davanti a una nota, prescrive una sua alterazione.
Accidentals are used to alter the pitch of a note within a piece. Si utilizzano gli stessi simboli presenti nell'→Armatura
di chiave ma sono poste prima di una nota particolare. Sono per esempio alterazioni →diesis, →bemolli and
→naturali. Le alterazioni influenzano tutte le note nella stessa posizione sullo stesso →pentagramma solo per il
resto della misura in cui si trovano, ma possono essere cancellati da un'altra alterazione. Per le note con legatura di
valore che attraversa una →stanghetta l'alterazione 'attraversa' la →stanghetta fino alla successiva nota legata ma
non infuisce sulle successive note nella stessa posizione nella battuta di quel →pentagramma.

Anacrusi (BE)
Vedi →Battuta in levare

Appoggiatura
A long →grace note.

Battuta (BE)
L'insieme delle note comprese tra due stanghette.

Stanghette
linee verticali poste sul →pentagramma o sull'→accollatura che separano le →battute.

Gruppo di note
Le note del valore di una →croma  o inferiore sono collegate da →bandierine o code (travi). Vengono utilizzate per
raggruppare le note.

BPM
Battiti per minuto è l'unità di misura del tempo. Vedi →Marcatore di Tempo

Breve
Brevis

Una nota (o una pausa) del valore doppio rispetto alla semibreve, utilizzata in particolare nella notazione antica.
Accordo

L'accordo è un minimo di due note diverse suonate insieme. Gli accordi sono basati sulle scelte fatte dal
compositore tra gli armonici di uno o più suoni fondamentali. Per esempio, nell'accordo di Do maggiore, Sol è il
secondo armonico, Mi il quarto armonico della fondamentale Do. Nell'accordo di Do settima di dominante il Si
bemolle è il sesto armonico di Do. Nell'accordo di Do Maj7 il Si è il secondo armonico di Mi e il quarto armonico di
Sol.

Chiave
Simbolo indicato all'inizio di un →pentagramma utilizzato per determinare le note sulle linee e negli spazi del rigo.
Ci sono quattro chiavi di Do, due chiavi di Fa e due chiavi di Sol. Le più usate sono la chiave di violino (Sol sulla
seconda linea), la chiave di basso (Fa sulla quarta linea) la chiave di contralto (Do sulla terza linea) e la chiave di
tenore (Do sulla quarta linea). Le chiavi sono molto utili per la →trasposizione.

Partitura in Do
Consente di passare dalla Partitura in Do alla tonalità di trasposizione (vediPartitura in Do e Trasposizione)

Semiminima (BE)
Crotchet in inglese quarter note in Angloamericano è la nota o pausa del valore di un quarto di semibreve.

Biscroma (BE)
Nota o pausa del valore di un trentaduesimo.

Duina
Vedi →Tuplet

Semibiscroma
Nota o pausa del valore di un sessantaquattresimo.. Same as British →quaver.

Finali
Vedi →Volta

Note enarmoniche
Note di nome diverso ma di altezza identica ( Es: SOL# - LAb sono note enarmoniche )

Bandierina
Vedi →Gruppo di note

Bemolle
Segno di alterazione che abbassa il suono della nota di un semitono.

Note di abbellimento
Le note di abbellimento sono come piccole note di fronte a una nota principale di dimensioni normali. Le note di
abbellimento corte (→acciaccatura) hanno una linea obliqua che attraversa il gambo.; Le note di abbellimento
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lunghe (→appoggiatura) non hanno questa linea.
Minima

Una nota o pausa la cui durata è pari alla metà del valore dell’intero.. Same as British →minim.
Semibiscroma (BE)

Nota o pausa del valore di un sessantaquattresimo.
Armatura di chiave (tonalità)

Insieme di accidenti, →diesis o →bemolli posti all'inizio di ogni riga di →pentagramma.i quali identificano la tonalità
di un brano indicando quali note devono essere stabilmente alterate lungo il →pentagramma.
Per esempio un Si bemolle in armatura di chiave indica una tonalità di Fa maggiore oppure Re minore.

Koron
An Iranian →accidental which means lower in pitch and it lowers a note by a quarter tone (in comparison to the →flat
which lowers a note by a semitone). It is possible to use this accidental in a →key signature.
Vedi anche →Sori

Longa
A longa is a quadruple whole note.

Ledger Line
Line(s) that are added above or below the staff

Measure (AE)
A segment of time defined by a given number of beats. Dividing music into bars provides regular reference points to
pinpoint locations within a piece of music.

Metronome mark
Metronome marks are usually given by a note length equaling a certain playback speed in →BPM. In MuseScore,
metronome marks are used in tempo texts.

Minim (BE)
A minim is the British term for a half note. It has half the duration of a whole note (→semibreve).

Natural
A natural is a sign that cancels a previous alteration on notes of the same pitch.

Operating System
OS

Set of programs written in the aim to set up a computer from a lot of electronic components. Popular OSes are
Microsoft Windows, macOS, and GNU/Linux.
Vedi anche →System

Part
Music to be played or sung by one or a group of musicians. In a string quartet, 1st part = Violin 1, 2nd part = Violin
2, 3rd part = Viola, 4th part = Cello.

Pickup Measure (→Anacrusis)
Incomplete first measure of a piece or a section of a piece of music.
Vedi anche Create new score: Time Signature... and Measure operations: Exclude from measure count

Quaver (BE)
The British quaver is what is called an →eighth note in American English. It has an eighth the duration of a whole
note.

Quadruplet
Vedi →Tuplet

Quarter note
A note whose duration is a quarter of a whole note (semibreve). Same as British →crotchet.

Quintuplet
Vedi →Tuplet

Respell Pitches
Tries to guess the right accidentals for the whole score (vedi Accidentals)

Rest
Interval of silence of a specified duration.

Re-pitch Mode
A way in MuseScore to rewrite a passage with note changes but no rhythm change (vedi Re-pitch Mode)

Semibreve (BE)
A semibreve is the British term for a whole note. It lasts a whole measure in 4/4 time.

Semiquaver (BE)
Sixteenth note

Semihemidemisemiquaver (Quasihemidemisemiquaver) (BE)
Hundred twenty-eighth note.

Sextuplet
Vedi →Tuplet

Sharp

186



Sign that indicates that the pitch of a note has to be raised one semitone.
Slur

→Tie and Slur are two words used to describe a curved line between two or more notes. Slur means that the notes
will be played without attack (legato). Tie is used between two or more notes on the same pitch to indicate its
duration:
Quarter note + Tie + Quarter note = Half note,
Quarter note + Tie + Eighth note = Dotted Quarter note
Quarter note + Tie + Eighth note + Tie + 16th note = Double Dotted Quarter note

Sori
An Iranian →accidental which means higher in pitch and it raises a note by a quarter tone (in comparison to the
sharp which raises a note by a semitone). It is possible to use this accidental in a →key signature.
Vedi anche →Koron

Spatium (plural: Spatia)
Space
Staff Space
sp (abbr./unit)

The distance between two lines of a normal 5-line staff. In MuseScore this unit influences most size settings. Vedi
anche Layout and Formatting, Layout / Page Settings

Staff (AE)
Stave (BE)

Group of one to five horizontal lines used to lay on musical signs. In ancient music notation (before 11th century) the
staff/stave may have any number of lines. (The plural of staff is staves.)

System
System: Set of staves to be read simultaneously in a score.
Vedi anche →Operating System (OS)

Tie
Vedi →Slur

Transposition
A tune can be played in any tonality. There are many reasons to change the tonality of a score:
1. The tune is too low or too high for a singer.
2. The score is written for a C instrument and has to be played by a B Flat one.
3. The score is written for an orchestra and you want to imagine what the horn, the flute and the clarinet are playing.
4. A darker or a more brilliant sound is desired.
- In the first case all the orchestra will have to transpose, which is very difficult without professional musicians.
MuseScore can do it very easily for you.
- In the second case the musician must play D when a C is written. If the score is written with a G 2nd Clef, he'll
have to think that the staff begins with a C 3rd Clef.
- In the third case the conductor has to transpose all the staves which are not written for C instruments.
- In all cases the key signature must be mentally changed.
- On some instruments (Horns and Tubas for instance) the musicians transpose using alternative fingerings.

Triplet (BE)
Vedi →Tuplet

Tuplet
A tuplet divides its next higher note value by a number of notes other than given by the time signature. For example
a →triplet divides the next higher note value into three parts, rather than two. Tuplets may be: →triplets, →duplets,
→quintuplets, and other.

Velocity
The velocity property of a note controls how loudly the note is played. This usage of the term comes from MIDI
synthesizers. On a keyboard instrument, it is the speed with which a key is pressed that controls its volume. The
usual scale for velocity is 0 (silent) to 127 (maximum).

Voice
Polyphonic instruments like Keyboards, Violins, or Drums need to write notes of different duration at the same time
on the same →staff. To write such things each horizontal succession of notes has to be written on the →staff
independently.

Volta
In a repeated section of music, it is common for the last few measures of the section to differ. Markings called voltas
are used to indicate how the section is to be ended each time. These markings are often referred to simply as
→endings.

External links

http://www.robertcarney.net/musical-terms-definitions.htm
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Opzioni da riga di di comando

È possibile avviare MuseScore dalla riga di comando digitando

mscore [options] [ filename] (Mac e Linux)
MuseScore.exe [options] [ filename] (Windows)

[options] e [filename] sono opzionali.

Vedi anche Ripristinare le impostazioni predefinite per le istruzioni dettagliate su come e dove trovare ed eseguire il file
eseguibile MuseScore dalla riga di comando sulle varie piattaforme supportate.

Sono disponibili le seguenti opzioni

-v

Visualizza la versione e il numeri della corrente revisione di MuseScore
-d

Avvia MuseScore in modalità debug
-L

Avvia MuseScore in modalità impaginazione debug
-s

Disabilita il software del sintetizzatore integrato
-m

Disabilita ingresso MIDI
-a <driver>

Utilizza il driver audio: jack, alsa, pulse, portaudio
-n

Avvia con la nuova procedura guidata finestra di avvio indipendentemente dalla preferenza per la modalità di avvio
impostata

-I

Visualizza tutti i dati MIDI in ingresso sulla consolle
-O

Visualizza tutti i dati MIDI in uscita sulla consolle
-o <filename>

Esporta il file attualmente aperto nel <filename> specificato. Il tipo di file dipende dall'estensione. Questa opzione
commuta alla modalità "convertitore" ed evita qualsiasi interfaccia grafica. È inoltre possibile aggiungere un nome al
file prima della -o se si desidera importare ed esportare i file dalla riga di comando. Per esempio mscore "My Score.mscz"

-o "My Score.pdf"

-r <dpi>

Determina la risoluzione di uscita dei flie "*.png" in modalità convertitore. La risoluzione di default è di 300 dpi.
-T <margin>

Esportazione Trim delle immagini PNG e SVG per rimuovere gli spazi intorno alla partitura. Il numero specificato di
pixel di spazio bianco sarà aggiunto come margine; utilizzare 0 per un'immagine ritagliata strettamente. Per SVG,
questa opzione funziona solo con le partiture di una sola pagina.

-x <factor>

Scala la visualizzazione punteggio e altri elementi della GUI (interfaccia grafica utente) dal fattore specificato, per
l'uso con i display ad alta risoluzione.

-S <style>

Carica un file di stile; utile quando si converte con l'opzione -o
-p <name>

Esegue il corrispondente plugin
-F

Utilizza solo le impostazioni standard incorporate o "impostazioni di fabbrica" e cancella le preferenze. Per i dettagli
vedi Ripristinare le impostazioni predefinite

-R

Utilizza solo le impostazioni standard incorporate o "impostazioni di fabbrica" ma non cancella le preferenze.
-i

Carica le icone dal file system. Utile se si desidera modificare le icone di MuseScore e visualizzare un'anteprima
delle modifiche

-e

Abilita le funzioni sperimentali. Vedi ad es. Layer (experimental)
-c <pathname>

Imposta percorso di configurazione
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-t

Attiva modalità test

-M <file>

Specifica il file di operazioni di importazione MIDI
-w

Nessuna visualizzazione web in finestra di Avvio.

Qt opzioni kit di strumenti

-style= <style>

-style <style>

Determina lo stile dell'applicazione GUI. I valori possibili sono "motivo", "finestre" e "platino". A seconda della
piattaforma possono essere disponibili altri stili

-stylesheet= <stylesheet>

-stylesheet <stylesheet>

Imposta il foglio di stile dell'applicazione. Il valore di "foglio di stile" è un percorso di un file che contiene il foglio di
stile

-platform <platformname[:options]>

Specifica il plugin Qt Platform Abstraction (QPA).
Esempio: MuseScore.exe -platform windows:fontengine=freetype

Vedi anche

Ripristina impostazioni di fabbrica
Layer (experimental)

Collegamenti esterni

http://doc.qt.io/qt-5/qapplication.html#QApplication
http://doc.qt.io/qt-5/qguiapplication.html#QGuiApplication
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